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Introduction

! aptop owners are special people.

You see, a laptop owner demands everything from a computer that a desktop
owner does: reliability, performance, expandability, and ease of use. Owners
of Mac Pro or iMac desktop computers can draw the line right there because
their computers are designed for a stationary existence. But, you and I are
laptop owners. We also need that same computer to be an inch thick (or
less). We demand that it run for hours on a single battery charge. We require
that it be light as a feather.

Today’s Apple laptops deliver all that, and more! If you've bought one of
these modern masterpieces — or you're thinking about it right now — I
applaud your good taste, common sense, and discerning eye. Apple laptops
have everything: super performance, a top-shelf LCD screen, rugged reli-
ability, and a trouble-free, powerful operating system. Heck, your Intel-based
Apple laptop can even run . . . wait for it . . . Windows XP or Vista. (If you
absolutely have to, the option is there.)

[ wrote this book for myself — and for every other Apple laptop owner who
desires to become a laptop techno-wizard. In these pages, you find a guide
to both your laptop’s hardware and Mac OS X Leopard, the latest version of
Apple’s superb operating system. After I cover the basics that every laptop
owner should know, you find out how to accomplish all sorts of cutting-edge
audio, visual, and Internet projects. (Oh, and if you already have another of
my books, you know that I don’t skimp on the power user tips and tricks that
save you time, effort, and money.)

Like my dozen-or-so other For Dummies titles, | respect and use the same
English language you learned in school, avoiding jargon, ridiculous computer
acronyms, and confusing techno-babble whenever possible. (Plus, I try to
bring out the humor that’s hidden inside every computer. Finding out how to
use your Mac should be fun, and not a chore!)

What's Really Required

If you're not an engineer with a degree in Advanced Thakamology — imagine
that — there’s no need to worry! Here’s a reasonably complete list of what’s
not required to use this book.
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v [ make no assumptions about your previous knowledge of computers —
laptop or otherwise — and software. I start at the beginning, which is
where every book should start.

v~ Still considering buying a MacBook, MacBook Air, or MacBook Pro?
Heck, you don’t even need the computer! If you're evaluating whether a
Mac laptop is right for you, this book is a great choice. I introduce you
to both the hardware and software you’ll get, so you can easily deter-
mine whether a Mac is the machine for you. (It is. Trust me.)

v Upgrading from the monster that is Windows? [ have tips, tricks, and
entire sections devoted to the hardy pioneers called Switchers! You
discover the similarities and differences between the two operating sys-
tems, how you can make the switch as easy and quick as possible, and
how to run Windows on your new laptop, if you absolutely must.

v If your friends and family have told you that you’re going to spend half
your savings on software — or that there’s no decent software available
for Mac computers — just smile quietly to yourself! These are two per-
sistent myths about Mac computers, and those same folks are going to
be blown away by the images, music, movies, and documents you pro-
duce. (Oh, by the way, your Mac laptop comes complete with a ton more
software than any other PC or laptop, and the iLife suite of applications
is better than anything available on a PC!) To sum up: You can do virtu-
ally everything in this book with the software that came with your Mac!

So what is required? Only your Mac laptop and the desire to become a power
user — someone who produces the best work in the least amount of time and
has the most fun doing it!

This book was written using the latest MacBook Pro computer, so owners of
older Mac laptops who aren’t running Intel processors might not be able to
follow along with everything I cover. However, if you’ve upgraded an older G4
laptop with Mac OS X Leopard and the iLife 08 application suite, you should
be able to use most of the book with no problem.

About This Book

Each chapter in this book is written as a reference on a specific hardware or
software topic. As fruit of the hard work of my editors, you can begin reading
anywhere you like because each chapter is self-contained. However, if you
want to get the most out of this tome (and your MacBook experience), noth-
ing’s wrong with reading this book from front to back. I warn you, however,
that Tom Clancy and Stephen King have nothing to fear from my “no-frills”
prose.
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Conventions Used in This Book

Even with a minimum of techno-speak, this book needs to cover the special
keys you have to press or menu commands you have to choose to make
things work. Hence, this short list of conventions.

Stuff you type

I may ask you to type a command in Mac OS X. That text often appears like this:
Type me.

You usually have to press the Return key before anything happens.

Menu command's

[ list menu commands, using this format:
Edit=>Copy

This example of shorthand menu instruction indicates that you should click
the Edit menu and then choose the Copy menu item.

Web addresses

No up-to-date book on a computer is complete without a bag full of Web
addresses for you to check out. When you see these in the text, they look like
this — www.mlcbooks . com — or like this:

www .mlcbooks.com

(By the way, that Web site does exist. You're always welcome to check out
my little acre of Web space!)

For the technically curious

Your MacBook is an elegant and sophisticated  disassembled alarm clocks as a kid, like | did.)
machine — and as easy to use as a computer Techie stuff is formatted as a sidebar, like this
can be — but from time to time, you may be one, and you don’t have to read it unless you
curious about the technical details surround-  want to know what makes things tick. (Pun by
ing your hardware and software. (You probably  sheer accident.)

3
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How This Book Is Organized

After careful thought (read that “flipping a coin”), I divided this book into
seven major parts — plus an index, just because you deserve one. For your
convenience, cross-references to additional coverage of many topics are
sprinkled liberally throughout the book.

The Seven Parts Shall Be As Follows.

Part I: Tie Myself Down with a Desktop?
Preposterous!

This part introduces you to the important features of your laptop — like find-
ing out where all the cables connect — and helps you set up your system. |
also introduce Mac OS X Leopard, which is the Apple operating system that
comes preinstalled on your MacBook, MacBook Air, or MacBook Pro.

Part 1I: Shaking Hands with Mac 0S X

Time to familiarize you with Leopard (there’s much more here behind the
spots). In Part II, you find out how to take care of mundane chores (such as
moving your stuff) as well as how to customize and personalize your system
until it fits like the proverbial glove. Switchers from the PC world will be
especially interested in understanding the ins and outs of Mac OS X — and
friends, it ain’t hard. The Mac started out easier to use than a Windows PC,
and nothing has changed.

Part I1I: Connecting and Communicating

In Part III, it’s time to jump into the one application you're likely to use every
day: your Safari Web browser! You also find out more about the Apple .Mac
Internet subscriber service as well as how to connect your laptop for print-
ing, sharing information with your PDA or cellphone, and even videoconfer-
encing. (I told you this thing was powerful, didn’t 1?)

Part IU: Living the iLife

Ah, readers, you can begin humming happily to yourself right this second!
Yep, Part IV provides complete coverage of the latest iLife 08 release, with
the names that are the envy of the Windows crowd: iTunes, iPhoto, iMovie,
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iDVD, and GarageBand. You find out how to turn your mobile monster com-
puter into the hub for all your digital media. Whether you listen to it, display
it, compose it, or direct it, this part of the book will explain it.

Part U: Sharing Access and Information

In Part V, I discuss how to share your Mac laptop among a group of people
and also how to connect your Mac to a network. (Wired or wireless, makes
no difference to me!) I also cover how to share data among wireless devices
using Bluetooth technology and iSync, and how to broadcast your music
around your house like Wolfman Jack.

Part Ul: Necessary Evils: Troubleshooting,
Upgrading, Maintaining

In Part VI, I cover the stuff my Dad used to call the Justin Case Guide — that
is, just in case, you want to upgrade your MacBook with more memory or
new hardware. If you need to troubleshoot a problem with your hardware or
software, check out my should-be-patented troubleshooting guide. Finally, I
describe what you can do to help keep your Mac running as fast and as trou-
ble-free as the day you took it out of the box!

Part UIl: The Part of Tens

The two chapters here that make up the famous “Part of Tens” section con-
tain a quick reference of tips and advice on a specific laptop or Macintosh
topic. Each list has ten concise tips, and one or two readers have told me
that they make excellent tattoos. (Personally, I'm not that much of a Mac
guru.)

Icons Used in This Book

3

Like other technology authors, I firmly believe that important nuggets of
wisdom should stand out on the page! With that in mind, this For Dummies
book includes a number of margin icons for certain situations.

The most popular icon in the book, you find it next to suggestions I make that
save you time and effort — and once or twice, even cash!

5
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These are My Favorite Recommendations — in fact, I'll bet just about any
laptop power user would tell you the same. Follow my Maxims, and you’ll
avoid the quicksand and pitfalls that I've encountered with all sorts of Macs
for well over a decade!

You don’t have to know this stuff, but the technologically curious love high-
tech details. (Of course, we're great fun at parties, too.)

Always read the information for this icon first! I'm discussing something that
could harm your hardware or throw a plumber’s helper into your software.

‘3“?’ The highlighter stuff — not quite as universally accepted (or as important to
the author) as a Mark’s Maxim, but a good reminder! [ use these icons to rein-
force That Which Should Be Remembered.

Where to Go from Here

My recommendations on how to proceed? I just happen to have three:

v If you're thinking about buying a new MacBook, MacBook Air, or
MacBook Pro, the box is still unopened in your living room, or you’d like
help setting things up, start with Part I.

v If you're already on the road with your laptop but you’d like guidance
with running Mac OS X — Hey, you Windows Switchers! Take note! —
start with Part IL.

v For all other concerns, use the index or check out the table of contents
to jump straight to the chapter you need.

A Final Word

I thank you for buying my book, and I hope that you find MacBook For
Dummies, 2nd Edition invaluable! With this fearless guide in hand, I believe
that you and your Mac will bond as I have with mine. (That sounds somewhat
wrong, but it’s really not.)

Time for the first Mark’s Maxim in this book:
Take your time — after all, finding out how to use your computer isn’t a race —

and don’t worry if you're not a graphic artist, professional photographer, or
video editor. With your Mac laptop and its software, you don’t have to be!™
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In this part . . .

our journey as a Mac Road Warrior — pun intended —

begins with a description of your laptop itself as
well as the details you need to know when unpacking and
setting up your newest family member. You'll also find an
introduction to Mac OS X Leopard, the latest version of
Apple’s super-popular operating system.

I also talk about the differences between the MacBook
models as of this writing: the MacBook, MacBook Pro, and
the incredibly thin MacBook Air.




Chapter 1

Hey, It Really Does Have
Everything | Need

In This Chapter
Identifying the important parts of your Mac laptop
Introducing the MacBook Air
Locating the right home for your computer
Plugging in stuff and getting hooked up
Playing with your bundled software
Buying additional stuff that you might need

M ost action films have one scene in common: I call it the “gear up”
scene, where the good guys strap on their equipment in preparation

for battle. (It doesn’t matter what era: You see “gear up” scenes in Gladiator,
Aliens, and virtually every movie Arnold has made.) You're sure to see lots
of clicking straps and equipping of offensive weapons (and sometimes even
a dash of war paint. The process usually takes a minute or so, all told with
whiplash camera work and stirring martial music in the background.

Well, fellow Macintosh Road Warrior, it takes only fwo seconds and one move
for you to gear up: closing the lid. That’s because your MacBook is a self-
contained world, providing virtually everything you’ll find on a desktop iMac
or Mac Pro. This is indeed the decade of the laptop, meshing nicely with your
cellphone and that wireless connection at your local coffee shop. You have
selected the right companion for the open road.

Unlike some of Apple’s other designs, such as the Mac Mini or the iMac, your
MacBook looks similar to a PC laptop running Windows. (In fact, an Intel-
based Mac laptop can run Windows, if you absolutely must.) But your laptop
holds a number of pleasant surprises that no PC laptop can offer — and, in
the case of the MacBook Air, you'll lose pounds and inches from your chas-
sis! In this chapter, I introduce you to the hardware and all the major parts
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of the machine — and you’ll even find out how to unpack and connect your
computer. And, as frosting on the cake, I'll preview the software that Apple
is so proud of, as well as the accessories that you should buy now instead of
later.

Welcome to your Mac laptop, good reader. Gear up!

An Overview of Vour Mac Laptop

Sure, your MacBook Pro might be but an inch thin (and a MacBook Air even
more svelte than that — I get to that later in the chapter), but a lot of superb
design lives inside, and you’ll encounter the same parts that you’d find in a
desktop machine. In this section, [ discuss those important parts — both the
stuff you can see and the stuff that’s shoehorned within.

The parts you probably recognize

Every laptop requires some of the same gizmos. Figure 1-1 helps you track
them down. Of course, as you’'d expect, a computer has a body of sorts in
which all the innards and brains are stored, a display screen, a keyboard, a
trackpad or other pointing device, and ports for powering and exchanging
data with outside toys.

iSight camera

LCD screen

Disc slot
(MacBook and
MacBook Pro
Keyboard Trackpad only)



Chapter 1: Hey, It Really Does Have Everything | Need

Feeling outdated? Never!

Are you using an older MacBook, iBook, or
PowerBook? It seems that Apple’s product line
changes every time you tear a page from your
12-month calendar, and every new generation
of laptops includes new whiz-bang features.
Sometimes you can add those features sepa-
rately to your older machine — such as an
external iSight camera or an AirPort Extreme
card — but you can't update some things, such
as like your iBook motherboard. Sigh.

Here's my take on this situation: If your older
laptop does what you need at a pace you can
accept, there is no needto upgrade it.

Skeptical? Here's the proof: Before my recent
upgrade to a MacBook Pro, yours truly was
lugging a pristine iBook G3, which booted Mac
0S X Tiger and did absolutely everything that |
demanded. (A little more patience was required,

That magnificent screen

certainly, but technology authors are simply
brimming with patience.) The moral: Avoid the
upgrade fever unless you really need a new
companion!

If your laptop bears the iBook or PowerBook
logo, you can still enjoy this book and dis-
cover new tips and tricks from it! Unless the
new breed of Intel-based Mac laptops has a
feature that you absolutely can’t use on your
iBook (such as booting directly into Windows),
you can sail on with your current computer,
fiercely proud of The Bitten Apple that appears
on the cover. Although this book was written
with the MacBook, MacBook Air, and MacBook
Pro lines in mind, virtually everything you read
here still applies to your older laptop. Unless it's
steam-driven, of course.

11

What a view you have! Today’s Mac laptops feature a 13", 15", or 17" LCD dis-
play. Most displays are available in glossy or standard finish: The former is

a good choice for the brightest colors and deepest blacks, and the latter is a
good choice where reflections might be a problem.

LCD screens use far less electricity than their antique CRT ancestors do, and
they emit practically no radiation.

Apple’s laptop screens offer a widescreen aspect ratio (the screen is consid-
erably wider than it is tall), which augurs well for those who enjoy watching
DVD movies. (A favorite editor of mine loves it when I use the antique word
augur, meaning fo predict or foretell.)

<P That reminds me: Throw away your printed dictionary! You won’t need it
because Mac OS X Leopard includes the fantastic Dictionary widget, which
uses the Internet to retrieve definitions from the online Oxford American
Dictionary site. More on widgets in general in Chapter 5. . . and yes, it does
contain augur.
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The keyboard and trackpad

Hey, here’s something novel for your laptop. Unlike the external input
devices on a standard desktop computer, your Mac has a built-in keyboard
and trackpad (which does the job of a mouse). The keyboard is a particular
favorite of mine for a few reasons:

» You can either control the sound volume or mute all that noise completely.

v You can use illuminated keyboards (at least on high-end Mac laptops),
which are perfect for darkened dorm rooms and airplane flights.

v A handy-dandy Media Eject key lets you eject a CD or DVD.

The disc slot

You'll notice a long groove at the bottom-right corner of your MacBook or
MacBook Pro. No, it’s not for your credit card. This slot accepts CDs and
DVDs into your optical drive. If the drive is empty, loading a disc is as simple
as sliding it in an inch or so; the drive sucks in the disc automatically. (And
we don’t need a stinkin’ floppy. Macs haven’t had floppy drives for years
now, and the PC types are just beginning to follow.)

A MacBook Air doesn’t sport any internal optical drive (more on the MacBook
Air later in this chapter). You use either the CD & DVD Sharing feature in
Leopard to read discs remotely (from another Mac or PC on your network), or
you can pick up an external optical drive from Apple for about $100. (Such is
the price you play for super-thin and super-light.)

“Luke, the printed label side of the disc should always be facing you when you
load a disc. Always.”

Food for your ears

A machine this nice had better have great sound, and the Mac doesn’t disap-
point. You have a couple of options for Mac laptop audio:

v All Mac laptops sport built-in speakers (and a microphone to boot).
The MacBook Air has a single speaker, and MacBook and MacBook Pro
models sport stereo speakers.

v Use built-in audio Line Out jacks to connect your Mac’s audio to a pair
of headphones, or a more powerful (and expensive) external speaker
system, or a home stereo system.

The power cable

Sorry, can’t get a wireless power system . . . yet. (Apple’s working hard on
that one.) However, the MacBook Pro was the first major release of a laptop
with a magnetic power connector; the MacBook and MacBook Air followed
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suit soon after. The MagSafe connector reduces the chances of your pride
and joy being yanked off a desk when someone trips over the power cord,
because the magnetic closure pops off under significant strain. Now that’s
sassy.

The power button

Yep, you have one of these, too. It’s on the upper right, next to the keyboard,
bearing the familiar “circle with a vertical line” logo.

The iSight camera

Check out that tiny square lens above your screen. That’s a built-in iSight
camera, which allows you to chat with others in a videoconferencing environ-
ment using Leopard’s iChat feature. You can even take photos with it, using
the Photo Booth software that comes with your laptop, or set up a travelin’
Webcam.

The battery compartment

Owners of a MacBook or MacBook Pro can open the cover on the bottom of
the laptop to switch batteries. Many road warriors who constantly use their
laptops for extended periods swear by extra batteries, especially if they're
on-site in the middle of nowhere and there’s not an AC outlet to be found.

Of course, your laptop automatically charges the battery while it’s plugged
in, so you shouldn’t have to remove the battery unless you're replacing it or
switching it with another battery.

If you're using a MacBook Air, your battery is sealed inside the case and
can’t be swapped. Only an Apple technician can replace a dead battery in a
MacBook Air laptop.

Hey, where’'s my remote?

If this isn’t your first Mac laptop, you're prob- If you've picked up a used MacBook or
ably looking for the Apple Remote amongst all MacBook Pro, you might have a remote already.
the Styrofoam. Unfortunately, the latest crop  Otherwise, you can always buy one directly
of Mac laptops don't come with a remote. This  from Apple for about $20. However, you can't
once-standard device, which looks like aniPod use an Apple Remote with the MacBook Air,
Shuffle, allowed you to control your laptop wire-  which doesn't have an IR (infrared) receiver.
less from across the room. Think DVD viewings,

presentations, and lazy iTunes listening.
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The holes called ports

The next stop on your tour of Planet Laptop is Port Central — those rows of
holes on the sides of your computer. Each port connects a different type of
cable or device, allowing you to easily add all sorts of functionality to your
computer.

Each of these stellar holes is identified by an icon to help you identify it.
Here’s a list of what you’ll find, and a quick rundown on what these ports do.

Connections for external devices and networking:

v FireWire: These ports are the standard in the Apple universe for con-
necting external hard drives and DVD recorders, but they do double-
duty as the connector of choice for peripherals like your digital video
(DV) camcorder. (A peripheral is another silly techno-nerd term that
means a separate device you connect to your computer.) Depending
on the model of laptop you chose, you’ll have one of the older FireWire
400 ports, and you may also have a much faster FireWire 800 port. (The
MacBook Air doesn’t have a FireWire port.)

v USB: Short for Universal Serial Bus, the familiar USB port is the jack-of-
all-trades in today’s world of computer add-ons. Most external devices
that you want to connect to your laptop (such as portable hard drives,
scanners, and digital cameras) use a USB port, including the iPod.
Depending on the model of laptop, you’ll have either two or three USB
2.0 ports available. USB 2.0 connections are much faster than the old
USB 1.1 standard, but they still accept USB 1.1 devices running at the
slower speed.

Get the lowdown on FireWire and USB ports in Chapter 20.

v Ethernet: Today’s Mac laptops include a standard 10/100/1000 Ethernet
port, so the laptop is ready to join your existing wired Ethernet network.
(Alternatively, you can go wireless for your network connection; more
on that in the next section and in Chapters 17 and 20.) Because the
MacBook Air is designed to be completely wireless, it doesn’t have a
wired Ethernet port — if necessary, you can add a USB Ethernet adapter
to add a wired network port to your Air.

v ExpressCard/34: When you need the absolute fastest performance
possible from an external device, you can connect that device to your
laptop by using the ExpressCard slot. These cards are the descen-
dants of the popular PCMCIA (or PC Card) cards, which many models
of older Mac PowerBooks can use. The MacBook Air doesn’t have an
ExpressCard slot.
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Connections for external video and audio are

1 VGA/DVI connector: In case that splendid screen isn’t big enough, you
can buy an adapter for this port that allows you to send the video signal
from your laptop to another VGA or DVI monitor, or even S-Video output
for your TV and VCR.

v Headphone/Optical Output: You can send the high-quality audio from
your rectangular beast to a set of standard headphones or an optical
digital audio device such as a high-end home theater system.

v Optical Line In: Last (but certainly not least) is the optical audio Line In
jack, which allows you to pipe the signal from another audio device into
your laptop. This one comes in particularly handy when you record MP3
files from your old vinyl albums or when you want to record loops in
GarageBand. (The MacBook Air doesn’t have an audio Line In jack.)

Don’t forget the parts you can’t see

When you bought your new digital pride and joy, you probably noticed a
number of subtle differences between the low-end MacBook and the uber-
expensive, top-end MacBook Pro and MacBook Air models. I call these dif-
ferences the Important Hidden Stuff (or IHS, if you're addicted to acronyms
already), and they’re just as important as the parts and ports that you can see.

Internal storage devices:

v CPU: Today’s Mac laptops feature — gasp! — Intel processors, which
run faster and cooler than the old G4 processors that powered the iBook
and PowerBook models. Of course, the faster the processor, the better.
(Definitely not rocket science.)

v Hard drive: MacBook and MacBook Pro laptops use the latest in hard
drive technology: namely, serial ATA hard drives, which are significantly
faster than the EIDE hard drives used in previous Mac laptop models.
(You don’t need to worry about what ATA and EIDE mean here. Really.)
As you might expect, the MacBook Pro laptop line has a larger capacity
hard drive as standard equipment, but you can special order a MacBook
from Apple with a larger hard drive.

The MacBook Air has two storage options: You can choose a mundane
EIDE hard drive, or you can opt for the much more expensive (and much
more technically impressive) solid-state drive. Hold on to your chair —
there are no moving parts with a solid-state drive, and it offers better
performance than a standard hard drive. Think of the solid-state drive
as an internal USB flash drive, which uses RAM chips to hold your data
instead of magnetic platters! Pricey, but super-sweet, and Apple once
again introduces the latest in computer hardware.

15
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v Optical drive: Okay, I'm cheating a little here. I mention the optical drive

in an earlier section, but all you can see is the slot, so it qualifies as an
[HS item. Depending on your Mac, your computer includes one of the
following:

e No built-in optical drive

The MacBook Air can be equipped with an external SuperDrive, or
you can use another computer’s drive remotely over your wireless
network.

e A DVD-R/CD-RW SuperDrive, which can play and record both CDs
and DVDs

e A DVD/CD-RW combo drive, which can record CDs but only read DVDs

If your laptop can’t burn DVDs with the internal drive, don’t give
up hope of recording your own DVD movies. Thanks to those
handy FireWire ports, it’s child’s play to add an external DVD
recorder.

Time for a plug: If you're interested in recording your own audio and data
CDs, or you have an itch to burn DVD movies, I can highly recommend
the bestselling CD & DVD Recording For Dummies, 2nd Edition (Wiley). It’s
written by yours truly; hence the solid recommendation. You'll find every-
thing you need to know to use Roxio’s Toast recording software. In a few
minutes, you’ll be burning your own shiny digital treasures.

Wireless communications devices:

v Wireless Ethernet: “Look, Ma, no wires!” As [ mention earlier, you can

connect your laptop to an existing wireless Ethernet network. All cur-
rent Mac laptops have built-in AirPort Extreme hardware (older laptops
can be upgraded with an internal AirPort or AirPort Extreme card). With
wireless connectivity, you can share documents with another computer
in another room, share a single high-speed Internet connection betwixt
several computers, or enjoy wireless printing. Truly sassy/

Although Apple would want you to build your wireless wonderland
with an Apple AirPort Extreme Base Station — go figure — you can use
your Mac with any standard 802.11 wireless network. And yes, PCs and
Macs can intermingle on the same wireless network without a hitch.
(Scandalous, ain’t it?)

1 Bluetooth: Let’s get the old “digital pirate” joke out of the way: “Arrgh,

matey, [ needs me a wireless parrot.” (Engineers again . . . sheesh.)
Although strangely named, Bluetooth is another form of wireless con-
nectivity. This time, however, the standard was designed for accessories
such as your keyboard and mouse, and devices such as a personal digi-
tal assistant (PDA) and a cellphone.
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Video display device:

v Video card: If your applications rely heavily on high-speed 3-D graphics,
you’ll be pleased as punch to learn that today’s MacBook Pro line of laptops
come equipped with muscle-bound cards, such as the NVIDIA GeForce
8600M GT. This card is well suited to 3-D modeling, video editing, and well,
honestly, blasting the enemy into small smoking pieces with aplomb. As of
this writing, the MacBook and MacBook Air laptops use an integrated video
card, so they’re not a good choice for hard-core gaming or 3-D design.

Meet the New MacBook Air

|
Figure 1-2:
Behold the
MacBook
Air.
|

Here’s a corker of a conundrum: The MacBook Air is a revolutionary laptop,
unique for both its size and weight (see Figure 1-2). And yet the Air is just like
the MacBook and the MacBook Pro. Well, mostly.

“Hold on, Mark. How can it be so singular and yet share so much with its road
warrior siblings?” That’s what I'll show you in this section, which discusses
the many similarities and the handful of very striking differences between the
three laptops in the MacBook line. If you’re considering buying an Air, this
section will help you decide whether you’d like to go ultra-thin or stick with
the conventional laptop crowd.

One thing’s for sure — Apple never does things mundane!

Comparing 'twixt MacBooks

Do you remember when Apple introduced those first iMacs? Although they
shared the same basic components as any computer — a monitor, keyboard,
ports, speakers, and cables — the iMac was revolutionary because it was

17
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completely self-contained. And it came in colors. And it didn’t have a floppy
drive. In fact, Apple had redesigned the common computer with the focus on
style and ease-of-use, and had scrapped the floppy (and rightly so, seeing as
how floppies had become practically useless and were unreliable, to boot).

I consider the MacBook Air to be an extension of the iMac revolution. With
this new design, Apple has focused this time on physical dimensions and
weight, and has tossed anything that isn’t absolutely necessary for the lecture
hall, board room, or city park. However, 'm happy to note that the Air is no
toy, nor is it a bare-bones sub-notebook. You'll find the Air as powerful as the
MacBook, and the Air even shares some of the features of the MacBook Pro.

What are the MacBook similarities?
Consider the similarities between the Air and the other MacBooks:

v Widescreen display: The Air has the same size display as the other
MacBook models. Same display resolution, same gorgeous graphics. (In
fact, at the time of this writing, the MacBook and MacBook Air have the
same internal video hardware.)

v+~ Intel Core 2 Duo processor: The Air is powered by the same type of CPU
as its siblings.

+* Keyboard and trackpad: The Air has a full-size keyboard, and it’s even
backlit, just like the MacBook Pro. The Air’s trackpad includes support for
Multi-Touch control, too. (Read more about Multi-Touch in Chapter 4.)

1 Leopard: The Air runs the latest version of Mac OS X with aplomb.

v~ iSight and microphone: Every MacBook Air is video-ready, using the
same iSight camera. You can record audio with the built-in microphone
as well. (Read more about iSight and recording in Chapter 10.)

v Wireless support: Like the other MacBooks, the Air has both built-in
AirPort Extreme hardware (802.11n) and built-in Bluetooth hardware.
(Read more about these in Chapters 17 and 18.)

[ think most Apple laptop owners would agree that this list covers the major
features to look for in a MacBook, so we can all agree that the MacBook Air is
no underpowered pushover.

So what’s so flippin’ radical?

I'm glad you asked! Here’s the checklist of striking differences that set the Air
apart from the MacBook and MacBook Pro:

v~ Physical dimensions: Apple doesn’t call this machine the Air for noth-
ing! The current Air laptop measures a mere 0.76” in height (at its tallest
point) when closed, 12.8” in width, and 8.94” in depth. Oh, and hold on
to your chair for this one: Our champ weighs in at a lightweight three
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pounds! (That’s a couple of pounds you won’t be carrying around all
day at that convention expo. Take it from this traveler: You will feel the
refreshing difference in just an hour or two.)

v Cost: At the time of this writing, there are two versions of the laptop. An
entry-level MacBook Air will set you back $1,800, and the top-of-the-line
Air is a whopping $3,100. The more expensive Air is equipped with a
very pricey, solid-state drive and a faster CPU. (Don’t miss the upcoming
coverage on why solid-state is worth every penny.)

v Ports: The Air offers only three ports: a USB 2.0 port, an audio out jack,
and a Micro-DVI for connecting an external monitor or video device.
Notice I didn’t mention a FireWire port, which can be a big problem for
Apple old-timers like me. I have a huge collection of FireWire devices.
The Air also doesn’t have an infrared port, so it’s not compatible with
the Apple Remote. Rats.

1 Sealed battery: You can’t swap batteries with a MacBook Air because
the battery is sealed inside the laptop. (Think iPod.)

v Sealed case: You can’t add or replace RAM modules. However, a
MacBook Air comes equipped with 2GB of RAM, so you should be good
to go. Comparatively, the MacBook and MacBook Pro models can be
upgraded to 4GB of RAM.

v Speaker(s): The MacBook Air includes but one speaker.

v~ Solid-state drive: Now we’'re talkin’, Buck Rogers! I discuss the solid-
state drive option in the next section.

v No built-in optical drive: Whoa, Nellie! This is a big one. Apple decided
that a typical Air owner is likely to use a wireless connection for trans-
ferring files and media. But what if you have to reinstall Leopard or new
applications? If you need to read or burn discs, a separate external USB
SuperDrive is available for about $100, or you can use the Remote Disc
feature and share the drive on another computer. (More on Remote Disc
later in this section.)

As you can see, these striking differences make the choice between a
MacBook Air and a MacBook/MacBook Pro very easy indeed. To wit: The Air
is designed for the traveler who appreciates minimum weight and size, but
who doesn’t want to sacrifice the power, full-size screen, and full-size key-
board of a typical MacBook. These folks see the MacBook Air as a racecar:
nimble, with reduced weight and no unnecessary frills. (Think of a typical
NASCAR entry: Who needs an expensive stereo or air conditioning?)

If you prefer the additional versatility of a MacBook or MacBook Pro —
including the standard set of ports, the ability to swap batteries, and a
built-in optical drive — I highly recommend that you stick with the more con-
ventional MacBook or MacBook Pro.
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Look, Ma, no moving parts!

You're probably familiar with the common species of usbius flashimus —
more commonly called the USB Flash drive. With one of these tiny devices,
you get the equivalent of a 2-8GB hard drive that plugs into a USB 2.0 port,
allowing you to pack your data with you as you jet across the continents. But
have you ever asked yourself, “Self, why don’t they make internal hard drives
that use this same technology?”

Actually, dear reader, solid-state drives have been around for a number

of years now (think iPod Shuffle). Unfortunately, however, the solid-state
memory used in today’s Flash drives gets pretty expensive as capacity
increases. In fact, the cost has been the limiting factor, as a solid-state drive
offers a number of advantages that really set it apart from a conventional
magnetic hard drive:

+* No moving parts: Unlike a typical magnetic hard drive, there’s no read-
write heads, no magnetic platter — just gobs of happy silicon memory
chips. In effect, a solid-state drive works along the same lines as your
MacBook’s system RAM. Unlike your Mac’s RAM, though, a solid-state
drive doesn’t lose the data it stores when you turn off your laptop. As
you can imagine, no moving parts on a computer in motion is superior
on two levels:

¢ The solid-state drive never wears out or needs replacing.

e If your laptop is accidentally abused (think, getting knocked off
your desk), it’s far less likely that you’ll lose a hard drive’s worth
of priceless data when it hits the ground.

v Speed: Oh, my goodness, is this thing fast! Your MacBook will boot/
restart/awake in far less time, and everything you do on your laptop will
benefit from the speed boost. A solid-state drive can read data far faster
than a conventional magnetic hard drive.

v Power usage: Forget your hard drive spinning up from sleep mode. The
solid-state drive uses far less power than a conventional hard drive,
resulting in significantly longer battery life.

+~ Blessed silence: The solid-state drive is completely silent. (No more of
that gargling noise while the disk is accessed. Sweet.)

So do you need the solid-state drive option for your MacBook Air? The
answer lies in your bank account (as well as your need for elbowroom). If you
can afford the extra expense of the solid-state drive and you can fit all of your
applications and data into 64GB, I heartily recommend that you consider join-
ing Buck Rogers with the storage device of the future.
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If you’d rather save that coin for something else, or you need a larger internal
hard drive to hold things like digital video and a massive collection of digital
images, stick with the tried-and-true magnetic hard drive.

What if I need that pesky optical drive?

Can a laptop survive in the jungle that is Real Life without a DVD drive? The
terse answer is no. I'll be honest here: Ripping an audio CD or burning an
iDVD slideshow disc without an optical drive is impossible. (Rather like a
cheap tank of gas.) And the wonders of digital media are a big part of the
iWorld. So what was Apple thinking?

First, a bit of explanation. Today’s DVD drives are thin, but not Air thin. In
order to create the stunning Air design with truly revolutionary dimensions,
Apples engineers had to leave out the drive. However, if you own a MacBook
Air, you have two choices when it comes to reading the contents of a CD or
DVD: Go external, or find how to share.

The external USB route

This is my choice. Personally, I have no problem at all toting around an exter-
nal USB DVD burner with a MacBook Air. Heck, half the time, you're likely

to leave it at home because most of us don’t install software every day. The
folks at Cupertino want you to download your movies from the iTunes Store,
so if you follow the Apple Path, you still don’t need an optical drive!

A USB SuperDrive from Apple costs a mere $100, and it can read and write
DVDs as well as the built-in SuperDrive you’ll find in the MacBook and
MacBook Pro.

You can also use any third-party USB DVD drive that’s compatible with
Apple’s laptops and Mac OS X Leopard.

Sharing a CD or DUD drive
The other option for installing software or reading a DVD on the MacBook Air
is Leopard’s built-in CD/DVD Sharing feature. Sharing is an option if you have a
wired or wireless network (see Chapter 17) with at least one of the following:
»* A Macintosh running Mac OS X Tiger or Leopard
+* A PC running Windows XP or Vista

This requires you to install a Windows application supplied by Apple
with your MacBook Air.
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You can only read from a shared optical drive. You can’t write data to the
remote drive, even if that drive is a DVD recorder.

On the Macintosh with the optical drive, open System Preferences, click the
Sharing icon, and then enable the DVD or CD Sharing check box. Note that
you can set whether the Mac will request your permission when another
computer attempts to share the drive.

On a PC, display Control Panel, click the DVD or CD Sharing icon, and then
choose the Enable DVD or CD Sharing check box. Again, you can specify that
permission is required if security is a concern.

After you set up the shared drive, just load the disc, and select the Remote
Disc item in any Finder sidebar. (Remote Disc appears under the Devices
heading in the sidebar.) Now you can access the drive as if it were directly
connected to your MacBook Air. Ah, technology!

Location, Location, Location!
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If you choose the wrong spot to park your new laptop, | can guarantee that
you’ll regret it. Some domiciles and office cubicles don’t offer a choice —
you have one desk at work, for example, and nobody’s going to hand over
another one — but if you can select a home for your Mac, consider the
important placement points in this section:

v Keep things cool. Your new laptop is silent, but that super-fast Intel
Core 2 Duo processor generates heat. Make sure the location you
choose is far from heating vents and shielded from direct sunlight. I also
recommend a laptop cooling pad, which elevates the base of your laptop
to allow air to circulate underneath.

v Outlets are key! Your computer needs a minimum of at least one nearby
outlet, and perhaps as many as three:

e A standard AC outlet (using a current adapter if you're traveling
abroad, if necessary)

¢ A telephone jack (if you have an Apple modem for connecting to the
Internet or sending and receiving faxes)

¢ A nearby Ethernet jack (if you use the MacBook or MacBook Pro’s
built-in Ethernet port for connecting to a wired Ethernet network)

If you prefer to send your data over the airwaves, consider wire-
less networking for your Mac — I discuss everything you need to
know in Chapter 17.
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v Don’t forget the lighting. Let me act as your Mom. (I know that’s a
stretch, but bear with me.) She’d say, “You can’t possibly expect to work
without decent lighting! You'll go blind!” She’s right, you know. You need
a desk or floor lamp at a minimum.

v Plan to expand. If your laptop hangs out on a desk, allow an additional
foot of space on each side. That way, you have room for external periph-
erals, more-powerful speakers, and an external keyboard and mouse if
you need one.

<P If you want to keep an external keyboard handy, consider using a laptop
shelf. These Plexiglas or metal stands elevate your laptop several inches
above the desk, putting the screen at a better ergonomic position and
allowing you to park your keyboard and external mouse underneath.

Unpacking and Connecting Your Laptop

You're going to love this section. It’s short and sweet because the configura-
tion of a laptop on your desktop is a piece of cake. (Sorry about the cliché
overload, but this really is easy.)

Unpacking for the road warrior

Follow these guidelines when unpacking your system:

v Check for damage. I've never had a box arrive from Apple with shipping
damage, but I've heard horror stories from others (who claim that King
<P Kong must have been working for That Shipping Company).

Check all sides of your box before you open it. If you find significant
damage, take a photograph (just in case).

v~ Search for all the parts. When you're removing those chunks o’ foam,
make certain that you've checked all sides of each foam block for parts
snuggled therein or taped for shipment.

1 Keep all packing materials. Do not head for the trash can with the box
and packing materials. Keep your box and all packing materials for at
least a year, until the standard Apple warranty runs out. If you have to
ship the laptop to an Apple service center, the box and the original pack-
ing is the only way for your machine to fly.

And now, a dramatic Mark’s Maxim about cardboard containers:

Smart computer owners keep their boxes far longer than a year. If you
sell your laptop or move across the country, for example, you’ll want
that box. Trust me on this one.™
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v~ Store the invoice for safekeeping. Your invoice is a valuable piece of
paper, indeed.

Save your original invoice in a plastic bag, along with your computer’s
manuals and original software, and other assorted hoo-hah. Keep the
bag on your shelf or stored safely in your desk, and enjoy a little peace
of mind.

” Read the Mac’s manual. “Hey, wait a minute, Mark. Why do I have to
read the manual from Apple along with this tome?” Good question, and
here’s the answer: The documentation from Apple might contain new
and updated instructions that override what I tell you here. (For example,
“Never cut the red wire. Cut the blue wire instead.” Or something to that
effect.) Besides, Apple manuals are rarely thicker than a restaurant menu.

You can always download the latest updated manuals for Apple comput-
ers in electronic format from Apple’s Web site. (Adobe’s PDF format is
the standard for reading documents on your computer, and Leopard can
open and display any PDF document, using the Preview application.) I
always keep a copy of the PDF manual for my MacBook Pro on my hard
drive, just in case.

Connecting cables 101

Your laptop makes all its connections simple, but your computer depends on
you to get the outside wires and thingamabobs where they go.

The absolutely essential connection

After your new Mac is resting comfortably in its assigned spot (I assume
that’s a desktop), you need to make just one required connection: the power
cable! Plug the cable into the corresponding socket on the Mac first, and then
plug ’er into that handy AC outlet. (After your battery is completely charged,
of course, you can go mobile at a moment’s notice.)

Adding the Internet to the mix

If you have Internet access or a local computer network, you need to make at
least one of the following connections in this section.

If you get on the Internet by dialing a standard phone number and your
laptop has an external USB modem, just make two more connections:
1. Plug one of the telephone cable’s connectors into your external modem.
2. Plug the other telephone cable connector into your telephone line’s

wall jack.

After you get your account information from your ISP, Chapter 17 has the
details on configuring your modem and Internet settings for dialup access.
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If you have high-speed Internet service, or if you're in an office or school with
a local computer network, you can probably connect through your MacBook
or MacBook Pro’s built-in Ethernet port. You make two connections:

1. Plug one end of the Ethernet cable into the Ethernet port on the Mac.

2. Plug the other end of the Ethernet cable into the Ethernet port from
your network.

Your network port is probably one of the following: an Ethernet wall
jack, an Ethernet hub or switch, or a cable or DSL Internet router (or
sharing device).
A\
Will you be joining a wireless network? If so, you find the information you need
on configuring Leopard for wireless networking in Chapter 17.

Great, a Lecture about
Handling My Laptop

Proper handling of your laptop is important, so take a moment to cover the
Rules of Proper Laptop Deportment. Okay, perhaps I'm lecturing a bit, but
a little common sense goes a long way when handling any computer equip-
ment, and your laptop is no different. (Scolding mode off.)

Keep these rules in mind while opening and carrying your laptop:

v The cover is your friend. Open your laptop’s cover slowly, without jerk-
ing or bending it.

v Close it before you move it. By closing your laptop, you put your Mac
OS X operating system into sleep mode, and the hard drive automati-
cally spins down (making it safer to move). The laptop is still on, and
will spring back to life after you open the cover.

+ Be nice to your keyboard. Don’t press too hard on those keys! Use
the same amount of pressure that you use with a desktop computer
keyboard.

+* Keep food and drinks far away. Care to turn your laptop into a very
expensive doorstop? Then go ahead and park your soda next to it.
(Oh, and crumbs are perfect if you're interested in buying replacement
keyboards.)

1 Keep your laptop as level as possible. Using your laptop while it’s tilted
too far in any direction can eventually cause problems with your hard
drive. [ kid you not.
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An Overview of Mac Software Goodness

This section answers the most common of all novice computer questions:
“What the heck will I do with this thing?” You find additional details and excit-
ing factoids about the software that you get for free, software you’ll want to
buy, and stuff you can do on the Internet.

What comes with my laptop?

Currently, Apple laptops ship with the following major software applications
installed and ready to use:

v~ The iLife ’08 suite: You know you want these applications! They turn
your Mac into a digital hub for practically every kind of high-tech device
on the planet, including DV camcorders, digital cameras, portable music
players, PDAs, and even cellphones.

Chapters 11-15 focus on the major applications that make up iLife:
iTunes, iPhoto, iMovie, iDVD, and GarageBand.

v iWork trial version: You can try this productivity suite from Apple, but
expect to buy the full shooting match if you want to continue using the
applications.

+* Photo Booth and Front Row: You discover more about these applica-
tions in Chapter 10. For now, sulffice it to say that Photo Booth works
with your laptop’s iSight camera, and Front Row is the remote-control
MBER software you'll use with your Apple remote (if you have one).
The installed software on your Mac might change as new programs become
available.

Connecting to the Internet from your lap

What is a modern computer without the Internet? Apple gives you great tools
to take full advantage of every road sign and offramp on the Information
Superhighway right out of the box:

v Web surfing: | use Leopard’s Apple Safari Web browser every single day.
It’s faster and better designed than Internet Explorer, with unique fea-
tures such as tabbed browsing and built-in RSS feeds.
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If tabbed browsing and RSS feeds sound like ancient Aztec to you, don’t
worry. Chapter 8 is devoted entirely to Safari.

1 Web searches: Dashboard widgets can search the entire Internet for
stocks, movie listings, airline schedules, dictionaries, and foreign lan-
guage translations. I explain Dashboard in Chapter 5.

v Chat: iChat lets you use your Mac to chat with others around the world
for free on the Internet — by keyboard, voice, or full-color video. This
is awesome stuff straight out of Dick Tracy and Buck Rogers. If you've
never seen a video chat, you'll be surprised by just how good your

BE,
&Q’m 4 friends and family look!
&

Always wear a shirt when videoconferencing.

v E-mail: Soldier, Apple’s got you covered. The Mail application is a full-
featured e-mail system, complete with defenses against the torrent of
junk mail awaiting you. (Imagine a hungry digital saber-toothed tiger
with an appetite for spam.) Send pictures and attached files to everyone
on the planet, and look doggone good doing it.

Applications that rock

Dozens of small applications are built into Mac OS X. [ mention them in later
chapters, but here are four good examples to whet your appetite:

v~ Safari: Apple’s Web browser of choice — it’s fast, simple and easily cus-
tomized. See how to navigate the Web in style in Chapter 8.

v DVD Player: Put all that widescreen beauty to work and watch your
favorite DVD movies with DVD Player! You have all the features of
today’s most expensive standalone DVD players, too, including a spiffy
onscreen control that looks like a remote.

v Address Book: Throw away that well-thumbed collection of fading
addresses. Use the Leopard Address Book to store, search, and
recall just about any piece of information on your friends, family,
and acquaintances.

v Chess: Ah, but this isn’t the chessboard your Dad used! Play the game of
kings against a tough (and configurable) opponent — your MacBook — on
a beautiful 3-D board. Heck, your Mac even narrates the game by speaking
the moves!
\\3
You can use the data you store in your Address Book in other Apple applica-
tions included with Leopard, such as Apple Mail and iChat.
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Boot Camp For Dummies

Mac OS X Leopard introduced one particularly exciting feature for Windows
switchers: You can use the Apple Boot Camp utility and your licensed

copy of Windows XP to install and boot Windows on your Intel-based Mac
laptop!

Boot Camp creates a Windows-friendly partition (or section) on your hard
drive, where all your Windows files are stored. Other than the slightly strange
key assignments you’ll have to remember, early adopters of Boot Camp
report that it’s surprisingly reliable and easy to use. However, I strongly urge
that you back up your laptop on a regular basis; inviting Windows to your
Mac laptop also invites potential viruses as well.

Apple’s Boot Camp Assistant provides step-by-step instructions, making it
easy to configure your laptop for Windows. To run the Boot Camp Assistant,
open your Applications folder and double-click on the Utilities folder, and
then double-click on the Boot Camp Assistant application icon.

Other Stuff That Nearly Everyone Wants

No man is an island, and no computer is either. | always recommend the
same set of stuff for new PC and Mac owners. These extras help keep your
new computer clean and healthy (and some make sure you're happy as well):

v Surge suppressor: Even an all-in-one computer like your laptop can fall
prey to a power surge. I recommend using one of these:

¢ A basic surge suppressor with a fuse can help protect your Mac
from an overload.

e A UPS (uninterruptible power supply) costs a little more, but it does
a better job of filtering your AC line voltage to prevent brownouts
or line interference from reaching your computer.

Of course, your laptop’s battery immediately kicks in if you expe-
rience a blackout, so a UPS is less important for your computer.
However, any computer tech will tell you that filtered AC current is
far better for your laptop, and your UPS will also provide power for
external devices that don’t have a battery.

v Screen wipes: Invest in a box of premoistened screen wipes to keep
your screen pristine. Your Mac’s screen can pick up dirt, fingerprints,
and other unmentionables faster than you think.

Make sure your wipes are especially meant for LCD or laptop computer
screens.
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v+~ Blank CDs and DVDs: Depending on the type of optical drive installed
in your laptop — and the type of media you're recording, such as com-
puter data CDs, DVD movies, or audio CDs — you’ll want blank discs for

e CD-R (record once)
e CD-RW (record multiple times)
¢ DVD-R (record once)

v Cables: Depending on the external devices and wired network connec-
tivity you’ll be using, these are

¢ A standard Ethernet cable (for wired networks or high-speed
Internet)

¢ FireWire or USB cables for devices you already have

1 A restraining cable: For those who are a little more security-conscious
or tend to use their laptops in public places, a standard Kensington
laptop lock slot is provided on the MacBook and MacBook Pro case.
(Sorry, MacBook Air owners, but your case is too thin to sport a lock
slot.) The principle is the same as a bicycle cable lock: If your laptop
is secured by a cable to a sturdy fixture, it’s nearly impossible for it to
walk off with someone else.

v A wrist rest: You might have many reasons to buy a new Mac laptop, but
[ know that a bad case of carpal tunnel syndrome is not one of them. Take
care of your wrists by carrying a keyboard wrist rest in your laptop bag.
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Chapter 2

Turning On Your Portable
Powerhouse

In This Chapter

Turning on your laptop

Checking your Mac for proper operation
Monitoring your battery and heat level
Setting up Mac OS X Leopard
Registering your MacBook

Using Migration Assistant

Copying information from a Windows PC

n Chapter 1, you got as far as unpacking your Mac laptop and connecting

a number of cables to it, but unless you bought this computer solely as a
work of modern art, it’s time to turn on your Mac and begin living The Good
Life. (Plus, you still get to admire that Apple design whilst using iTunes.)
After you get your new beauty powered on, [ show you how to run an initial
checkup of your laptop’s health.

[ also familiarize you with the initial chores that you need to complete —
such as using the Mac OS X Setup and moving the data and settings from
your existing computer to your MacBook, MacBook Air, or MacBook Pro —
before you settle in with your favorite applications.

In this chapter, | assume that Mac OS X Leopard was preinstalled on your

Mac or that you just completed an upgrade to Leopard from an earlier ver-
sion of Mac OS X.

Tales of the On Button

Your Mac’s power switch is located on the right side of the keyboard. Press
it now to turn on your Mac, and you will hear the pleasant startup tone that’s
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been a hallmark of Apple computers for many years. Don’t be alarmed if you
don’t immediately see anything onscreen because it takes a few seconds for
the initial Apple logo to appear.

In my experience, sometimes a simple quick press of the power button on
some Mac laptop models just doesn’t do it. Rather, you actually have to
hold the button down for a count of two or so before the computer turns on.
However, if your Mac laptop ever locks up tight (and you can’t quit an appli-
cation, as [ demonstrate in Chapter 4), the power button gives you another
option: Hold it down for a count of five to ten (depending on your counting
speed), and your Mac shuts off — even if your laptop is locked up tight.

As the Apple logo appears, you see a twirling, circular high-tech progress
indicator that looks like something from a James Bond movie. That’s the sign
that your Mac is loading Leopard and checking your internal drive for prob-
lems. Sometimes the twirling circle can take a bit longer to disappear. As long
as it’s twirling, though, something good is happening.

Next, Leopard displays the soon-to-be-quite-familiar Aqua Blue (yup, that’s its
name) background while it loads certain file sharing, networking, and print-
ing components (and such). This time, you get a more conservative progress
bar, but the result is the same. Just wait patiently a bit longer.

At last, your patience of a whole 10-15 seconds is rewarded, and after a short
(but neat) video, you see the Leopard Setup Assistant appear.

Mark’s Favorite Signs
of a Healthy Laptop

Before you jump into the fun stuff, don’t forget an important step — a quick
prelim check of the signs that your new mobile Mac survived shipment intact
and happy.

If you can answer “yes” to each of these questions, your Mac likely made the
trip without serious damage:
1. Does the computer’s chassis appear undamaged?

It’s pretty easy to spot damage to your Mac’s svelte design. Look for
scratches and puncture damage.

2. Does the LCD screen work, and is it undamaged?

Does the cover open smoothly? Are any individual dots (or pixels) on
your LCD monitor obviously malfunctioning? Bad pixels appear black or
in a different color than everything surrounding them. (Techs call these
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irritating anarchists dead pixels. A 13" MacBook screen has literally hun-
dreds of thousands of pixels, and unfortunately, many new LCD screens
include one or two dead ones.

3. Do the keyboard and trackpad work?

Check your Mac’s built-in trackpad by moving your finger across its sur-
face; the cursor should move on your screen. To check the keyboard,
press the Caps Lock key on the left and observe whether the Caps Lock
light turns on and off.

If you do notice a problem with your laptop (and you can use your Safari
browser and reach the Web), you can make the connection to an Apple sup-
port technician at www . apple. com. If your MacBook Pro remains dead —
like an expensive paperweight — and you can’t get to the Internet, you can
check your phone book for a local Apple service center, or call the AppleCare
toll-free number at 1-800-275-2273. Chapter 19 also offers troubleshooting
information.

Vou've Not Going to Lecture
about Batteries, Are You?

A\

No, this is not going to be a lecture. In fact, the only lecture I put you through
in this book concerns backing up (ahem, which you should do). Instead, con-
sider these tips as your rules of the road for monitoring and charging your
battery:

v Recharge in sleep mode or when powered off. Your battery recharges
faster when your laptop is off or in sleep mode. (I go into more detail on
sleep mode in Chapter 6.)

v Keep your laptop plugged into an AC socket when possible. | take
every opportunity to top off my laptop’s battery, and so should you.

If you don’t have much time to charge your battery before you're away
from an AC socket — say, half an hour — don’t use your MacBook whilst
it’s plugged in and charging.

1 Save your juice. For the most juice you can scavenge, here are some
easy tricks:

e Turn off your laptop or leave it in sleep mode.

e Turn off unnecessary hardware. To conserve battery power as
much as possible, disconnect any USB or FireWire devices, and
turn off your AirPort and Bluetooth wireless hardware if you're not
connected to a network. (I cover AirPort wireless networking in
Chapter 17, and Bluetooth in Chapter 18.)

33
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® Reduce the brightness of your display from your laptop’s keyboard,
using the FI key.

e Remove CDs and DVDs from the optical drive. (MacBook Air owners,
don’t go hunting for a built-in optical drive, because your laptop
doesn’t have one.)

 Monitor your battery level from the Finder menu. I love Leopard’s
battery-monitoring system! Your laptop’s battery life can be displayed in
the Finder menu in several different views — my personal favorite is as a
percentage of power remaining (with a fully charged battery registering
at 100%). To display the percentage, click the battery icon in the Finder
menu and choose Show=>Percentage.

Keep in mind that the percentage shown is estimated by using your
current System Preference settings and power usage, so if you change
your Energy Saver settings or remove a USB device that draws power
from your laptop, you'll see that change reflected in the battery meter.
Figure 2-1 illustrates the battery meter in Percentage view.

v~ Calibrate your battery. You can “train” your battery to provide the
maximum charge by calibrating it, which Apple recommends doing
monthly. It’s a snap:

a. Charge your battery until the Finder menu battery meter indicates that
the unit is fully charged at 100%.

b. Keep your laptop connected to an AC socket for another two hours to
ensure a maximum charge.

c. Disconnect the power cord and use your laptop on battery power until
it’s fully discharged and it automatically switches to sleep mode.

\NG/
gg‘“ Make sure that you close all your applications when you see
the low battery warning dialog box so that you don’t lose any-
thing.
d. Allow your laptop to sleep (or turn it off) for a full five hours.
e. Reconnect the AC cord and fully charge your battery.
\“Q‘MBE” If your battery is no longer holding a charge — in other words, if you
Y

fully charge it and unplug the AC adapter, only to discover that you
have only a few minutes of battery life — it’s time to invest in a replace-
ment battery. MacBook and MacBook Pro owners can buy a new battery
themselves (from Apple or any one of a number of online vendors),

but owners of MacBook Air laptops must bring their computers in for
servicing. The Air is a sealed unit, and you can’t replace the battery
yourself.
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Hot patootie, is my laptop steam-powered?

Laptops generate heat. And today’s super-fast
multicore processors can work up a head of
steam — pun intended — while you're using
them, and even though most MacBooks have
a fan, some of that heat is simply radiated from
the bottom of the computer.

What you might not realize, however, is just
how much heat your MacBook, MacBook Air,
or MacBook Pro can produce! No, you won't be
scalded if you shift your MacBook from a desk
to your lap (Apple dislikes lawsuits as much as
the next company), but if you've been using that
laptop for hours, it will be uncomfortably hot!

To avoid that burning sensation, buy a laptop
stand or cooling pad for your desk. These nifty
metal or Plexiglas pedestals raise your laptop up
off of your desk, allowing air to flow under the
bottom of the computer for better cooling. Also,
a laptop stand elevates the screen to a more
ergonomic position. (The keyboard might sud-
denly be harder to use, naturally, but that's yet
another reason why | recommend an external
keyboard when you're using your Mac laptop at
a semipermanent desk location; it saves wear
and tear on your laptop keyboard, and you get
a full-size keyboard.)
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Setting Up and Registering Your Laptop

After your Mac is running and you give it the once-over for obvious ship-
ping damage, your next chore is to set up your laptop. Unlike other tasks in
this book, I won’t cover the setup process step by step. Apple contextually
tweaks the questions that you see during setup on a regular basis, and the
questions are very easy to answer. Everything is explained onscreen, com-
plete with onscreen Help if you need it.

However, [ do want you to know what to expect as well as what information

you need to have at hand. I also want you to know about support opportunities,
such as the Apple .Mac Internet services. Hence, this section: Consider it a study
guide for whatever your MacBook’s setup procedure has to throw at you.
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Setting up Mac 0S X Leopard

After you start your computer for the first time — or if you just upgraded
from Mac OS 9 or an earlier version of Mac OS X — your laptop will likely
launch Leopard Setup automatically. (Note that some custom install options,
such as the Archive and Install option, might not launch the setup proce-
dure.) The setup process takes care of a number of different tasks:

v Setup provides Leopard with your personal information. As [ mention
in Chapter 1, your Mac ships with a bathtub full of applications, and
many of those use your personal data (such as your address and tele-
phone number) to automatically fill out your documents.

If that stored personal information starts you worrying about identity
theft, [ congratulate you. If you're using your common sense, it should.
However, in this case, Apple doesn’t disseminate this information any-
where else, and the applications that use your personal data won’t send
it anywhere, either. And Safari, the Apple Web browser, fills out forms
on a Web page automatically only if you give your permission.

1 Setup creates your user account. You'll be prompted for a username
and password, which Setup uses to create your administrator-level
account.

v Setup configures your language and keyboard choices. Mac OS X is a
truly international operating system, so you are offered a chance to con-
figure your laptop to use a specific language and keyboard layout.

1 Setup configures your e-mail accounts in Apple Mail. If you already
have an e-mail account set up with your ISP, keep handy the e-mail
account information that the ISP provided to answer these questions.
The info should include the incoming POP3 and outgoing SMTP mail
servers you'll be using, your e-mail address, and your login name and
password. Leopard can even automatically configure many Web-based
e-mail accounts for you (including Google Mail, Yahoo! Mail, and AOL
Mail) if you supply your account ID and password. Sweet.

v~ Setup allows you to open a free trial subscription with Apple’s .Mac
service. A .Mac subscription provides you with online file storage, iSync
capability across multiple computers, backups to your online storage,
Apple e-mail accounts (through both Web mail and the Apple Mail appli-
cation), photocasting, podcasting, and your own acre of iWeb site on
the Internet. [ go into all these in detail in Chapter 9, but for now, just
sign up (or sign in, if you already have an existing account) and take the
opportunity to feel smug about owning an Apple computer.

1 Setup sends your registration information to Apple. As a proud owner
of a Mac laptop, take advantage of the year of hardware warranty sup-
port and the free 90 days of telephone support. All you have to do is reg-
ister to use ’em. Rest assured that all this info is confidential.
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v Setup launches Migration Assistant. This assistant guides you through
the process of migrating (an engineer’s term for moving) your existing
user data from your old Mac or PC to your new laptop. Naturally, if your
MacBook is your first Macintosh computer, you can skip this step with
a song in your heart! (Read more on Migration Assistant in the section,
“Importing Stuff from Another Mac.”)

Registering your MacBook

I'll be honest here: I know that many of us, myself included, don’t register
every piece of computer hardware we buy. For example, I didn’t register my
wireless Bluetooth adapter that [ bought for my older iBook because the total
expenditure was only around $40, the gizmo has no moving parts, and I'm
never likely to need technical support to use it or get it fixed.

However, your MacBook is a different kettle of fish altogether, and I strongly
recommend that you register your purchase with Apple during the setup pro-
cess. You spent a fair amount on your computer, and it’s an investment with
a significant number of moving parts.

Even the hardiest of techno-wizards would agree with this important Mark’s
Maxim:

If you don’t register your new laptop, you can’t receive support.™

And rest assured that Apple is not one of those companies that constantly
pesters you with e-mail advertisements and near-spam. 've registered every
Apple computer I've owned, and I've never felt pestered. (And [ have an
extremely low tolerance for pester.)

Importing Stuff from Another Mac

If you're upgrading from an older Mac running Mac OS X to your new
MacBook or MacBook Pro, I have great news for you: Apple includes
Migration Assistant, a utility application that can help you copy (whoops, 1
mean, migrate) all sorts of data from your old Mac to your new machine, via
your laptop’s FireWire port.

To use Migration Assistant to copy your system from your older Mac, you
need a FireWire cable to connect the computers. If you don’t already have
one, you can pick one up at your local Maze o’ Wires electronics store or at
your computer store. (This cable will probably come in handy in the future
as well, so it’s not a one-use wonder.)
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If you’re a MacBook Air owner, you might be scratching your head looking for
a FireWire port on your new laptop. Let me save you the trouble: You don’t
have one. Therefore, you can’t use the Migration Assistant in FireWire mode
at the time of this writing. (I hope that Apple will fix this and add USB 2.0 sup-
port to Migration Assistant soon.) However, you can use a network connec-
tion between computers. Assuming that both your MacBook and your older
Mac can communicate over your home or office network, just click the Use
Network button on the Connect Your Computers screen to transfer data!

As I mention earlier, Setup launches Migration Assistant automatically if you
indicate that you need to transfer stuff during the setup process, but you can
always launch Migration Assistant manually at any time. You'll find it in the
Utilities folder inside your Applications folder; just double-click the Migration
Assistant icon.

The list of stuff that gets copied over includes the following:

v~ User accounts: If you set up multiple user accounts (so that more than
one person can share the computer), the utility ports them all to your
new Mac.

1 Network settings: Boy, howdy, this is a real treat for those with manual
network settings provided by an ISP or a network administrator!
Migration Assistant can re-create the entire network environment of
your old Mac on your new laptop.

v~ System Preference settings: If you're a fan of tweaking and customizing
Mac OS X to fit you like a glove, rejoice. Migration Assistant actually
copies over all the changes that you’'ve made in System Preferences on
your old Mac! (Insert sound of angelic chorus: Hallelujah!)

v Documents: The files in your Documents folder(s) are copied to your
new Mac.

v~ Applications: Migration Assistant tries its best to copy over the third-
party applications that you’ve installed in your Applications folder on the
older Mac. I say tries its best because you might have to reinstall some
applications, anyway. Some developers create applications that spread
out all sorts of files across your hard drive, and Assistant just can’t keep
track of those nomadic files. And some other applications make the trek
just fine, but you might have to reenter their serial numbers.

Follow these steps to use Migration Assistant:
1. If Migration Assistant isn’t already open, open the Utilities folder

inside your Applications folder and then double-click the Migration
Assistant icon.
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2. Click Continue on the opening screen.

Migration Assistant prompts you for the account name and password
that you create during the setup procedure, as shown in Figure 2-2. Your
account is an admin account, meaning that you have a higher security
level that allows you to change things in Leopard. (See Chapter 16 for
much more detail on user accounts.)

A Migration Assistant

Introduction

You can use Migration Assistant to transfer your important

Migration Assistant requires that you type
R your password.

L %

Name: Mark Chambers

Password: [| ]

» Details

@ (Cancel) (0K )

Go Back { Continue )

3. Type your account name and password, and then click OK.

Characters in your password are displayed as bullet characters for secu-
rity. After you successfully enter your admin account name and pass-
word, this dialog disappears, and you get to play in the real Migration
Assistant dialog.

. Select the From Another Mac radio button and then click Continue.

In case you’ve lost the data on your hard drive (or you've upgraded
your hard drive), you can also restore your MacBook’s data from a Time
Machine backup drive by using Migration Assistant. (You find all the
details on Time Machine in Chapter 21.)

. Connect a FireWire cable between the two computers. Then click

Continue.

As I mention earlier, if you’d rather use a wired or wireless Ethernet
connection between the computers, click the Use Network button
and eschew the FireWire cable completely. (MacBook Air owners will
also have to use a network connection because the Air doesn’t have a
FireWire port.)
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If you take this route, skip Steps 6 and 7. Instead, run Migration Assistant
on your older Mac and follow Steps 1-4, but click To Another Mac

on your older machine and then click Continue. Follow the onscreen
instructions to enter the passcode, and then continue with Step 8.

. Restart your older Mac while holding down the T key.

This restarts your older computer in FireWire Target Disk mode, in which
your older Mac essentially becomes a huge external FireWire hard drive.
(Neat trick.)

You must hold down the T key until you see the FireWire symbol (which
looks like a stylized Y) appears on your older machine.

. Click Continue.

8. Select the check boxes next to the user accounts that you want to

10.

11.
12.

transfer from your older machine and then click Continue.

Migration Assistant displays how much space is required to hold the
selected accounts on your new laptop’s hard drive.

. Select the check boxes next to the applications and files that you want

to copy. Then click Continue.
Select the check boxes next to the settings that you want to transfer.

Normally, you want to migrate all three of these settings groups:
Network Settings, Time Zone and Sharing Settings.

Click the Migrate button.

After everything is copied, press the power button on your older Mac
to shut it off. Then disconnect the FireWire cable (if necessary).

Importing Stuff from Windows
(1f You Must)

If you're a Windows-to-Mac Switcher, you made a wise choice, especially if
you're interested in the creative applications in the iLife suite! Although you
could choose to start your Apple computing life anew, you probably want to
migrate some of your existing documents and files from that tired PC to your
bright, shiny, new MacBook.
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Unfortunately, Mac OS X has no Windows Migration Assistant. However, if
you're moving from a Windows PC to a Mac, you can copy your files manu-
ally from a CD or DVD, a USB Flash drive, or over a network. (Note, however,
that today’s Mac laptops don’t come with a floppy drive. And trust me, you
wouldn’t want to use one to move anything that matters, anyway.)

The Mac OS X Help system contains an entire subsection on specific tricks
you can use when switching from Windows to Mac, including how to connect
to a Windows network and how to directly connect the two computers.

Even with Boot Camp — Apple’s dual-boot feature that allows you to run both
Leopard and Windows XP/Vista on your MacBook, MacBook Pro, or MacBook
Air — manually moving existing Windows applications (such as Paint Shop
Pro) to your laptop’s hard drive usually won’t work. That’s because most
Windows software installs all sorts of necessary files in several folders across
your hard drive. Instead, you have to install Windows XP or Windows Vista
on your Mac laptop (using Boot Camp) and then reinstall your Windows
applications.

If you don’t mind investing around $50, use the Move2Mac software utility,
which does most of the work of Migration Assistant for those switching from
a Windows PC. From Detto Technologies (www.detto.com/move2mac),
Move2Mac comes complete with a special USB-to-USB cable that connects
your two computers for high-speed copying. You can choose what you want
to transfer to your new Mac (use Table 2-1 as a guide), and the copying is per-
formed automatically for you. Plus, Move2Mac transfers goodies such as your
home page and bookmarks from Internet Explorer, desktop backgrounds, and
even your Address Book contacts and account settings from Outlook Express.
Move2Mac makes switching much easier, and [ can highly recommend it.

Table2-1  Moving Media and Documents betwixt Computers

File Type Windows Location Mac 0S X Mac Application
Location
Music files My Music folder Music folder iTunes
Video and My Videos folder Movies folder QuickTime/
movie files DVD Player
Digital photos My Pictures folder Pictures iPhoto
folder
Office documents My Documents Documents Mac Office/

folder folder iWork
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Switching froma PCto ... an Apple PC?

With the Leopard Boot Camp feature, you can
actually create a full Windows XP or Vista
system on your Intel-based Mac laptop. Yup,
Windows and Leopard coexist peacefully on
the same computer. However, you'll have to
reboot your computer to use your MacBook as
a Windows system.

This brings a whole new meaning to the term
Switcher because some Mac owners are
moving their stuff from Windows (running on
their old PC) to . . . well, Windows (running on

their new laptop) instead of Leopard. If you do
decide to create a Windows system on your
MacBook with Boot Camp, the files and fold-
ers on your existing PC can be copied directly
by using the Files and Settings Transfer Wizard
(in Windows XP) or the Windows Easy Transfer
utility (in Windows Vista). In effect, you're copy-
ing your settings and data between your old PC
and your new Apple-based PC! (That sounds a
little skewed, but die-hard Apple apostles will
have to forgive me.)




Chapter 3

The Laptop Owner’s Introduction
to Mac 0S X

In This Chapter
Introducing Mac OS X Leopard

Appreciating the Unix core underneath Leopard
Recognizing similarities between Windows XP and Leopard
Getting help while learning about Leopard

n the other books that I've written about Mac OS X Leopard, I use all

sorts of somewhat understated phrases to describe my operating system
of choice, such as elegantly reliable, purely powerful, and supremely user
friendly.

But why is Leopard such a standout? To be specific, why do creative profes-
sionals and computer techno-wizards across the globe hunger for the very
same Mac OS X that runs your MacBook? Why is Leopard so far ahead of
Windows Vista in features and performance? Good questions, all!

In this chapter, | answer those queries and satisfy your curiosity about your
new big cat. I introduce the main elements of the Leopard Desktop, and I
show you the fearless Unix heart that beats underneath Leopard’s sleek exte-
rior. I also point out the most important similarities between Leopard and
Windows Vista, and [ outline the resources available if you need help with
Mac OS X.

Oh, and I promise to use honest-to-goodness English in my explanations, with
a minimum of engineer-speak and indecipherable acronyms. (Hey, you've got
to boast about Leopard in turn to your family and friends. Aunt Harriet might
not be as technologically savvy as we are.)
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Vour Own Personal Operating System

3

Leopard is a special type of software called an operating system. You know,
OS, as in Mac OS X? That means that Leopard essentially runs your MacBook
and also allows you to run all your other applications, such as iTunes or
Photoshop. It’s the most important computer application — or software —
that you run.

Think of a pyramid, with Leopard as the foundation and other applications
running on top.

You're using the OS when you aren’t running a specific application, such as
these actions:

v Copying files from a CD to your hard drive

v Choosing a different screensaver

Sometimes, Leopard even peeks through an application while it’s running.
For example, application actions like these are also controlled by Leopard:

v The Open, Save, and Save As dialogs that you see when working with
files in Photoshop

v The Print dialog that appears when you print a document in Microsoft
Word

In this section, [ escort you personally around the most important hotspots
in Leopard, and you meet the most interesting onscreen thingamabobs
that you use to control your laptop. (I told you I wasn’t going to talk like

an engineer!)

The Leopard Desktop

This particular desktop isn’t made of wood, and you can’t stick your gum
underneath. However, your Leopard Desktop does indeed work much like
the surface of a traditional desk. You can store things there, organize things
into folders, and take care of important tasks like running other applications.
Heck, you've even got a clock and a trash can.

Gaze upon Figure 3-1 and follow along as you venture to your Desktop and
beyond.
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Dock Icons

Meet me at the Dock

The Dock is the closest thing to the dashboard of a car that you're likely to
find on a Macintosh. It’s a pretty versatile combination: one part organizer,
one part application launcher, and one part system monitor. From here, you
can launch applications, see what’s running, and display or hide the windows
shown by your applications.

Each icon in the Dock represents one of the following (many of which are
proudly displayed in Figure 3-2):

v An application that you can run (or is running)

v An application window that’s minimized (shrunk)

v A Web page URL link

b5
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|
Figure 3-2:
The Dock
can contain
all sorts of
exotic icons.
|
\\J

v A document or folder on your system
v A network server or shared folder
v Your Trash

I cover the Dock in more detail in Chapter 5.
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The Dock is highly configurable:

v~ It can appear at different edges of the screen.

v It can disappear until you move your mouse pointer to the edge to call it
forth.

v You can resize it.

Dig those crazy icons
By default, Leopard always displays at least one icon on your Desktop: your

Mac’s internal hard drive. To open a hard drive and view or use the contents,
you double-click the icon. Other icons that might appear on your Desktop
can include

v CDs and DVDs

v An iPod

v External hard drives or USB Flash drives

v Applications, folders, and documents

v Files you downloaded from the Internet

v Your iDisk (if you have a .Mac account)

1+~ Network servers you access

Chapter 4 provides the good stuff on icons and their uses within Leopard.
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There’s no food on this menu

The Finder menu isn’t found in a restaurant. You find it at the top of the
Desktop, where you can use it to control your applications. Virtually every
application that you run on your laptop has a menu.

To use a menu command, follow these steps:

1. Click the menu group (such as File or Edit).
2. Choose the desired command from the list that appears (see Figure 3-3).

Virtually every Macintosh application has some menu groups, such as File,
Edit, and Window. You're likely to find similar commands within these groups.
However, only two menu groups are in every Mac OS X application:

v The Apple menu (which is identified with that jaunty Apple Corporation
icon, ").

v The Application menu (which always bears the name of the active appli-
cation). For instance, the DVD Player menu group appears when you run
the Leopard DVD Player, and the Word menu group appears when you
launch Microsoft Word.

I cover these two common groups in more detail in Chapters 4 and 5.
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You can also display a contextual menu — which regular human beings call a
right-click menu — by right-clicking your Leopard Desktop, or an application, a
folder, or a file icon. I get into the right-click menu in detail in the next chapter.
(You can also right-click by holding down the Ctrl key while clicking, or by tap-
ping the trackpad with two fingertips.)

There’s always room for one more window

You're probably already familiar with the ubiquitous window itself. Both
Leopard and the applications that you run use windows to display things like

v The documents that you create

v The contents of your hard drive

For example, the window in Figure 3-1 is a Finder window, where Leopard
gives you access to the applications, documents, and folders on your system.

Windows are surprisingly configurable. I cover them at length in Chapter 4.

Why get so excited by Leopard?

How the core of an operating system is designed makes more of a differ-

ence than all the visual bells and whistles, which tend to be similar between
Windows Vista/XP and Mac OS X Leopard (and Linux as well, for that matter).
Time for a Mark’s Maxim:

Sure, Leopard’s elegant exterior is a joy to use, but Mac OS X is a better OS
than Windows because of the unique Unix muscle that lies underneath!™

So what should you and I look for in an OS? Keep in mind that today’s com-
puter techno-wizard demands three requirements for a truly high-powered
software wonderland — and Mac OS X Leopard easily meets all three:

v~ Reliability: Your OS has to stay up and running reliably for as long as
necessary — I'm talking months here — without lockups or error mes-
sages. If an application crashes, the rest of your work should remain
safe, and you should be able to shut down the offending software.

v Performance: If your computer has advanced hardware, your OS must
be able to use those resources to speed things up big-time. The OS has
to be highly configurable, and it has to be updated often to keep up with
the latest in computer hardware.

“Mark, what do you mean by advanced hardware?” Well, if you're already
knowledgeable about state-of-the-art hardware, examples include

¢ True 64-bit computing

e Multiple processors (like more than one Intel chip in your computer)
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¢ A huge amount of RAM (2GB on most MacBooks, or far more on
today’s Mac Pro desktop computers)

¢ Enough hard drive space to make use of a RAID array

If all that sounds like ancient Sumerian, gleefully ignore this technical

drabble and keep reading.

1 Ease of use: All the speed and reliability in the world won’t help an OS if

it’s difficult to use.

Like Windows done right

You might have heard of the Windows Switcher: a uniquely intelligent species

that’s becoming more and more common these days. Switchers are former

PC owners who have abandoned Windows and bought a Macintosh, thereby

joining the Apple faithful running Mac OS X. (Apple loves to document this

migration on its Web site.) Because today’s Macintosh computers are signifi-

cantly faster than their PC counterparts — and you get neat software, such
as Leopard and the iLife suite when you buy a new Mac — switching makes

perfect sense.

Switchers aren’t moving to totally unfamiliar waters. Windows XP, Windows
Vista, and Leopard share a number of important concepts. Familiarizing your-
self with Leopard takes far less time than you might think.

It's Apple to the rescue!

Unix is the established, super-reliable 0S that
powers most of the high-performance servers
that make up the Internet. Unix has built-in sup-
port for virtually every hardware device ever
wrought by the hand of Man (including all the
cool stuff that came with your MacBook), and
Unix is well designed and highly efficient.

Unfortunately, standard Unix looks as hideous
as DOS, complete with a confusing command
line, so ease-of-use for normal human beings
like you and me goes out the door. Enter the
genius types at Apple, who understood several
years ago that all Unix needed was a state-of-
the-art, novice-friendly interface! To wit: Mac
0S X was developed with a Unix foundation

(or core), so it shares the same reliability and
performance as Unix. However, the software
engineers at Apple (who know a thing or two
about ease-of-use) made it good looking and
easy to use.

If you're interested in all the details about what
makes Mac 0S X tick, as well as its settings and
features, | can heartily recommend another of
my books, the bestselling (and extremely heavy)
Mac 0S X Leopard All-in-One Desk Reference
For Dummies (Wiley). It comprehensively
covers everything Leopard — over 700 pages
devoted entirely to Mac OS X and its companion
applications!
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Here’s an overview of the basic similarities between the two operating systems:

v The Desktop: The Leopard Desktop is a neat representation of a real
physical desktop, and Windows uses the same idea:

* You can arrange files, folders, and applications on your Desktop to
help keep things handy.

e Application windows appear on the Desktop.

v Drives, files, and folders: Data is stored in files on your hard drive(s),
and those files can be organized in folders. Both Leopard and Windows
use the same file/folder concept.

v~ Specific locations: Both Windows and Leopard provide every user with
a set of folders to help keep various types of files organized. For exam-
ple, the My Videos folder that you can use in Windows XP corresponds
to the Movies folder that you find in your Home folder within Leopard.

+ Running programs: Both Leopard and Windows run programs (or appli-
cations) in the same manner:

¢ Double-clicking an application icon launches that application.

¢ Double-clicking a document runs the corresponding application
and then automatically loads the document.

v Window control: Yep, both operating systems use windows, and those
windows can be resized, hidden (or minimized), and closed in similar
fashions. (Are you starting to see the connections here?)

v Drag and drop: One of the basics behind a GUI (a ridiculous acronym
that stands for graphical user interface) like Windows and Leopard is the
ability to drag documents and folders around to move, delete, copy, and
load them. Drag-and-drop is one of the primary advantages of both of
these operating systems because copying a file by dragging it from one
window to another is intuitive and easy enough for a kid to accomplish.

v Editing: Along the same lines as drag-and-drop, both Leopard and
Windows offer similar cut-and-paste editing features. You've likely used
Cut, Copy, and Paste for years, so this is familiar stuff.

And Just in Case You Need Help . . .

You can call on these resources if you need additional help while you're dis-
@ covering how to tame the Leopard.
;\
Some of the help resources are located on the Internet, so your Web browser
will come in handy.
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The Leopard built-in Help system

Sometimes the help you need is as close as the Help group on the Finder
menu. You can get help for either

1 A specific application: Just click Help. Then, click in the Search box
and type a short phrase that sums up your query (such as startup keys).
You'll see a list of help topics appear on the menu. Just click a topic to
display more information.

v General topics: Click a Finder window and then click Help on the menu.
Again, you’ll see the Search box, and you can enter a word or phrase to
find within the Help system. To display the Help viewer window, click
the Mac Help item under the Search box.

The Apple Web-based support center

Apple has online product support areas for every hardware and software
product that it manufactures. Visit www.apple.com and click the Support
tab at the top of the Web page.

The Search box works just like the Mac OS Help system, but the Knowledge
Base that Apple provides online has a lot more answers.

Magazines

Many magazines (both in print and online) offer tips and tricks on using and
maintaining Mac OS X Leopard.

My personal online favorites are Macworld (www .macworld. com) and
Maclife (www.maclife.com).

Mac support Web sites

A number of private individuals and groups offer support forums on the Web,
and you can often find help from other Mac owners on these sites within a
few hours of posting a question.

I'm very fond of MacFixIt (www.macfixit.com), Mac OS X Hints (http://
forums.macosxhints.com) and MacMinute (www.macminute. com).
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Mac newsgroups on Usenet

If you're familiar with Usenet newsgroups, you can find lots of help (typically
dispensed with a healthy dose of opinion) in newsgroups like comp . sys.
mac.systemand comp.sys.mac.applications. Simply post a message
and then check back within a few hours to read the replies.

Local Mac user groups

I'd be remiss if [ didn’t mention your local Mac user group. Often, a user
group maintains its own Web site and discussion forum. If you can wait until
the next meeting, you can even ask your question and receive a reply from a
real-live human being . . . quite a thrill in today’s Web-riffic world!



Partll

Shaking Hands
with Mac 0S X

The Sth Wave By Rich Tennant

AFTER INSTALLING OS X LEOPARD
NED AND LORETTA SELECT THE
COMPUTERS BACKGROUND

© RICHTENNANT —

“Oh -1 like this background much better than
the basement.”



In this part . . .

t’s time to delve deeper into the workings of Mac OS X
Leopard. Here, I show you how to perform all sorts of
common tasks as well as how to customize your system,
how to change settings in System Preferences, where
your personal files are stored, and how to use the latest
Spotlight search technology to find anything you've stored
on your MacBook, MacBook Pro, or MacBook Air!




Chapter 4

Opening and Closing and
Clicking and Such

In This Chapter
Introducing the highlights of the Finder
Coping with that missing trackpad button
Launching and quitting applications
Identifying and selecting icons
Using keyboard shortcuts to speed things up
Managing windows in Leopard

A h, the Finder — many admire its scenic beauty, but don’t ignore its
unsurpassed power nor its many moods. And send a postcard while
you're there.

Okay, so Leopard’s Finder might not be quite as majestic as the mighty
Mississippi River, but it’s the basic toolbox that you use every single day
while piloting your MacBook. The Finder includes the most common ele-
ments of Mac OS X: window controls, common menu commands, icon fun
(everything from launching applications to copying files), network connec-
tions, keyboard shortcuts, and even emptying the Trash. In fact, one could
say that if you master the Finder and find how to use it efficiently, you're on
your way to becoming a power user! (My editor calls this the Finder “window
of opportunity.” She’s a hoot.)

That’s what this chapter is designed to do: This is your Finder tour guide,
and we're ready to roll.

Using the All-Powerful Finder

This is a hands-on tour, with none of that, “On your right, you’ll see the
historic Go menu” for you! Time to get off the bus and start the tour with
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Figure 4-1, in which I show you around the most important elements of the
Finder. (In the upcoming section, “Performing Tricks with Finder Windows,” |
give you a close-up view of window controls.)

The popular attractions include

1+~ The Apple menu (%): This is a special menu because it appears both
in the Finder and within every application menu that you run. It doesn’t
matter whether you're in iTunes or Photoshop or Word: If you can see a
menu bar, the Apple menu is there. The Apple menu contains common
commands to use no matter where you are in Leopard, such as Restart,
Shut Down, and System Preferences.

v The Finder menu bar: Whenever the Finder itself is ready to use (or, in
Mac-speak, whenever the Finder is the active application, rather than
another application), the Finder menu bar appears at the top of your
screen. You know the Finder is active and ready when the word Finder
appears at the left of the menu bar.

If you're brand new to computers, a menu is simply a list of commands.
For example, you click the File menu and then choose Save to save a
document. When you click a menu, it extends down so that you can see
the commands it includes. While the menu is extended, you can choose
any enabled menu item (just click it) to perform that action. You can tell
that an item is enabled if its name appears in black. Conversely, a menu
command is disabled if it is grayed out — clicking it does nothing.

When you see a menu path, like this example — Filer>Save — it’s just
a visual shortcut that tells you to click the File menu and then choose
Save from the drop-down menu that appears.

v The Desktop: Your Desktop serves the same purpose as your physical
desktop: You can store stuff here (files, alias icons, and so on), and it’s
a solid, stable surface where you can work comfortably. Application
windows appear on the Desktop, for example, as do other applications,
such as your Stickies notes and your DVD player. Just double-click an
application there to launch it.

Your Desktop is easily customized in many ways. For example, you can
use your own images to decorate the Desktop, organize it to store new
folders and documents, arrange icons how you like, or put the Dock in
another location. Don’t worry — I cover all this in other areas of the
book — I just want you to know that you don’t have to settle for what
Apple gives you as a default Desktop.

v All sorts of icons: This is a Macintosh computer, after all, replete with
tons of make-your-life-easier tools. Check out the plethora of icons on
your Desktop as well as icons within the Finder window itself. Each icon
is a shortcut of sorts to a file, folder, network connection, or device in
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|
Figure 4-1:
Leopard’s
friendliest
face —the
Finder,
complete
with a
window and
menu bar.
|

your system, including applications that you run and documents that
you create. Refer to Figure 4-1 to see the icon for my MacBook Pro’s
hard drive icon, labeled Wolfgang. (I'm a huge Mozart fan.) Sometimes
you click an icon to watch it do its thing (like icons in the Dock, which
I cover next), but usually you double-click an icon to make something
happen.

v The Dock: The Dock is a launching pad for your favorite applications,

documents, folders, network connections, and Web sites. You can also
refer to it to see what applications are running. Click an icon there to
open the item. For example, the postage stamp icon represents the
Apple Mail application, and clicking the spiffy compass icon launches
your Safari Web browser.

v The Finder window: Finally! The basic Finder window in Figure 4-1 dis-

plays the contents of my Applications folder. You use Finder windows to
launch applications; perform disk chores, such as copying and moving
files; and navigate your hard drive.
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My, what an attractive Sidebar . .. and so useful!

Have you noticed the Sidebar that occupies the
left side of every Finder window? It's a pane of
links to common locations and devices that you
can use to jump like a flash to a specific spot
on your hard drive. For example, you can click
the Applications link under the Places heading,
and you're there in an instant. The Sidebar also
contains a Search For heading that displays
the applications, files and folders that you've
accessed today, yesterday and this past week.
(Heck, you can even search for all the images,
movies, and documents on your system from

Here's a great example of Sidebar magic: | like
as few icons on my Desktop as possible, so
each book I'm working on gets its own folder.
All the items for that project that might other-
wise end up on my Desktop are saved into that
folder instead. In fact, | make a point of adding
my current book project folder to my Finder
window Sidebar so that it's available immedi-
ately from any Finder window. To do this, just
drag the folder into the column at the left side of
the Finder window and drop it under the Places
heading in the Sidebar's list.

\NG/
Vg‘\\

this same Search For section!)

Wait a Second: Where the Heck
Is the Right Mouse Button?

Leopard takes a visual approach to everything, and what you see in Figure 4-1 is
designed for point-and-click convenience because the trackpad is your primary
navigational tool while you're using your Mac laptop. You move your finger over
the surface of the trackpad, and the cursor follows like an obedient pup. The
faster you move your finger, the farther the cursor goes. You click an item, it
opens, you do your thing, and life is good.

Never use any object other than your finger on the trackpad! That means no
pencils (no, not even the eraser end), pens, or chopsticks; they can damage
your trackpad in no time at all.

If you've grazed on the other side of the fence — one of Those Who Were
Once Windows Users — you're probably accustomed to using a mouse with
at least two buttons. This brings up the nagging question: “Hey, Mark! Where
the heck is the right button?”

In a nutshell, the right button simply ain’t there. At least, if you're using your
Mac laptop’s trackpad, it simply ain’t there. The entire bottom of the track-
pad is one huge button, and you click something by pressing down anywhere
on the top surface of the aforementioned bump.
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Lean in closer, and I'll tell you a secret. (Dramatic pause.) This is one of the
few disagreements that [ have with my friends at Apple Inc. Once upon a
time, Apple felt that a mouse needed but one button, and until the arrival of
the Mighty Mouse on Apple’s desktop models, it was the only button you got.
And you liked it. And you still do, if you're using a Mac laptop’s trackpad.

If you're like me, you feel that a right button is pretty doggone essential. In
fact, when my laptop is on my desk at home, I plug in a Logitech optical track-
ball (a really fancy mouse, in effect). This neat device has both a right mouse
button and a scroll wheel. So here’s a Mark’s Maxim that I think you’ll appre-
ciate more and more as you use your laptop.

If you can afford a new USB mouse or trackball with more than one button,
buy it. You can thank me later with an e-mail message, which you can send to
mark@mlcbooks.com.™

In fact, a new industry is springing up for tiny USB mousing devices especially
made for laptops. Some devices are smaller than a business card, but they
still carry a full complement of two buttons and a scroll wheel. You can carry
one of these mini-mice in your laptop bag and eschew your trackpad com-
pletely. In fact, in this book I'm going to refer to the pointer as the “mouse
pointer,” whether you're using your trackpad or a mouse.

If you have a pointing device with two buttons, you’ll find that clicking the
right mouse button performs the same default function in Leopard that it
does in Windows. Namely, when you click the right mouse button on most
items — icons, documents, even your Desktop — you get a contextual menu
of things. That is, you get more commands specific to that item. (Boy, howdy,
[ hate that word contextual, but that’s what engineers call it. I call it the right-
click menu, and [ promise to refer to it as such for the rest of the book.)

Figure 4-2 illustrates a typical convenient right-click menu within a Finder
window. I have all sorts of cool items at my disposal on this menu because of
the applications I've installed that make use of a right-click menu.

If you're using your laptop’s trackpad or one-button mouse, don’t despair.
You can still display a right-click menu: Just hold down the Control key while
you click.

Pressing an extra key, as you might imagine, can be a real downer, especially
if your non-trackpad-using hand is busy doing something else. Hence my pre-
ceding Mark’s Maxim. Someday, Apple will finally throw in the towel and add
a second trackpad button to their laptops. Luckily, you can also configure
your trackpad to recognize a tap with two fingertips as a right-click (as I men-
tion earlier in this section).
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Clicking and right-clicking magic

Here are some handy and painless workarounds: Head over to System
Preferences and open the Keyboard & Mouse Pane (under Hardware). Look
for the Trackpad options. Find the Clicking check box and enable it. Now,
when you tap the trackpad quickly, your Mac laptop counts that as a click,
and two fast taps act as a double-click. Enable the Tap Trackpad Using Two
Fingers for Secondary Click check box, and suddenly a single tap with two fin-
gers displays the right-click menu (which I cover in more detail in a paragraph

or two).

It’s okay to scroll with your fingers

If you move two fingers over the surface of the trackpad at once, the Finder
window or application scrolls the contents of the window in the direction you
move. (For example, you can use the scroll function to move up and down
through the pages of a document or to move up and down through a long Web
page.) Who needs scroll bars?
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Doing the Multi-Touch thing

The latest crop of MacBooks — including the MacBook Air — have the smart-
est trackpads on the planet! That’s because Apple recently introduced a new
feature called Multi-Touch, which allows you to control the view of a docu-
ment by using specific finger motions on the trackpad. Here’s the rundown:

v+ Two-finger zooming: Pinching your thumb and first fingertip toward
each on the trackpad other zooms in on a document or image. The
reverse (moving your fingertips away from each other) zooms out.

v Two-finger rotating: Rotate your thumb and first fingertip in a circle
on the trackpad to rotate an image or document in the corresponding
direction.

v Three-finger paging: Move your thumb and first two fingertips to the
left or right across your trackpad to page through a document or move
to the next or previous image in a set.

Unfortunately, Multi-Touch doesn’t work with every application, but support
for this neat feature is rapidly being added by Apple software developers.
(For now, [ recommend you try out your fingertips in iPhoto and Pages!)

Visit the Keyboard & Mouse pane within System Preferences to configure your
wireless mouse as well. (More on the System Preferences window in the next
section.)

Launching and Quitting Applications
with Aplomb

A\\S

Now it’s time for you to pair your newly found trackpad acumen with
Leopard’s Finder window. Follow along this simple exercise. Move your
cursor over the iTunes icon in the Dock (this icon looks like an audio CD
with musical notes on it). Then click the trackpad button (default) or tap the
trackpad once with your fingertip (see the preceding section for how to set
this preference). Whoosh! Leopard launches (or starts) the iTunes applica-
tion, and you see a window much like the one in Figure 4-3.

If an application icon is already selected (which I discuss in the next section),
you can simply press O+O to launch it. The same key shortcut works with
documents, too.
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Besides the Dock, you have several other ways to launch an application or
open a document in Leopard:

1+ From the Apple menu (%): A number of different applications can
always be launched anywhere within Leopard from the Apple menu:

e System Preferences: This is where you change all sorts of settings,
such as your display background and how icons appear.

e Software Update: This uses the Internet to see whether update
patches are available for your Apple software, as I discuss in
Chapter 21.

e Mac OS X Software: This launches the Safari browser and displays
software that you can download for your laptop.

v From the Desktop: If you have a document that you created or an appli-
cation icon on your Desktop, you can launch or open it here by double-
clicking that icon (clicking the trackpad button twice in rapid succession
when the mouse pointer is on top of the icon). Remember that you can
also configure your MacBook’s trackpad to accept a single tap with one
fingertip as a click.
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Double-clicking a device or network connection on your Desktop opens
the contents in a Finder window. This works for CDs and DVDs that
you've loaded as well as external hard drives and USB Flash drives. Just
double-click '’em to open them and display their contents in a Finder
window. Applications and documents launch from a CD, a DVD, or an
external drive just like they launch from your internal drive (the one
that’s typically named Macintosh HD), so you don’t have to copy stuff
from the external drive just to use it. (You can’t change the contents of
most CDs and DVDs; they’re read only, so you can’t write to them.)
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+* From the Recent Items selection: When you click the Apple menu and
hover your mouse pointer over the Recent Iltems menu item, the Finder
displays all the applications and documents that you used over the past
few computing sessions. Click an item in this list to launch or open it.

v From the Login Items list: Login Items are applications that Leopard
launches automatically each time you log in to your user account.

I cover Login Items in detail in Chapter 16.

v From the Finder window: You can also double-click an icon within the
confines of a Finder window to open it (for documents), launch it (for
applications), or display the contents (for a folder).

<P The Quick Look feature that debuted with Leopard can display the contents
of just about any document or file — but without actually opening the corre-
sponding application! Sweet. To use Quick Look from a Finder window, click a
file to select it and then click the Quick Look button (which bears an eye icon)
on the Finder window toolbar.

After you finish using an application, you can quit that application to close
its window and return to the Desktop. Here are a number of different ways to
quit an application:

v Press 8+Q. This keyboard shortcut quits virtually every Macintosh
application on the planet. Just make sure that the application that you
want to quit is currently active first!

v Choose the Quit command from the application’s menu. To display
the Quit command, click the application’s name — its menu — from the
menu bar. This menu is always to the immediate right of the Apple (%)
menu. For example, Safari displays a Safari menu, and that same spot
in the menu is taken up by iCal when iCal is the active application. In
Figure 4-3, look for the iTunes menu, right next to <.

1 Choose Quit from the Dock. You can Control-click (or right-click) an
application’s icon on the Dock and then choose Quit from the right-click
menu that appears. Alternatively, just click the icon and hold down the

M button to display the same menu.

A running application displays a small blue dot under its icon on the Dock.
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v Click the Close button on the application window; refer to Figure 4-3.
Some applications quit entirely when you close their window, like the
System Preferences window or the Apple DVD Player. Other applications
might continue running without any window, like Safari or iTunes; to
close these applications, you have to use another method in this list.

Vg\“\NG! v Choose Force Quit from the Apple menu. This is a last-resort mea-
S sure! Use this only if an application has frozen and you can’t use
another method in this list to quit. Force-quitting an application doesn’t
save any changes to any open documents within that application!

Jugagling Folders and Icons

Finder windows aren’t just for launching applications and opening the files
and documents that you create. You can also use the icons within a Finder
window to select one or more specific items or to copy and move items from
place to place within your system.

A field observer’s guide to icons

Not all icons are created equal. Earlier in this chapter, [ introduce you to your
MacBook’s hard drive icon on the Desktop, but here is a little background on the
other types of icons that you might encounter during your mobile Mac travels:

v Hardware: These are your storage devices (such as your hard drive and
DVD drive) as well as external peripherals (such as your iPod and printer).

1 Applications: These icons represent the applications (or programs) that
you can launch. Most applications have a custom icon that incorporates
the company’s logo or the specific application logo, so they’re very easy
to recognize, as you can see in Figure 4-4. Double-clicking an application
usually doesn’t load a document automatically; you typically get a new
blank document, or an Open dialog box from which you can choose the
existing file you want to open.

v Documents: Many of the files on your hard drive are documents that can
be opened within the corresponding application, and the icon usually
looks similar to the application’s icon. Double-clicking a document auto-
matically launches the required application (that is, as long as Mac OS X
recognizes the file type).

v~ Files: Most of the file icons on your system are mundane things (such as
preference and settings files, text files, log files, and miscellaneous data
files), yet most are identified with at least some type of recognizable
icon that lets you guess what purpose the file serves. You'll also come
across generic file icons that look like a blank sheet of paper (used when
Leopard has no earthly idea what the file type is).
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v~ Aliases: An alias acts as a link to another item elsewhere on your system.
For example, to launch Adobe Acrobat, you can click an Adobe Acrobat
alias icon that you can create on your Desktop rather than clicking the
actual Acrobat application icon. The alias essentially acts the same way as
the original icon, but it doesn’t take up the same space — only a few bytes
for the icon itself, compared with the size of the actual application. Plus,
you don’t have to go digging through folders galore to find the original
application icon. (Windows Switchers know an alias as a shortcut, and the
idea is the same although Macs had it first. Harrumph.) You can always
identify an alias by the small curved arrow at the base of the icon, and the
icon might also sport the tag alias at the end of its name.

You have two ways to create an alias. Here’s one:
a. Select the item.
The following section has details about selecting icons.
b. Choose Filer>Make Alias, or press 38+L.

Figure 4-5 illustrates a number of aliases, arranged next to their
linked files.

Here’s another way to create an alias:
a. Hold down $+Option.
b. Drag the original icon to the location where you want the alias.

Note that this funky method doesn’t add the alias tag to the end
of the alias icon name!
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So why bother to use an alias? Two good reasons:

v Launch an application or open a document from anywhere on your
drive. For example, you can start Pages directly from the folder where
you store the documents for your current Pages project. Speed, organi-
zation, and convenience . . . life is good.

» Send an alias to the Trash without affecting the original item. When
that school project is finished, you can safely delete the entire folder
without worrying about whether Keynote will run the next time you
double-click the application icon!

If you move or rename the original file, Leopard is actually smart enough to
update the alias, too! However, if the original file is deleted (or if the original
is moved to a different volume, such as an external hard drive), the alias no
longer works. (Go figure.)

Selecting items

Often, the menu commands or keyboard commands that you perform in the
Finder need to be performed on something: Perhaps you're moving an item
to the Trash, or getting more information on the item, or creating an alias for
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that item. In order to identify the target of your action to the Finder, you need
to select one or more items on your Desktop or in a Finder window. In this
section, I show you just how to do that.

Selecting one thing

Leopard gives you a couple of options when selecting just one item for an
upcoming action:

v Move your mouse pointer over the item and click. A dark border (or
highlight) appears around the icon, indicating that it’s selected.

v~ If an icon is already highlighted on your Desktop or within a window,
move the selection highlight to another icon in the same location by
using the arrow keys. To shift the selection highlight alphabetically, press
Tab (to move in order) or press Shift+Tab (to move in reverse order).

Selecting items in the Finder doesn’t actually do anything to them by itself.
You have to perform an action on the selected items to make something
happen.

Selecting a whole bunch of things
You can also select multiple items with aplomb by using one of these methods:

v Adjacent items

* Drag a box around them. If that sounds like ancient Sumerian,
here’s the explanation: Click a spot above and to the left of the first
item; then hold down the trackpad button and drag down and to
the right. (This is dragging in Mac-speak.) A box outline like the one
in Figure 4-6 appears, indicating what you're selecting. Any icons
that touch or appear within the box outline are selected when you
release the button.

e Click the first item to select it and then hold down the Shift key while
you click the last item. Leopard selects both items and everything
between them.

1 Nonadjacent items: Select these by holding down the 3 key while you
click each item.

Check out the status line at the bottom of a Finder window. It tells you how
much space is available on the drive you're working in as well as how many
items are displayed in the current Finder window. When you select items, it
shows you how many you highlighted.
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Copying items

Want to copy items from one Finder window to another, or from one location
(like a CD-ROM) to another (like your Desktop)? Trés easy. Just use one of
these methods:

v On the same drive

To copy one item to another location: Hold down the Option key
(you don’t have to select the icon first) and then click and drag the
item from its current home to the new location.

To put a copy of an item within a folder, just drop the item on top
of the receiving folder. If you hold the item that you're dragging
over the destination folder for a second or two, Leopard opens up
a new window so you can see the contents of the target. (This is
called a spring-loaded folder. Really.)

To copy multiple items to another location: Select them all first (see
the earlier section, “Selecting a whole bunch of things™), hold down
the Option key and then drag and drop one of the selected items
where you want it. All the items that you selected follow the item
you drag. (Rather like lemmings. Nice touch, don’t you think?)

To help indicate your target when you’re copying files, Leopard high-
lights the location to show you where the items will end up. (This works
whether the target location is a folder or a drive icon.) If the target loca-
tion is a window, Leopard adds a highlight to the window border.
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v On a different drive

e To copy one or multiple items: Click and drag the icon (or the
selected items if you have more than one) from the original
window to a window you open on the target drive. (No need to
hold down the Option key whilst copying to a different drive.) You
can also drag one item (or a selected group of items) and simply
drop the items on top of the drive icon on your Desktop.

The items are copied to the top level, or root, of the target drive.

If you try to move or copy something to a location that already has an item
with the same name, you get a dialog that prompts you to decide whether to
replace the file or to stop the copy/move procedure and leave the existing
file alone. Good insurance, indeed.

Moving things from place to place

Moving things from one location to another location on the same drive is the
easiest action you can take. Just drag the item (or selected items) to the new
location. The item disappears from the original spot and reappears in the
new spot.

Duplicating in a jiffy

If you need more than one copy of the same item within a folder, use the
Leopard Duplicate command. I use Duplicate often when I want to edit a doc-
ument but ensure that the original document stays pristine, no matter what. I
just create a duplicate and edit that file instead.

To use Duplicate, you can

v Click an item to select it and then choose File>Duplicate.
+ Right-click the item and choose Duplicate from the menu.

v Hold down the Option key and drag the original item to another spot
in the same window. When you release the trackpad button, the dupli-
cate file appears like magic!

The duplicate item has the word copy appended to its name. A second copy
is named copy?2, a third is copy3, and so on.

Duplicating a folder also duplicates all the contents of that folder, so creat-
ing a duplicate folder can take some time to create if the original folder was
stuffed full. The duplicate folder has copy appended to its name, but the con-
tents of the duplicate folder keep their original names.
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Keys and Keyboard Shortcuts
to Fame and Fortune

Your MacBook’s keyboard might not be as glamorous as your trackpad, but
any Macintosh power user will tell you that using keyboard shortcuts is usu-
ally the fastest method of performing certain tasks in the Finder, such as
saving or closing a file. | recommend committing these shortcuts to memory
and putting them to work as soon as you begin using your laptop so that they
become second nature to you as quickly as possible.

Special keys on the keyboard

The Apple standard keyboard has a number of special keys that you might not
recognize — especially if you've made the smart move and decided to migrate
from the chaos that is Windows to Mac OS X! Table 4-1 lists the keys that bear
strange hieroglyphics on the Apple keyboard as well as what they do.

Table 4-1 Too-Cool Key Symbols

Action Symbol Purpose

Media Eject a Ejects a CD or DVD from your optical drive

Audio Mute | Mutes (and restores) all sound produced by your
MacBook

Keyboard ol Increases, decreases, or turns off the brightness

lllumination of your keyboard backlighting (MacBook Air and
MacBook Pro only)

Volume Up <) Increases the sound volume

Volume L) Decreases the sound volume

Down

Control A Displays right-click/Control-click menu

Command 38 Primary modifier for menus and keyboard shortcuts

Del x> Deletes selected text

Option \C Modifier for shortcuts
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Using Finder and application keyboard

shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care

of common tasks. Some of the handiest shortcuts are in Table 4-2.

But wait, there’s more! Most of your applications also provide their own set
of keyboard shortcuts. While you’re working with a new application, display
the application’s Help file and print out a copy of the keyboard shortcuts as a

handy cheat sheet.

Table 4-2 Leopard Keyboard Shortcuts of Distinction

Key Combination Location Action

B+A Edit menu Selects all (works in the Finder, too)

38+C Edit menu Copies the highlighted item to the
Clipboard

8+H Application Hides the application

menu

8+M Window menu Minimizes the active window to the
Dock (also works in the Finder)

88+0 File menu Opens an existing document, file, or
folder (also works in the Finder)

8+P File menu Prints the current document

#8+0 Application Exits the application

menu

8+V Edit menu Pastes the contents of the Clipboard at
the current cursor position

#B+X Edit menu Cuts the highlighted item to the
Clipboard

8+Z Edit menu Reverses the effect of the last action
you took

88+7 Help menu Displays the Help system (works in the
Finder, too)

88+Tab Finder Switches between open applications

& +0ption+M Finder Minimizes all Finder windows to the
Dock

88+0ption+W Finder Closes all Finder windows

/1
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If you've used a PC before, you're certainly familiar with three-key shortcuts —
the most infamous being Ctrl+Alt+Delete, the beloved shut-down shortcut, nick-
named the Windows Three-Finger Salute. Three-key shortcuts work the same
way in Leopard (but you'll be thrilled to know you won’t need to reboot by using
that notorious Windows shortcut)! If you're new to computing, just hold down
the first two keys simultaneously and then press the third key.

You're not limited to just the keyboard shortcuts listed above, either. Within
System Preferences, visit the Keyboard & Mouse pane and then click the
Keyboard Shortcuts button to change an existing shortcut or add another!

Performing Tricks with Finder Windows

\\J

In this section of your introduction to Mac OS X, I describe basic windows
management within Leopard: how to move things around, how to close win-
dows, and how to make ’em disappear and reappear like magic.

Scrolling in and resizing windows

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so
would the contents of the folders on your hard drives!

That’s why Leopard adds scroll bars that you can click and drag to move
through the contents of the window. You can

v Click the scroll bar and drag it.

v Click anywhere in the empty area above or below the bar to scroll pages
one at a time.

v Hold down the Option key and click anywhere in the empty area above
or below the bar to scroll to that spot in the window.

Of course, you can also drag two fingertips across the trackpad to scroll the
contents of a window (both vertically and horizontally). To control trackpad
behavior, open System Preferences, click the Keyboard & Mouse pane, and
then click the Trackpad button. You can read all about this in the earlier sec-
tion, “Wait a Second: Where the Heck Is the Right Mouse Button?”

Figure 4-7 illustrates both vertical and horizontal scroll bars in a typical
Finder window.

Often, pressing your Page Up and Page Down keys moves you through a docu-
ment one page at a time. Also, pressing your arrow keys moves your insertion
cursor one line or one character in the four compass directions.
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You can also resize most Finder and application windows by enlarging or
reducing the window frame itself. Move your mouse pointer over the Resize
handle in the lower-right corner of the window (which smartly bears a
number of slashed lines to help it stand out) and then drag the handle in any
direction until the window is the precise size you need.

Minimizing and restoring window's

Resizing a window is indeed helpful, but maybe you simply want to banish

the doggone thing until you need it again. That’s a situation for the Minimize
button, which also appears in Figure 4-7. A minimized window disappears from
the Desktop but isn’t closed: It simply reappears in the Dock as a miniature

icon. Minimizing a window is easy: Move your mouse pointer over the Minimize
button at the top-left corner of the window — a minus sign appears in the button

/3
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to tell you that you're on target — and then click. Here’s a good shortcut: double-
clicking the window’s title bar (that’s the top frame of the window, which usually
includes a document or application name) minimizes the window.

Hold down the Shift key whilst you minimize, and prepare to be amazed when
the window shrinks in slow motion like Alice in Wonderland!

To restore the window to its full size again (and its original position on the
Desktop), just click its window icon on the Dock.

Moving and zooming windows

Perhaps you want to move a window to another location on the Desktop so
you can see the contents of multiple windows at the same time. Click the
window’s title bar and drag the window anywhere you like. Then release the
button. (Don’t click the icon in the center of the title bar, though. You won’t
move the window, just the icon itself.)

Many applications can automatically arrange multiple windows for you.
Choose Windowr>Arrange All menu item (if it appears).

To see all that a window can show you, use the Zoom feature to expand any
Finder or application window to its maximum practical size. (This is different
from zooming with the Multi-Touch feature because you're expanding only the
window — and not an image or a document.) Note that a zoomed window can fill
the entire screen, or (if that extra space isn’t applicable for the application) the
window might expand only to a larger part of the Desktop. To zoom a window,
move your mouse pointer over the button (as shown in Figure 4-7) at the top-left
corner of the window. When the plus sign appears in the Zoom button, click to
claim the additional territory on your Desktop. (You can click the Zoom button
again to automatically return the same window to its original dimensions.)

Only one can be active at once™

Yes, here’s a very special Mark’s Maxim in the
Mac OS X universe.

Only one application window can be active
in Leopard at any time.™

You can always tell which window is active:

v~ The active window is on top of other
windows.

Tip: You can still use a window's Close,
Minimize, and Zoom buttons when it's
inactive.

v~ Any input you make by typing or by moving
your finger on the trackpad appears in the
active window.

v Mac 0S X dims inactive windows that you
haven’t minimized.
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Toggling toolbars the Leopard way

Time to define a window control that's actually
inside the window for a change. A toolbaris a
strip of icons that appears under the window's
title bar. These icons typically perform the most
common actions within an application; the
effectis the same as if you use a menu or press
a keyboard shortcut. Toolbars are very popu-
lar these days. You see ‘em within everything
from the Finder window to most application
windows.

You can banish a window’s toolbar to make
extra room for icons, documents, or whatever
it happens to be holding. Just click the little
lozenge-shaped button at the right corner of the
window. (You guessed it — the Toolbar button
is also shown in Figure 4-7.) Note: If you toggle
the Finder toolbar off, you also lose the Finder
window Sidebar.

Closing windows

When you're finished with an application or no longer need a window open,
move your mouse pointer over the Close button at the top-left corner of the

window. When the X appears in the button, click it. (And yes, I can get one

more reference out of Figure 4-7, which I'm thinking of nominating as Figure

If you have more than one window open in the same application and you want

to close ’em all in one swoop, hold down the Option key whilst you click the

If you haven’t saved a document and you try to close that application’s

of the Year.)
3
Close button on any of the windows.
WBER
@?—
&

window, Leopard gets downright surly and prompts you for confirmation.
“Hey, human, you don’t really want to do this, do you?” If you answer in the

affirmative — “Why, yes, machine. Yes, indeed, I do want to throw this away

and not save it.” — the application discards the document that you were

working on. If you decide to keep your document (thereby saving your poste-

rior from harm), you can either save the document under the same filename

or under a new name.
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Chapter 5
Getting to the Heart of the Leopard

In This Chapter

Making the most of your Home folder

Arranging your Desktop for greater efficiency

Adding timesavers to the Dock

Using the Trash (and rescuing precious stuff from it)

Using Exposé, Spaces, and Dashboard to perform Desktop magic
Printing documents

w hen you’re no longer a novice to Leopard and the basics of the
Finder, turn your attention to a number of more advanced topics 'n
tricks to turn you into a MacBook power user — which, after all, is the goal of
every civilized consciousness on Planet Earth.

Consider this chapter a grab bag of Leopard knowledge. Sure, [ jump around
a little, but these topics are indeed connected by a common thread: They're
all surefire problem-solvers and speeder-uppers. (I can’t believe the latter is
really a word, but evidently it is. My editors told me so.)

Home, Sweet Home Folder

Each user account that you create within Leopard is actually a self-contained
universe. For example, each user has a number of unique characteristics and
folders devoted just to that person, and Leopard keeps track of everything
that user changes or creates. (In Chapter 16, I describe the innate loveliness
of multiple users living in peace and harmony on your laptop.)

This unique universe includes a different system of folders for each user
account on your system. The top-level folder uses the short name that
Leopard assigns when that user account is created; don’t necessarily look for
a folder named “Home.” Naturally, the actual folder name is different for each
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person, and Mac techno-types typically refer to this folder as your Home
folder. (On the sidebar, look for the teeny house icon under the Places head-
ing, marked with your account name.)

Each account’s Home folder contains a set of subfolders, including

v Movies

v Music

v Pictures

v Downloads (for files you download by using Safari)
v~ Sites (for Web pages created by the user)

v Documents (created by the user)

Although you can store your stuff at the root (top level) of your hard drive,
that gaggle of files, folders, and aliases can get very crowded and confusing
very quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff. Use it
to make your computing life much easier!™

Create subfolders within your Documents folder to organize your files

and folders even further. For example, I always create a subfolder in my
Documents folder for every book that [ write so that I can quickly and easily
locate all the documents and files associated with that book project.

[ discuss security within your Home folder and what gets stored where in
Chapter 16. For now, Figure 5-1 shows how convenient your Home folder is
to reach because it appears in the Finder window Sidebar. One click of your
Home folder, and all your stuff is in easy reach.

In addition to the Finder window Sidebar, you can also reach your Home
folder in other convenient ways:

v From the Go menu: Choose Go>Home to display your Home folder
immediately from the Finder window. Alternatively, you can press
88 +Shift+H to accomplish the same thing.

v From within Open and Save dialogs: Leopard’s standard File Open and
File Save dialogs also include the same Home folder (and subfolder)
icons as the Finder window Sidebar.

v Within any new Finder window you open: If you like, you can set every
Finder window that you open to automatically display your Home folder.

a. Choose Finderc>Preferences to display the dialog that you see in
Figure 5-2.
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b. Click the arrow button at the right side of the New Finder Windows
Open pop-up menu.

A menu pops up (hence, the name).
c. Click the Home entry in the menu.
d. Click the Close button at the top-left corner of the dialog.
You're set to go. From now on, every Finder window you open dis-

plays your Home folder as the starting location!

Here’s another reason to use your Home folder to store your stuff: Leopard
expects your stuff to be there when you migrate your files from an older Mac
to a new Mac.

Personalizing Your Desktop

Most folks put all their documents, pictures, and videos on their Leopard
Desktop because the file icons are easy to locate! Your computing stuff is
right in front of you . . . or is it?

Call me a finicky, stubborn fussbudget — go ahead, I don’t mind — but I
prefer a clean Leopard Desktop without all the iconic clutter. In fact, my
Desktop usually has just three or four icons even though I use my MacBook
Pro several hours every day. It’s an organizational thing; I work with liter-
ally hundreds of applications, documents, and assorted knickknacks daily.
Sooner or later, you'll find that you're using that many, too. When you keep
your stuff crammed on your Desktop, you end up having to scan your screen
for one particular file, an alias, or a particular type of icon, which ends up
taking you more time to locate it on your Desktop than in your Documents
folder!

Plus, you'll likely find yourself looking at old icons that no longer mean
anything to you or stuff that’s covered in cobwebs that you haven’t used in
years. Stale icons . . . yuck.

I recommend that you arrange your Desktop so you see only a couple of
icons for the files or documents that you use the most. Leave the rest of the
Desktop for that cool image of your favorite actor or actress.

Besides keeping things clean, | can recommend a number of other favorite
tweaks that you can make to your Desktop:
v Keep Desktop icons arranged as you like.
a. From the Finder menu, choose View->Show View Options.

b. Select the Arrange By check box.
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c. From the pop-up menu, choose the criteria that Leopard uses to auto-
matically arrange your Desktop icons, including the ifem name, the
last modification date, or the size of the items.

[ personally like things organized by name.
1 Choose a favorite background.

a. Hold down the Control key while you click any open spot on your
Desktop. (Or, if you use a pointing thing with a right mouse button,
click that instead.)

b. From the right-click menu that appears, choose Change Desktop
Background.

You see the Desktop & Screen Saver pane appear, as shown in Figure
5-3. Browse through the various folders of background images that
Apple provides or use an image from your iPhoto library.

v+~ Display all the peripherals and network connections on your system.
a. Choose Finderc>Preferences.

b. Make sure that all four of the top checkboxes (Hard Disks; External
Disks; CDs, DVDs, and iPods; and Connected Servers) are enabled.

If you're connected to an external network or you've loaded an
external hard drive or device, that shows up on your Desktop. You
can double-click that Desktop icon to view your external stuff.

@  System Preferences Edit View Window Help [7] W f = 4 Tuel2:24AM Q
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Customizing the Dock Just So
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If the Dock seems like a nifty contraption to you, you're right again — it’s like
one of those big control rooms that NASA uses. From the Dock — that icon
toolbar at the bottom of Leopard’s Desktop — you can launch an application,
monitor what’s running, and even use the pop-up menu commands to control
the applications that you launch. (Hey, that NASA analogy is even better than
[ thought!)

By default, the Dock hangs out at the bottom of your screen, but you can
move it to another edge, change the size of the icons, or even hide it until it’s
necessary. (You can find more details on customizing your Dock in Chapter 6.)

When you launch an application — either by clicking an icon on the Dock
or by double-clicking an icon in a Finder window or the Desktop — the icon
begins to bounce hilariously on the Dock to indicate that the application

is loading. (So much for my Mission Control analogy.) After an application
is running, the application icon appears on the Dock with a shiny blue dot
underneath. Thusly, you can easily see what’s running at any time just by
glancing at the Dock.

You can hide most applications by pressing 8+H.

Adding Dock icons

Ah, but there’s more: The Dock can offer more than just a set of default icons!
You can add your own MIS (or Most Important Stuff) to the Dock, making it
the most convenient method of taking care of business without cluttering up
your Desktop. You can add

v~ Applications: Add any application to your Dock by dragging the applica-
tion icon into the area to the left of the separator line (the vertical dotted
line on the Dock which appears between applications and folders or
documents). The existing Dock icons move aside so that you can place
the new neighbor in a choice location.

Do not try to add an application anywhere to the right of the separator
line. You can’t put applications there — and Leopard might even think
that you want the application dumped in the Trash!

v Folders: Here’s where you want to add things to the area to the right
of the separator line. A folder or volume icon that you drag to the Dock
is called a Stack in Leopard, and you can display the contents with a
single click. (The contents of the folder “fan out” into a half-circle or grid
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arrangement, depending on the number of items in the folder.) To open
or launch an item, just click it in the Stack display. Folders that include
many items are displayed in a grid view.

Leopard already includes two Stacks in the Dock by default: your
Documents folder and your Downloads folder.

v Web URLs: Sure, you can add your favorite Web site from Safari! Drag it
right from the Safari Address bar into the area to the right of the separa-
tor line. When you click the URL icon, Safari opens the page automatically.

Removing Dock icons

You can remove an icon from the Dock at any time (as long as the applica-
tion isn’t running). In fact, I always recommend that every Leopard user
remove the default icons that never get used to make more room available
for your favorite icons. The only two icons you can’t remove are the Finder
and the Trash icons. To remove an icon from the Dock, just click and drag
it off the Dock. You're rewarded with a ridiculous puff of smoke straight out
of a Warner Brothers cartoon! (One of the Mac OS X developers was in a fun
mood, [ guess.)

When you delete an icon from the Dock, all you delete is the Dock icon: The
original application, folder, or volume is not deleted.

Using Dock icon menus

From the Dock menu, you can open documents, open the location in a Finder
window, set an application as a Login Item, control the features in some
applications, and other assorted fun, depending on the item.

To display the right-click Dock menu for an icon

1. Move your mouse over the icon.
2. Right-click.

Note that you can also press the Control key and click the icon, or even
hold down the left mouse button for a second or two.

I cover the Dock settings that you can change within System Preferences in
Chapter 6. You can also change the same settings from the Apple menu if you
hover your mouse over the Dock menu item, which displays a submenu with
the settings.
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What's with the Trash?

Another sign of a Mac laptop power user is a well-maintained Trash can. It’s
a breeze to empty the discarded items you no longer need, and you can even
rescue something that you suddenly discover you still need!

Previewing images and documents
the Leopard way

Leopard’s new Quick Look feature (available on
the Finder window toolbar) has garnered a lot
of attention within the technology press, and
rightly so. Just select a file and click the Quick
Look button (or just press the spacebar), and
Leopard instantly displays the contents of the
document or image, without opening the appli-
cation. Heck, I've been waiting for such a magic
lamp for two decades now!

However, don't forget that Mac 0S X has always
offered a Swiss Army knife application for view-
ing image files and documents: namely, Preview.
You can use Preview to display digital photos in
several popular image formats, including TIFF,
GIF, PICT, PNG, JPEG, and Windows Bitmap.

| know, if that were the sum total of Preview's
features, it wouldnt deserve coverage here. So,
what else canitdo? Here's a partial list (just my
favorites, mind you):

v Use Preview to add a bookmark at the
current page within a PDF document by
choosing Bookmarks->Add Bookmark.

v~ Fill outaformin a PDF document by choos-
ing Tools=>Text Tool.

Click an area that's marked as an input
field, and you can type text into that field.
After you complete the form, you can fax or
print it.

v~ Take a screen snapshot (saving the con-
tents of your screen as a digital photo) by
choosing File>Grab=>Timed Screen.

Preview launches the Grab utility, which
displays an onscreen timer and then snaps
the image for you after ten seconds. (This
gives you time to get things just right before
saying, “Cheese!”)

v~ Convert an image into another format or
into a PDF file by choosing File=>Save As.

If a PDF document can be edited, you can
delete or insert pages at will.

v~ Resize or rotate an image by using the
commands on the Tools menu.

Leopard automatically loads Preview when you
double-click an image in a format that it rec-
ognizes or when you double-click a PDF file. It
also acts as the Print Preview window, as you
can read elsewhere in this chapter. However,
if you want to launch Preview manually, open a
Finder window, click the Applications folder in
the Sidebar, and then double-click the Preview
icon.
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The Leopard Trash icon resides on the Dock, and it works just like the Trash
has always worked in Mac OS X: Simply drag selected items to the Trash to
delete them.

Note one very important exception: If you drag a Desktop icon for an external
device or removable media drive to the Trash (such as an iPod, iPhone, DVD,
or an external hard drive), the Trash icon automagically turns into a giant
Eject icon, and the removable device or media is ejected or shut down — not
erased. Repeat, not erased. (That’s why the Trash icon changes to the Eject
icon — to remind you that you're not doing anything destructive.)

Here are other methods of chunking items you select to go to the wastebasket:

v Choose FilecoMove to Trash.

v Click the Action button on the Finder toolbar and choose Move to Trash
from the list that appears.

v Press 38+Delete.

v Right-click the item and choose Move to Trash from the menu that
appears.

You can always tell when the Trash contains at least one item because the
basket icon is full of crumpled paper! However, you don’t have to unfold a
wad of paper to see what the Trash holds: Just click the Trash icon on the
Dock to display the contents of the Trash. To rescue something from the
Trash, drag the item(s) from the Trash folder to the Desktop or any other
folder in a Finder window. (If you're doing this for someone else who’s not
familiar with Leopard, remember to act like it was a lot of work, and you’ll
earn big-time DRP, or Data Rescue Points.)

When you’re sure that you want to permanently delete the contents of the
Trash, use one of these methods to empty the Trash:

v Choose Finder~>Empty Trash.
v Choose Finder=>Secure Empty Trash.

If security is an issue around your laptop and you want to make sure
that no one can recover the files you've sent to the Trash, using the
Secure Empty Trash command takes a little time but helps to ensure
that no third-party hard drive repair or recovery program could resusci-
tate the items you discard.

v Press 38+Shift+Delete.

v Right-click the Trash icon on the Dock and then choose Empty Trash
from the menu that appears.



86

Part ll: Shaking Hands with Mac 0S X

Working Magic with Dashboard,
Exposé, and Spaces

3

3

MacBook power users tend to wax enthusiastic over the convenience fea-
tures built into Leopard. In fact, we show ’em off to our PC-saddled friends
and family. Three of the features that I've demonstrated the most to others
are Leopard’s Dashboard display, the amazing convenience of Exposé, and
the brand-new Spaces Desktop manager. In this section, [ show ’em off to you
as well. (Then you can become the Leopard evangelist on your block.)

Using Dashboard

The idea behind Dashboard is deceptively simple yet about as revolutionary
as it gets for a mainstream personal computer operating system. Dashboard
is an alternate Desktop that you can display at any time by using the key-
board or your mouse; the Dashboard desktop holds widgets (small applica-
tions that each provide a single function). Examples of default widgets that
come with Leopard include a calculator, a world clock, weather display, and
a dictionary/thesaurus.

Oh, did [ mention that you’re not limited to the widgets that come with
Leopard? Simply click the plus button at the bottom of the Dashboard dis-
play and drag new widgets to your Dashboard from the menu at the bottom
of the screen. To remove a widget while you're in this mode, click the X icon
that appears next to each widget. When you’re done with your widgets —
that sounds a bit strange, but I mean no offense — press the Dashboard key
again to return to your Desktop.

Widgets can also be rearranged any way you like by dragging them to a new
location.

Simple applications like these are no big whoop — after all, Mac OS X

has always had a calculator and a clock. What’s revolutionary is how you
access your widgets. You can display and use them anywhere in Leopard,
at any time, by simply pressing the Dashboard key. The default key is F12
although you can change the Dashboard key via the Exposé & Spaces pane
within System Preferences (or even turn it into a key sequence, such as
Option+F12). You can also click the Dashboard icon on the Dock to summon
your Dashboard widgets and then banish the Dashboard when you’re done.

Click the scroll ball on your Mighty Mouse to display your Dashboard.
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A WebClip widget is a portion of a Web page that can include text, graphics,
and links, which Dashboard updates every time you display your widgets.
Think about that for a second: Dynamic displays, such as weather maps, car-
toons, and even the Free Music Download image from the iTunes Store are all
good sources of WebClip widgets! (That last one is a real timesaver.)

Leopard even allows you to create your own Dashboard widgets! That’s right,
this new feature is sure to be a winner amongst the In Crowd. Follow these
steps to create a new WebClip Dashboard widget from your favorite Web site:

1. Run Safari and navigate to the site you want to view as a widget.

2. Click the Open This Page in Dashboard button on the Safari toolbar,
which bears a pair of scissors and a dotted box.

3. Select the portion of the page you want to include in your widget.

Most Web pages use frames to organize and separate sections of a page,
so this step allows you to choose the frame with the desired content.

4. Drag the handles at the edges of the selection border to resize your
widget frame to the right size and then click Add.

Bam! Leopard displays your new WebClip widget within Dashboard.

When you click a link in a WebClip widget, Dashboard loads the full Web page
in Safari, so you can even use WebClips for surfing chores with sites you visit
often.

Switching between apps with Exposé

Most MacBook owners are comfortable using the 88+Tab keyboard shortcut
to switch between open applications. If you’ve moved to the Mac from a PC
running Windows, you might think this simple shortcut is all there is to it. Ah,
dear reader, you're in Leopard territory now!

Exposé is a rather racy-sounding feature, but (like Dashboard) it’s really all
about convenience. If you typically run a large number of applications at the
same time, Exposé can be a real timesaver, allowing you to quickly switch
between a forest of different application windows (or display your Desktop
instantly without those very same windows in the way). The feature works in
three ways:

1 Press the All Windows key (or key sequence) to display all your applica-
tion windows on a single screen, as shown in the truly cool Figure 5-4.
(By default, F9 is the All Windows key.)

Then just click the window that you want to make active.
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Figure 5-4:
With
Exposé,
you can
instantly see
every open
applica-
tion’s
window(s).
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v Press the Application Windows key (or key sequence) to display all
the windows that have been opened by the active application. (By
default, F10 is the Application Windows key.)

This comes in handy with those mega-applications like Photoshop
Elements or FileMaker Pro, in which you often have three or four win-
dows open at one time. Again, you can click the window that you want
to make active.

+” Press the Desktop key (or key sequence) to move all your application

and Finder windows to the sides of your Desktop so you can access
your Desktop icons. (The default Desktop key is F11.)

After you're done with your Desktop and you want to restore your win-
dows to their original locations, press the Desktop key (F11) again to put
things back.

Switching between desktops with Spaces

Ah, but what if you want to switch to an entirely different set of applica-
tions? For example, suppose that you're slaving away at your pixel-pushing
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job, designing a magazine cover with Pages. Your page design desktop also
includes Photoshop and Aperture, which you switch between often by using
one of the techniques I just described. Suddenly, however, you realize you
need to schedule a meeting with others in your office by using iCal, and you
also want to check your e-mail in Apple Mail. What to do?

Well, you could certainly launch those two applications on top of your graph-
ics applications, and then minimize or close them. With Leopard’s new Spaces
feature, though, you can press the Control+« or Control+— sequences to
switch to a completely different “communications applications” desktop, with
iCal and Apple Mail windows already open and in your favorite positions!
Figure 5-5 illustrates the Spaces screen, showing two available desktops.

After you're done setting up your meeting and answering any important
e-mail, simply press Control+« or Control+— again to switch back to your
“graphics” desktop, where all your work is exactly as you left it!

Now imagine that you’ve also created a custom “music” desktop for
GarageBand and iTunes . . . or perhaps you joined iWeb, Safari, and iPhoto as
a “Webmaster” desktop. See why everyone’s so excited? (Let’s see Windows
Vista do that out of the box.)

Figure 5-5:
With
Spaces,

you can
instantly
switch
between
multiple
desktops!
|
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Unlike Exposé, Spaces has to be enabled and configured before you can use
it. You can create new desktops, customize your desktops, and even choose
a different set of key sequences to activate Spaces from within System
Preferences. For the complete story on configuring Spaces, see Chapter 6.

You can activate Exposé, Spaces, and Dashboard by using your mouse rather
than the keyboard:

1. Click the System Preferences icon on the Dock.

2. Click the Exposé & Spaces icon to display the settings.

3. Click the desired Screen Corner pop-up menu to choose what function
that screen corner will trigger.

4. Press 8+Q to save your changes and then exit System Preferences.

When you move your mouse pointer to that corner, the feature you've
specified automatically kicks in.

Printing within Mac 0S X
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Leopard makes document printing a breeze. Because virtually all Mac print-
ers use a Universal Serial Bus (USB) port, setting up printing couldn’t be
easier. Just turn on your printer and connect the USB cable between the
printer and your MacBook; Leopard does the rest.

Printer manufacturers supply you with installation software that might add
cool extra software or fonts to your system. Even if Leopard recognizes your
USB printer immediately, | recommend that you still launch the manufactur-
er’'s Mac OS X installation disc. For example, my new Epson printer came with
new fonts and a CD/DVD label application, but I wouldn’t have ’em if I hadn’t
installed the Epson software package.

After your printer is connected and installed, you can use the same pro-
cedure to print from within just about every Mac OS X application on the
planet! To print with the default page layout settings — standard 8%" x 11"
paper, portrait mode, no scaling — follow these steps:

1. Within the active application, choose File=>Print or press the $+P
shortcut.

Mac OS X displays the Print sheet, as shown in Figure 5-6.
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citation ullamca laboris nisi ut aliquip ex ea commoda consequat. Duis aute irure dolor in rep-
rahanderit in voluptate velit ssse molestaie cilum. Tia non ob ea soluad incom dereud facilis
est er expedit distinct. Nam liber ta conscient to factor tum poen lagum adioque civiuda et tam.
Neque pecun modut est neque nonor et imper ned libidig met, consectetur adipiscing elil, sed
ut labore et dolore magna aliguam is nostrud exercitation ullam mmeodo consequet. Duis aute
in voluptate velit esse cillum dolore eu fugiat nulla pariatur.

At vver eos et accusam dignissum qui blandit est praesent, Tranz pruca beynocguon doas nog
‘apaply su trenz ucu hugh rascluguan monugor or trenz ucugwo jag scannar. Wa hava laasad
tranzsa gwo pmduuqs su ldfoBraid, yop quiel gag ba solaly raspansubla rof renzur sala ent

. Offact phat eit sakem eit vory gast te Plok peish
F et s s e il i o o b e st o
tranz draek wire procassidt program. Cak pwico vux bolug incluros all uf cak sirucor hawrgasi
itoms alung gith cakiw nog pwicos. ||

Plioaso mako nuto uf cakso dodlos anr koop a cupy uf cak vux noaw yerw phuna, Whag
schenges, uf efed, quiel ba mada su ofrenzr swipontgwook proudgs hus yag su ba dagarmi- M
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From this dialog, you can

* Print from a different printer connected to your laptop or print over a
network connection to a shared printer on another computer.

Click the Printer pop-up menu. In this pop-up menu, Leopard dis-
plays all the printers that you can access.

e Check what the printed document will look like.

Click Preview to open it within the very same Preview application I
discuss earlier in this chapter.

If you have to make changes to the document or you need to change
the default print settings, click Cancel to return to your document. (You
have to repeat Step 1 again to display the Print dialog again.)

If everything looks good at this point and you don’t need to change any set-
tings (like multiple copies or to print only a portion of the document), click
Print — you’re done! If not, click the Expand button next to the Printer pop-up
menu. (It bears a downward-pointing arrow.) Now you can proceed with these
steps:

1. (Optional) For more than one copy, click in the Copies field and type
the number of copies that you need.

Collation (separating copies) is also available, and it doesn’t cost a thing!

Chapter 5: Getting to the Heart of the Leopard
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2. (Optional) To print a range of selected pages, select the From radio

GMBER button and then enter the starting and ending pages.

‘j
&
To print the entire document, leave the default Pages option set to All.

3. (Optional) If the application offers its own print settings, such as col-
lating and grayscale printing, make any necessary changes to those
settings.

To display these application-specific settings, click the pop-up menu
in the Print dialog and choose the desired settings pane that you need
to adjust. (You can blissfully ignore these settings and skip this step
entirely if the defaults are fine.)

4. When you’re set to go, click Print.

\§
P You can also save an electronic version of a document in the popular Adobe
Acrobat PDF format from the Print dialog — without spending money on

Adobe Acrobat. (Slick.)
1. Click the PDF button to display the destination pop-up menu.

2. Click Save as PDF.

Leopard prompts you with a Save As dialog, where you can type a name
for the PDF document and specify a location on your hard drive where
the file should be saved.

Heck, if you like, you can even fax a PDF (with an external USB modem) or
send it as an e-mail attachment! Just choose these options from the destina-
tion list rather than Save as PDF.



Chapter 6

A Nerd's Guide to System
Preferences

In This Chapter

Navigating System Preferences

Searching for specific controls

Customizing Leopard from System Preferences

R emember the old TV series Voyage to the Bottom of the Sea? You always
knew you were on the bridge of the submarine Seaview because it had
an entire wall made up of randomly blinking lights, crewmen darting about
with clipboards, and all sorts of strange and exotic-looking controls on

every available surface. You could fix just about anything by looking into the
camera with grim determination and barking out an order. After all, you were
On The Bridge. That’s why virtually all the dialog and action inside the sub
took place on that one (expensive) set: It was the nerve center of the ship,
and a truly happenin’ place to be.

In the same vein, I devote this entire chapter to the System Preferences
window and all the settings within it. After all, if you want to change how
Leopard works or customize the features within our favorite operating
system, this one window is the nerve center of Mac OS X, and a truly hap-
penin’ place to be. (Sorry, no built-in wall of randomly blinking lights — but
there are exotic controls just about everywhere.)

An Explanation (In English, No Less)

The System Preferences window (as shown in Figure 6-1) is a self-contained
beast, and you can reach it in a number of ways:

1 Click the Apple menu (%) and choose the System Preferences menu item.

v Click the System Preferences icon on the Dock — it’s a collection of gears.



9/,  Partii: Shaking Hands with Mac 0S X

|
Figure 6-1:
The power-
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settings and
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System
Prefer-
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|

1+~ Click the Apple menu (), choose Dock, and then choose the Dock
Preferences menu item.

v Click the Time and Date display in the Finder menu and then choose the
Open Date and Time menu item.

v Control-click (or right-click) any uninhabited area of your Desktop and
then choose Change Desktop Background.

v Click most of the Finder menu status icons and then choose the Open
Preferences menu item. (This includes the Bluetooth, AirPort, Display,
Modem, and Clock icons.)

When the System Preferences window is open, you can click any of the group
icons to switch to that group’s pane, the entire window morphs to display the
settings for the selected pane. For example, Figure 6-2 illustrates the Sound
pane, which allows you to set a system alert sound, configure your MacBook’s
built-in microphone, and choose from several different output options.

Many panes also include a number of tabbed buttons at the top — in this case,
Sound Effects, Output, and Input. You can click these tabs to switch to another
panel within the same pane. Many panes within System Preferences have mul-
tiple panels. This design allows our friends at Apple to group a large number of
related settings together in the same pane (without things getting too confusing).
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To return to the top-level System Preferences panel from any pane, just click
the Show All button (top left) or press 8+L. You can also click the familiar
Previous and Next buttons to move backward through the panes you've
already visited and then move forward again, in sequence. (Yep, these
buttons work just like the browser controls in Safari. Sometimes life is

funny that way.)

You won'’t find an OK button that you have to click to apply any System
Preference changes — Apple’s developers do things the right way. Your
changes to the settings in a pane are automatically saved when you click
Show All or when you click the Close button on the System Preferences
window. You can also press 8+Q to exit the window and save all your
changes automatically . . . a favorite shortcut of mine.

If you see an Apply button in a pane, you can click it to immediately apply any
changes you made, without exiting the pane. This is perfect for some settings
that you might want to try first before you accept them, like many of the con-
trols on the Network pane. However, if you're sure about what you changed
and how those changes will affect your system, you don’t have to click Apply.
Just exit the System Preferences window or click Show All as you normally
would.

Locating That Certain Special Setting

Hey, wouldn't it be great if you could search through all the different panes
in System Preferences — with all those countless radio buttons, check boxes,
and slider controls — from one place, even when you're not quite sure
exactly what you’re looking for?
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Figure 6-3 illustrates exactly that kind of activity taking place. Just click in the
System Preferences Spotlight Search box (upper right, with the magnifying
glass icon) and type in just about anything. For example, if you know part of
the name of a particular setting you need to change, type that. Leopard high-
lights the System Preferences panes that might contain matching settings.
And if you're a Switcher from the Windows world, you can even type in what
you might have called the same setting in Windows XP or Vista!

®60 System Preferences
Show All (@ background )
Change background
Ferganal Check for new software
(o V| ﬁ Desktop picture
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Appearance  Desktop & Dock Exposé &  International  Security Spotlight
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Saver Mouse
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the Search | ™"
box. O

Déjavu

System

The System Preferences window dims, and the group icons that might con-
tain what you’re looking for stay highlighted. Slick.

You can also search for System Preferences controls by using the Spotlight
menu and Spotlight window. Find more on this cool feature in Chapter 7.

If you need to reset the Search box to try again, click the X icon that appears
at the right side of the box to clear it.

Popular Preference Panes Explained

Time to get down to brass tacks. Open up the most often-used panes in
System Preferences to see what magic you can perform! I won’t discuss every
pane because I cover many of them in other chapters. (In fact, you might
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never need to open some System Preferences panes at all, like the .Mac
pane.) However, this chapter covers just about all the settings that you're
likely to use on a regular basis.

The Displays pane

If you're a heavy-duty game player or you work with applications like
Keynote or Final Cut Pro, you probably find yourself switching the charac-
teristics of your monitor on a regular basis. To easily accomplish switching,
visit the Displays pane (see Figure 6-4), which includes two panels:

v~ Display: Click a screen resolution to choose it from the Resolutions
list on the left. Leopard displays the number of colors (or color depth)
allowed at that resolution, and you can pick a color depth from the
Colors pop-up menu. (Typically, it’s a good idea to use the highest reso-
lution and the highest number of colors.) If you have an external moni-
tor connected to your laptop, click the Detect Displays button to scan
for that monitor. Because MacBooks running Leopard have a flat-panel
LCD, the refresh rate is disabled. If you're working with a projector, you
can also use the Detect Displays button to configure external displays.
Drag the Brightness slider to change the brightness level of your display.

When you enable (mark) the Show Displays in Menu Bar check box, you
can switch resolutions and color levels right from the Finder menu!

v Color: Your MacBook can use a color profile file that controls the colors
on your display. This setting comes in handy for graphic artists and
illustrators who need color output from their printers that closely
matches the colors displayed by the laptop. Click the Calibrate button
to launch the Display Calibrator, which can create a custom ColorSync
profile and calibrate the colors that you see on your monitor.

860 Color LCD
Display | Color !
Resolutions:
640 x 480 Colors: | Millions %
640 x 480 (stretched) = <
720 x 480 Refresh Rate: n/a -
720 x 480 (stretched) (" Detect Displays k|

800 x 500
800 x 600

800 x 600 (stretched)

1024 x 640

1024 x 768 .

1024 x 768 (stretched) b ™ Show displays in menu bar @

Brightness; =

™ Automatically adjust brightness as ambient light changes
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The Desktop & Screen Saver pane

Hey, no offense to the awesome Aurora background (new with Leopard), but
who doesn’t want to choose their own background? And what about that
nifty screen saver you just downloaded from the Apple Web site? You can
change both your background and your screen saver by using these options
on the Desktop & Screen Saver pane.

The settings on the Desktop panel (as shown in Figure 6-5) include

v Current Desktop picture: To change your Desktop background, click
a thumbnail. You can also drag a picture from a Finder window or the
desktop and drop it into the well (the fancy Apple word for the square
box with the sunken look). Leopard automatically updates your Desktop
so you can see the results. To open another collection of images from
Apple, click the desired collection folder in the list on the left of the
panel. (I recommend the stunning images in the Nature folder.) If you
want to open a different folder with your own images, click the Add
button (which bears a plus sign) at the lower left of the panel and then
navigate to that folder.

v Arrangement: You can automatically fit an image to your screen, tile
your background image (repeat it across the Desktop), center it, or
stretch it to fill the screen. Because the images from Apple are all sized
correctly already, the Arrangement control appears only when you’re
using your own pictures.

The well
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v+ Change Picture: If you like a bit of automatic variety on your Desktop,
select the Change Picture check box. You can click the accompanying
drop-down list box to set the delay period. The images in the current
collection or folder are then displayed in the sequence in which they
appear in the thumbnail list.

v Random Order: Select this check box to throw caution utterly to the
wind and display random screens from the current collection or folder!

The settings on the Screen Saver tab include

v Screen Savers: Click the screen saver that you want to display from the
Screen Savers list. Leopard displays an animated preview of the selected
saver on the right. You can also click the Test button to try out the screen
saver in full-screen mode. (Move your mouse a bit to end the test.)

If the selected screen saver has any settings you can change, the
Options button displays them.

v~ Start Screen Saver: Drag this slider to choose the period of inactivity
that triggers the screen saver. Choose Never to disable the screen saver
entirely.

For additional security, check out the Security pane in System Preferences,
where you'll find the Require password to wake this computer from sleep
or screen saver check box. Enable the check box, and Leopard will require
your user account password before allowing anyone to turn off the screen
saver (a great idea when traveling, as you can imagine).

v Use Random Screen Saver: Another chance to rebel against conformity!
Enable this check box, and Leopard picks a different screen saver each
time.

v Show With Clock: Enable this check box, and Leopard adds a smart
clock display to your screen saver. (A great help for those of us who
spend many minutes on the phone.)

+* Hot Corners: Click this button to display a drop-down sheet, and then
click any of the four pop-up menus at the four corners of the screen
to select that corner as an activating hot corner. (Moving your mouse
pointer there immediately activates the screen saver.) You can also
specify a corner as a disabling hot corner — as long as the mouse pointer
stays in that corner, the screen saver is disabled. Note that you can also
set the Dashboard, Spaces, and Exposé activation corners from here.
(Read on for the entire lowdown.)

The Exposé & Spaces pane

The pane you see in Figure 6-6 illustrates the settings that control Leopard’s
Spaces, Dashboard, and Exposé features, which I discuss in more detail in
Chapter 5. The settings on the Exposé tab include
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v Active Screen Corners: The screen corners pop-up menus that I
describe in the preceding section operate just like those in the Screen
Savers panel. Click a corner’s list box to set it as

e An Exposé All Windows corner (displays all windows on your
Desktop).

¢ An Exposé Application Windows corner (displays only the windows
from the active application).

¢ An Exposé Desktop corner (moves all windows to the outside of
the screen to uncover your Desktop).

e A Spaces corner (activates the Spaces Desktop selection feature).

e A Sleep Display corner (immediately turns off your display, putting
your screen in Sleep mode).

¢ A Dashboard corner (displays your Dashboard widgets). Widgets
are small applications that each perform a single task; they appear
when you invoke the awesome power of Dashboard.

These pop-up menus can also set the Screen Saver activate and disable
hot corners.

1 Keyboard and mouse shortcuts: Pretty straightforward stuff here. Click
each pop-up menu to set the key sequences (and mouse button settings)
for all three Exposé functions as well as Dashboard.

<W¥ If you hold down a modifier key (Shift, Control, Option, or 8) while a
shortcut pop-up menu is open, Leopard adds that modifier key to the
selections you can choose! (Perfect for those folks who already have the
F11 key in use by another application. Make your Desktop shortcut key
the Shift+F11 key sequence instead.)

One of Leopard’s hottest new features is Spaces, which is the system you
use to configure and control multiple “prefabricated” desktops that you can
switch between at will! The settings on the Spaces tab include

v Enable Spaces: Enable this check box to use Spaces. (Go figure.)

v Show Spaces in Menu Bar: When this check box is enabled, Leopard
displays the Spaces desktop number you're currently using in the
Finder menu bar. You can click the number in the menu bar to switch to
another Spaces desktop or to open the Spaces Preferences pane.

+* Rows buttons: To add a row of Spaces desktops to the Spaces grid,
click the Add button with the plus sign. (By default, Spaces starts with
two desktops enabled, so new rows and columns are numbered begin-
ning with three.) To delete a row, click the Delete button (which bears a
minus sign).
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v Columns buttons: To add a column of Spaces desktops to the Spaces
grid, click the Add (plus) button. Click the Delete (minus) button to
remove a column from the grid.

If you choose to remove a column or row, Leopard alerts you that the
bindings (the specific applications linked to the deleted columns or
rows) will be reassigned.

v+ Add/Remove Application: Click the Add Application button (the button
with the plus sign under the Application Assignments list) to add an
application to one of your Spaces desktops. You can select which desk-
top should include an application by clicking the up/down arrows next
to the Space column for that application’s entry — just click the desired
desktop from the pop-up menu that appears. To remove an application,
click it in the Application Bindings list to select it and then click the

<P Remove Application button (which sports a minus sign).

Spaces can even add an application to all your desktops; just choose
Every Space from the pop-up menu.

v Keyboard and mouse shortcuts: Click each pop-up menu to set the key
sequences (and mouse button settings) for all three Spaces functions.

WMBER . . .
éy“" Like with Dashboard and Exposé keyboard and mouse shortcuts, you
can press Shift, Control, Option, and & keys (or even a combination of
them) while the box is open to display modified choices.
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The Appearance pane

The talented Appearance pane (as shown in Figure 6-7) determines the look
and operation of the controls that appear in application windows and Finder
windows. It looks complex, but I cover each option here.

ae0 Appearance
3
[« =] [ ShowAll Q
Appearance: | 1 Graphite ;
For the overall look of buttons, menus and windows
Highlight Color: | Blue $
For selected text
Place scroll arrows: () Together

Click in the scroll bar to:

@ At top and bottom

(@ Jump to the next page
O Jump to here
) Use smooth scrolling

@ Minimize when double-clicking a window title bar

Number of Recent Items:

[30 + | Applications
20 %] Documents

10 %] servers

Font smoothing style:

[ Automatic - best for main display 5]

Turn off text smoothing for font sizes | 4 % | and smaller.

The settings include

v Appearance: Click this pop-up menu to specify the color Leopard uses
for buttons, menus, and windows.

v+~ Highlight Color: Click this pop-up menu to choose the color that high-
lights selected text in fields, pop-up menus, and drop-down list boxes.

v~ Place Scroll Arrows: Select a radio button here to determine whether
the arrows that control the scroll bar in a window appear together
at the bottom of the scroll bar, or separately at the top and bottom
of the scroll bar.

v Click in the Scroll Bar To: By default, Leopard scrolls to the next or pre-
vious page when you click in an empty portion of the scroll bar. Select
the Jump to Here radio button to scroll the document to the approxi-
mate position in relation to where you clicked. (Smooth scrolling slows
down scrolling, which some people prefer.)

You can minimize a Finder or application window by simply double-
clicking the window’s title bar. To enable this feature, mark the Minimize
When Double Clicking a Window Title Bar check box.
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v Number of Recent Items: By default, Leopard displays ten recent appli-
cations, documents, and servers within Recent Items in the Apple menu.
Need more? Just click the corresponding pop-up menu and specify up to
50 items.

1 Font Smoothing Style: This feature performs a little visual magic that
makes the text on your monitor or flat-panel look more like the text on
a printed page. Most MacBook owners should choose Automatic or
Medium (for a typical flat-panel LCD display).

+ Turn Off Text Smoothing for Font Sizes: Below a certain point size, text
smoothing doesn’t help fonts look any smoother onscreen. By default,
any font displayed at 8 point or smaller isn’t smoothed, which is a good
choice for a MacBook with a flat-panel LCD screen.

The Energy Saver pane

I'm an environmentalist — it’s surprising how many techno-types are col-
ored green — so these two panels here are pretty doggone important. When
you use them correctly, you not only conserve battery power but also even
invoke the Power of Leopard to automatically start and shut down your
laptop whenever you like!

Laptop owners get special treatment within Leopard — notice the Settings
For and Optimization pop-up menus at the top of the pane, which don’t
appear if you're using a mere desktop Mac. These menus allow you to quickly
switch between different settings for operation with a battery or AC adapter,
making it easy to fine-tune your power use wherever you may find yourself!
You can choose from two energy use settings (Battery or Power Adapter)
and three optimization modes (Better Battery Life, Normal, or Better
Performance). If you tweak the settings on this pane yourself, Leopard auto-
matically assigns you a Custom optimization mode (perfect for those presen-
tations where you need a longer screen saver delay).

Naturally, if you plug your MacBook into a convenient AC outlet, the Settings
menu automatically switches to Power Adapter. When you’re running on bat-
tery power, System Preferences switches to Battery settings. (You can manu-
ally change at any time, however, if you need your laptop’s best performance
on the road, or if you want to go green and conserve electricity while using
your power adapter.)

The panels (as shown in Figure 6-8) include
v~ Sleep: To save that precious battery power, drag the Put the Computer

to Sleep When It Is Inactive For slider to a delay period that triggers
sleep mode when you're away from the keyboard for a significant period
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of time. (I prefer 30 minutes.) If your laptop must always remain alert
and you want to disable sleep mode entirely, choose Never. You can set
the delay period for blanking your monitor separately from the sleep set-
ting with the Put the Display to Sleep When the Computer Is Inactive For
slider. To conserve the maximum juice and cut down on wear, enable
the Put the Hard Disk(s) to Sleep When Possible check box to power-
down your hard drives when they’re not needed. (This might cause a
delay of a second or two while loading or saving files because the drives
must spin back up.)

You can set Leopard to start or shut down your laptop at a scheduled
time. Click the Schedule button and then select the desired schedule
(the Start Up or Wake check box and the Shut Down/Sleep pop-up menu)
to enable them. Set the trigger time by clicking the up and down arrows
next to the time display for each schedule. Click OK to return to the
Energy Saver pane.

v Options: By default, your laptop’s display will dim to indicate that sleep
mode is approaching, but you can disable the Automatically Reduce
the Brightness of the Display check box to maintain full brightness until
sleep mode actually kicks in. To reduce display power consumption, you
can enable the Slightly Dim the Display When Using This Power Source
check box. You can also enable or disable the Finder menu Battery
meter from the Options panel.
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Settings for: | Battery :j

Optimization: | Custom )

Your energy settings are optimized for high performance.
Current battery charge: 60% Estimated time remaining: 1:29
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' 1 ' ' ' ' 1 ' ' ' i
Lmin 15 min 1hr 3hrs  Never

Put the display(s) to sleep when the computer is inactive for:

1min 15 min 1hr 3hrs  Never

1Put the hard disk(s) to sleep when possible @

Hide Details _ Schedule...

1
J% Click the lock to prevent further changes.
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The Dock pane

I'll come clean: [ think the Dock is the best thing since sliced bread! (I wonder
what people referred to before sliced bread was invented?) You can use the
settings, as shown in Figure 6-9, to configure the Dock’s behavior until it fits
your personality like a glove:

v Size: Pretty self-explanatory. Just drag the slider to change the scale of
the Dock.

v Maghnification: When you select this check box, each icon in your Dock
swells like a puffer fish when you move your mouse cursor over it.
(Just how much it magnifies is determined by the Magnification slider.)
I really like this feature because I resize my Dock smaller, and [ have a
large number of Dock icons.

v Position on Screen: Select a radio button here to position the Dock on
the left, bottom, or right edge of your Desktop.

v+ Minimize Using: Leopard includes two cool animations that you can
choose from when shrinking a window to the Dock (and expanding it
back to the Desktop). Click the Minimize Using pop-up menu to specify
the genie-in-a-bottle effect or a scale-up-or-down-incrementally effect.

\3
P If animation isn’t your bag or you want to speed up the graphics perfor-

mance of an older G4 iBook or PowerBook, you can turn off these mini-
mizing effects.

1 Animate Opening Applications: Are you into aerobics? How about punk
rock and slam dancing? Active souls who like animation likely get a kick
out of the bouncing application icons in the Dock. They indicate that
you’ve launched an application and that it’s loading. You can turn off
this bouncing behavior by disabling this check box.

1 Automatically Hide and Show the Dock: Select this check box, and the
Dock disappears until you need it. (Depending on the size of your Dock,
the Desktop that you gain can be significant.) To display a hidden Dock,
move your mouse pointer over the corresponding edge of the Desktop.

8.0 0 Dock
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The Sharing pane

So you’re in a neighborly mood, and you want to share your toys with others
on your local wired or wireless network. Perhaps you’d like to start your own
Web site, or protect yourself against the Bad Guys on the Internet. All these
fun diversions are available from the Sharing pane in System Preferences, as
shown in Figure 6-10.

Click the Edit button to change the default network name assigned to your
MacBook during the installation process. Your current network name is listed
in the Computer Name text field.

Each entry in the Service list controls a specific type of sharing, including
Screen Sharing, File Sharing (with other Macs and PCs running Windows),
Printer Sharing, Web Sharing, Remote Login, Remote Management (using
Apple Remote Desktop), Remote Apple Events, Xgrid Sharing, Internet
Sharing, and Bluetooth Sharing. To turn on any of these services, enable the
On check box for that service. To turn off a service, click the corresponding
On check box to disable it.

From a security standpoint, I highly recommend that you enable only those
services that you actually use because each service you enable automatically
opens your Leopard firewall for that service. (Chapter 17 discusses your fire-
wall in more detail.) A Mark’s Maxim to remember:

Poking too many holes in your firewall is not A Good Thing.™

When you click one of the services in the list, the right side of the Sharing pane
changes to display the settings you can specify for that particular service. To
display all the details on these options, click the Help button (question mark)
at the lower-right corner of the System Preferences dialog.

The Time Machine pane

Mac users are excited about the new Time Machine automatic backup feature
that debuts with Leopard, and you can easily configure how Time Machine
handles your backups from this pane (as shown in Figure 6-11). Chapter 21
covers how to use Time Machine. Of course, you need an external hard drive
(or a Time Capsule wireless backup station) for the best backup security.
Note that Time Machine won’t work with your CD or DVD rewriteable drive:
You must use a hard drive.
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You can actually use a second partition on your existing internal hard drive to
hold your Time Machine data, but guess what happens if your internal hard
drive is hit with a hardware failure. You lose both your original data and your
backup in one fell swoop! For this reason, I strongly recommend that you add
an external hard drive to your MacBook for use with Time Machine. (I don’t
know why Apple even made this an option. Sigh.)

Time Machine

r \ Name: Ludwig
| Available: 34.1 GB of 51.5 GB

Oldest Backup: ——

Change Dlsks. e o ke e

Options... Next Backup: B9 seconds..

Time Machine Time Machine keeps
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OFF ! ON « Weekly backups until your backup disk is full

1 5how Time Machine status in the menu bar

1
[4 Click the lock to prevent further changes.

®

To enable Time Machine, click the big On sliding switch and then select a
disk (or partition) that will hold your Time Machine backup data. Click the
desired backup location, and then click Use for Backup. It’s really that simple!

Your Mac must be turned on to allow a Time Machine backup to run.
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By default, Time Machine backs up all the hard drives on your system;
however, you might not need to back up some hard drives or folders on
your laptop. To save time and hard drive space, Time Machine allows you
to exclude specific drives and folders from the backup process. Click the
Options button; then click the Add button (with the plus sign) to select the
drives or folders you want to exclude, and they’ll appear in the Do Not Back
Up list.

To remove an exclusion, select it in the list and click the Delete button (with
the minus sign); note the Total Included figure increases, and Time Machine
adds the item you deleted from the list to the next backup.



Chapter 7

Sifting through Your Stuff

In This Chapter
Understanding how Spotlight works

Searching for data, files, and folders via Spotlight
Using the results you get from a Spotlight search
Searching with the Find dialog and the Search box

Searching for stuff on the Internet with Dashboard widgets

w hat would you say if I told you that you could search your entire
system for every single piece of data connected with a person —

and in only the short time it takes to type that person’s name? And I'm not
just talking about files and folders that might include that person’s name. I
mean every e-mail message and every iCal calendar event that references
that person — and even that person’s Address Book card to boot? Heck,
how about if that search could dig up every occurrence of the person’s name
inside your electronic PDF documents?

You’d probably say, “That makes for good future tech — I'll bet I can do that
in five or ten years. It’ll take Apple at least that long to do it . . . and just in
time for me to buy a new MacBook! (Harrumph.)”

Don’t be so hasty: You can do all this, right now. The technology is the Mac
OS X feature named Spotlight, built right into Leopard. In this chapter, I show
you how to use it like a Mac power guru. I also show you how to take advan-
tage of Internet search widgets you can display within Dashboard. (From
what I hear, there’s good stuff on the Internet, too.)

A Not-So-Confusing Introduction
to Spotlight

Invoking the magic of Spotlight is a snap. As you can see in Figure 7-1, the
Spotlight search field always hangs out on the right side of the Finder menu
bar. You can either click once on the magnifying glass icon or just press

& +spacebar. Either way, Leopard displays the Spotlight search box.
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Spotlight works by indexing — in other words, searching for and keep-

ing track of keywords within your files. (In case you've never heard the
term before, a keyword is a word in the title or innards of a document that
describes the contents, like leopard, music, or soda. That last one turns up a
lot in my documents.)

In fact, Leopard indexes the contents of your MacBook’s hard drives into one
huge file, which it constantly maintains while you create new files and modify
existing files. Leopard can search this index file in a fraction of a second

after you enter your search criteria. Your index file contains all sorts of data,
including quite a bit of information from inside various documents: hence,
Spotlight’s ability to present matching data inside your files and application
records.

When you first boot Leopard, it spends anywhere from a few minutes to an
hour or two creating the initial Spotlight index file. A blue dot appears in the
middle of the magnifying glass icon while indexing is underway. Creating this
full index happens only once, so it’s no great burden to bear.

You can search for any string of text characters in Spotlight, and you’ll
be surprised at everything this plucky feature will search. For example,
Spotlight searches through your Address Book contacts, Mail messages, iCal
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calendars, iChat transcripts, temporary Web page cache, and even System
Preferences! Yep, you can even use it to find specific settings in all those
System Preferences panes, such as printer sharing or Dashboard. Of course,
Spotlight includes matching files and folders — like that other operating
system — but it does it in the blink of an eye.

Spotlight matches all the items that include all your search text: Therefore,
if you enter just the word horse, you're likely to get far more matches than if
you enter a more-restrictive word string, such as horse show ticket.

If you add metadata to your documents — such as a Comment field in a Word
document (which you can display in the Get Info dialog box) — Spotlight
matches that information as well. Other recognized file formats include iWork
documents, Excel spreadsheets, Keynote presentations, and third-party appli-
cations that offer a Spotlight plug-in.

Searching with Spotlight

To begin a Spotlight topic search, click within the Spotlight box and start
typing. As soon as your finger presses the first key, you’ll see matching items
start to appear. Check out Figure 7-2, in which I typed only a single character
(L). No need to press Return to start the process, by the way. When you type
more characters, Spotlight’s results are updated in real time to reflect those
more-restrictive qualifiers. For example, if I had typed three characters —
say, Leo — my results would be far more specific: everything from Leopard to
Leonard Bernstein.

Spotlight displays what it considers the top 20 matching items within the
Spotlight menu itself. These most relevant hits are arranged into categories,
such as Documents, Images, and Folders. You can change the order in which
categories appear (via the Spotlight pane within System Preferences, which I
cover a bit later in this chapter).

With its internal magic, Spotlight presents the category Top Hit (with what it
considers the single, most-relevant match) at the top of the search results, as
also shown in Figure 7-2. You'll find that the Top Hit is often just what you're
looking for. To open or launch the Top Hit item from the keyboard, click the
entry or press the down-arrow key (|) to select Top Hit; then press Return.

Didn’t find what you were after? Click the X icon that appears at the right side
of the Spotlight box to reset the search box and then start over.

If all you know about the item you’re searching for is its file type, prefix a key-
word with the text kind: in front of the file type in the Searchlight field. For
example, say you're searching for a QuickTime movie, but you don’t know the
title. In this case, you’d type kind:movies. This trick also works with image
files (kind:images), contacts (kind:contacts), applications (kind:applications),
and audio files (kind:music), too.

111
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Here’s another trick that’s built into Spotlight: You can type in a date a file was
created or received, such as modified:=>01/01/08, to match all items modi-
fied on or after January 1, 2008. Heck, you can even combine appended cri-
teria, such as kind:music created:07/18/07. Note: Be sure to include a space
between the criteria. Spotlight then matches every audio file that was created

on that date. One-hundred-percent sassy!

To allow even greater flexibility in your searches, Apple uses those help-
ful Boolean search friends that you might already be familiar with: AND, OR,
and NOT (separated by spaces). For example, in Leopard, you can perform

Spotlight searches, such as

v Horse AND cow: Collects all references to both those barnyard animals

into one search

v Batman OR Robin: Returns all references to either Batman or Robin, but

not both

v Apple NOT PC: Displays all references to Apple that don’t include any

information on dastardly PCs
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How secure is Spotlight?

Say you're sharing your Mac as a multiuser
computer, or accessing other Macs remotely.
What about all those files, folders, contacts,
and events that you dont want to appear in
Spotlight? Can other folks search for and access
your personal information through Spotlight?

Definitely not! The results displayed by
Spotlight are controlled by file and folder per-
missions as well as your account login, just like
the applications that create and display your
personal data. For example, you can’t access
other users’ calendars by using iCal, and they
can't see your Mail messages. Only you have

access to your data, and only after you log in
with your username and password. Spotlight
works the same way. If a user doesn't normally
have access to anitem, it simply doesn’t appear
when that user performs a Spotlight search. (In
other words, only you get to see your stuff.)

However, you can even hide certain folders
and disks from your own Spotlight searches if
necessary. Perhaps you'd prefer keeping your
tax and financial records away from Spotlight's
all-searching eye? Check out the last section of
this chapter for details on setting private loca-
tions on your system.

Working with matching stuff

After you run a fruitful search, and Spotlight finds the proverbial needle in
your system’s haystack, what’s next?

Just click the item — that’s all it takes. Depending on the type of item,

Leopard does one of four things:

v Launches an application

v Opens a specific pane in System Preferences (if the match is the name of

a setting or contained in the text on a Preferences pane)

v Opens a document or data item, such as an Address Book card

v Displays a folder within a Finder window

To see all sorts of useful info about each Spotlight menu item — otherwise

known as filtering — click the Show All item (above the Top Hit listing; refer
to Figure 7-2) to expand your Spotlight menu into the Results window, as
shown in Figure 7-3. From the keyboard, you can press the Results window
shortcut key, which you can set from System Preferences (more on this in a
page or two).
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To further filter the search, click one of the buttons on the Spotlight Results
window toolbar or create your own custom filter. Click the button with the
plus sign to display the search criteria bar and then click the pop-up menus
to choose from criteria, such as the type of file, text content, or the location
on your system (such as your hard drive, your Home folder, or a network
server). You can also filter your results listing by the date when the items
were created or last saved. To add or delete criteria, click the plus and minus
buttons at the right side of the search criteria bar. To save a custom filter
that you created, click Save.

After you locate the item you want, click it to open, launch, or display it, just
like you would in the Spotlight menu.

Tweaking Spotlight in System Preferences

The System Preferences window boasts a Spotlight pane, which you can use
to customize what search matches you see and how they are presented. To
adjust these settings, click the System Preferences icon on the Dock (look
for the Three Gears of Justice) and then click the Spotlight icon (under
Personal).

Configuring the Search Results settings

Figure 7-4 illustrates the Search Results tab of the Spotlight Preferences pane.
From here, you can

v Pick your categories. To disable a category (typically because you don’t
use those types of files), select the check box next to the unnecessary
category to clear it.
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v~ Specify the order that categories appear within Spotlight. Drag the
categories into the order that you want them to appear in the Spotlight

menu and Results window.

1 Select new Spotlight menu and Spotlight Results window keyboard
shortcuts. In fact, you can enable or disable either keyboard shortcut, as
you like. Click the pop-up menu to choose a key combination.

600
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Spotlight

e

at the top right corner of the screen.

Search Results | Privacy |

Drag categories to change the order in which results appear.

o

Only selected categories will appear in Spotlight search results.
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E4 Spotlight menu keyboard shortcut:

Spotlight helps you quickly find things on your computer. Spotlight is located

# Space =
ESpnlligh( window keyboard shortcut: U838 Space |

Marking stuff off-limits
Click the Privacy tab (as shown in Fig

ure 7-5) to add disks and folders that

should never be listed as results in a Spotlight search. The disks and folders

that you add to this list won’t appear
string. This safeguard can come in ha

even if they actually match your search
ndy for organizations (such as hospi-

tals) that are required by law to protect their patient or client data. However,
you can select a removable hard drive here, which is often stored in a safe

after business hours.

To add a private location, click the Add button (which bears a plus sign) and
navigate to the desired location. Then click the location to select it and click

Choose.

If you already have the location open in a Finder window, you also can drag
folders or disks directly from the window and drop them into the list.
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Figure 7-5:
Some things
should
never

been seen;
specify
them within
Spotlight.

Add button

® 00 Spotlight

[ show Al Q ]

{ /3; Spotlight helps you quickly find things on your computer. Spotlight is located
at the top right corner of the screen.

! Search Results | Privacy

Prevent Spotlight from searching these locations:
Click the Add button, or drag a folder or disk into the list below.

3 Work

—+

¥ Spotlight menu keyboard shortcut: | 38 Space

-
-

¥ Spotlight window keyboard shortcut: | % Space

Other Search Tools Are Available, Too

The Finder window toolbar has featured a Search box for a few years now
(and Leopard includes a Find dialog), but even the older Search features
within Leopard have been updated to take advantage of Spotlight technology.
Now you can even use file types (such as image or movie) and relative time
periods (such as yesterday and last week) in the Finder window Search box
and Find displays!

Typically, I use the Finder window Search box if | need to do a simple file or
folder name search: It works the same as using the Spotlight search field.
Just begin typing. To reset the field and start anew, click the X button in the
Search box. To choose a specific location for your search — say, your Home
folder or a hard drive volume — click the desired button along the top of the
Search results display. The Finder window automatically turns into a Results
display.

Leopard also includes the oldest Search method in the book: the Find dis-
play. (It used to be a dialog all by itself, but Find controls are now displayed
in the Finder window, so it’s more of an extension to the Finder window.)
Choose Filer>Find or press 38+F to display the Find controls. From here, you
can click pop-up menus to choose a specific filename or portion of a filename.
Other modifiers include the file type, content, file size, and the most recent
date when the file was opened. Again, click the location buttons at the top of
the window to choose where to search.
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For a truly mind-blowing list of modifiers, click the Other item in the modifier
menu. You'll find you can search for all photos where a certain shutter speed
was used, or all files that are read-only. Heck, | sometimes use this expanded
list to search for documents that use a certain font!

\\J

The Find display, however, is a little more sophisticated than the toolbar Search
box. You can click the plus (+) button next to a search criterion field in the Find
display to add another field, allowing for matches based on more than one condi-
tion. Click the minus (=) button next to a search criterion field to remove it.

After you find a match, both older Search methods work the same: Click

the item once to display its location, or double-click it to launch or open it.
Files can also be moved or copied, respectively, from the Results and Find
displays with the standard drag or Option+drag methods. You can return to
the more mundane Finder window display by clicking the Back button on the
toolbar to erase the contents of the Spotlight box.

<W¥ These older Search methods can also do one thing that Spotlight doesn’t offer:
You can use them to create a new Smart Folder, which is a folder with contents
that Leopard automatically updates according to the criteria you set — the
same modifiers I discuss earlier.

Click the Save button in either the Finder window Search Results or Find dis-
play. You'’re prompted to specify the name and location for the new Smart
Folder and whether it should appear in the Finder window Sidebar.

After you create the folder, Leopard automatically updates the contents of
the Smart Folder with whatever items match the criteria you saved. You
never have to search using the same text or criteria again because the search
is saved as part of the Smart Folder! (Each icon in a Smart Folder is a link to
the actual file or folder — just like an alias — so nothing gets moved, and

no extra space is wasted with multiple copies of the same items.) In other
words, you can work with the files and folders inside a Smart Folder as if they
were the actual items themselves.

With Widgets, the Internet
Is Your Resource

No chapter on searching within Mac OS X would be complete without the
Internet resources available through your Leopard Dashboard. (I describe
widgets in illuminating detail in Chapter 5.) Figure 7-6 illustrates many of
these widgets:

v Dictionary: This multipurpose widget can display the Oxford American
dictionary or thesaurus entry for the word you enter.
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v Weather: Check out the six-day forecast for a specific ZIP code or
city/state combination at a glance.

\ . . . .

P To enter the location data, click the tiny i/ button that appears when you
mouse over the right corner of the widget. This trick works with just
about every widget, allowing you to set any options it offers.

v+~ Flight Tracker: Keep tabs on the arrival and destination time for the
flight you specify.

v Google: Yep, it’s a shortcut to the King of all Internet search engines.
Just type in the words you want to search for and then press Return.
The widget automatically launches Safari with the results!

v Business: Put your local Yellow Pages to work by typing in a business
name or category. This widget displays matching telephone numbers
and addresses. Click an entry to get directions or a map from the Web.

CMBER , . .

é,\“ Okay, I know you’re going to roll your eyes, but [ have to remind you that you
need an Internet connection to use these widgets. Otherwise, Business and
Flight Tracker are about as useful as a pair of swim fins in the Sahara Desert.
Naturally, you’ll find countless other Internet-enabled widgets on the Apple
Web site, in the Download area. For all the details on adding built-in widgets
to your Dashboard, visit Chapter 5.
Dictonary
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be veached on the road with my pager and PDA,
Soon T’11 be veachable on a plane with email. T'm
beginning to think identity theft wouldn’t be
such a bad idea for a while.”




In this part . . .

ou want to do the Internet thing, don’t you? Sure,

you do! In this part, I describe and demonstrate your
Safari Web browser. You also find out about Apple’s .Mac
Internet subscription service. Finally, this part fills you in
on connecting important stuff, such as printers and scan-
ners, as well as how you can use the cool-looking Apple
Remote and your laptop’s built-in iSight Web cam and
Photo Booth.




Chapter 8
Taking Your Laptop on Safari!

In This Chapter

Introducing the Safari window and controls
Visiting Web sites with Safari

Moving between sites

Creating and using bookmarks
Receiving files with Safari

Surfing with your tabs showing
Saving Web pages to disk
Protecting your privacy on the Web
Blocking those irritating pop-ups

! ooking for that massive Microsoft monster of a Web browser on your
MacBook? You know, the one that practically everyone uses in the
Windows world. What'’s it called? I forget the name.

You see, I use a MacBook Pro, and I proudly surf the Web via a lean, mean —
and very fast — browser application. That’s Safari, of course, and it just keeps
getting better with each new version of Mac OS X. It doesn’t matter whether
you’re working wirelessly from a hotel room or safely ensconced in your
office: Safari delivers the Web the right way, without the wait.

If you need a guide to Safari, this is your chapter. Sure, you can start using it
immediately, but wouldn’t you rather read a few pages in order to surf like a
power user?

It’s Not Just Another Web Browser

Figure 8-1 illustrates the Safari window. You can launch Safari directly from
the Dock, or you can click the Safari icon (which looks like a compass dial)
within your Applications folder.
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|
Figure 8-1:
The Web
doesn't get
any better
than this —
the default
Safari
window.
|
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Status bar Content window

Major sections of the Safari window include

’/

1

”

The Toolbar: You'll find the most often-used commands on this toolbar
for everyday tasks, such as navigation, adding bookmarks, and search-
ing Google. Plus, here, you can type or paste the address for Web sites
that you’d like to visit. You can hide the Toolbar to open up more real
estate in your browser window for Web content. To toggle hidden
mode, press 38+ (the vertical bar right above the backslash) or choose
ViewroHide/Show Toolbar.

The Bookmarks bar: Consider this a toolbar that allows you to jump
directly to your favorite Web sites with a single click. I show you later,
in the section “Adding and Using Bookmarks,” how to add and remove
sites from your Bookmarks bar. For now, remember that you can
toggle the display of the Bookmarks bar by choosing View=>Hide/Show
Bookmarks Bar, or by pressing 38 +Shift+B.

The Content window: Congratulations! At last, you waded through all
the pre-game show and reached the area where Web pages are actually
displayed. Like any other window, the Content window can be scrolled;
when you minimize Safari to the Dock, you get a thumbnail (minimized)
image of the Content window.

The Content window often contains underlined text and graphical icons
that transport you to other pages when you click them. These under-
lined words and icons are links, and they make it easy for you to move
from one area of a site to another or to a completely different site.
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v~ The status bar: The status bar displays information about what the
mouse pointer is currently resting upon, like the address for a link or the
name of an image; it also updates you on what’s happening while a page
is loading. To hide or display the status bar, press $8+/ (forward slash).

Visiting Web Sites

3

Sure, you're likely saying, “Mark, I already know this stuff. [ can operate a
Web browser blindfolded — while listening to The Best of Air Supply, even.” |
agree wholeheartedly, but I get paid by the word, and some folks might just
not be aware of all the myriad ways of visiting a site. You can load a Web
page from any of the following methods:

v Type (or paste) a Web site address into the Toolbar and then press
Return.

If you're typing in an address and Safari recognizes the site as one that
you already visited, it helps by completing the address for you. If this is
a new site, just keep typing.

v Click a Bookmarks entry within Safari.

v Click the Home button, which takes you to the home page that you
specify.

More on this in the section, “Putting Down Roots with a New Home
Page,” later in this chapter.

v Click a page link in Apple Mail or another Internet-savvy application.
v Click a page link within another Web page.
v Use the Google box in the Toolbar.

Click in the Google box, type the contents that you want to find, and
then press Return. Safari presents you with the search results page on
Google for the text that you entered. (In case you’ve been living under
the Internet equivalent of a rock for the last couple of years, Google.
com is the preeminent search site on the Web. People use Google to find
everything from used auto parts to ex-spouses.)

1 Click a Safari page icon on the Dock or in a Finder window.

For example, Mac OS X sports an icon in the default Dock that takes
you to the Mac OS X page on the Apple Web site. Drag a site from your
Bookmarks bar and drop it on the right side of the Dock. Clicking the
icon that you add launches Safari and automatically loads that site.

This trick works only on the side of the Dock to the right of the vertical
line.
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If you minimize Safari to the Dock, you’ll see a thumbnail of the page with
the Safari logo. Click this thumbnail in the Dock to restore the page to its full

glory.

Basic Navigation While on Safari

A typical Web surfing session is a linear experience — you bop from one page
to the next, absorbing the information that you want and discarding the rest.
However, after you visit a few sites, you might find that you need to return to
where you’ve been or head to the familiar ground of your home page. Safari
offers these navigational controls on the Toolbar:

v Back: Click the Back button (the left-facing arrow) on the toolbar to
return to the last page that you visited. Additional clicks take you to pre-
vious pages, in reverse order. The Back button is disabled if you haven’t
visited at least two sites.

v Forward: If you've clicked the Back button at least once, clicking the
Forward button (the right-facing arrow) takes you to the next page (or
through the pages) where you were, in forward order. The Forward
button is disabled if you haven’t used the Back button.

v Home: Click this button (look for the little house) to return to your
home page.

égN\BEH Not all these buttons and controls might appear on your Toolbar. To

& display or hide Toolbar controls, choose View=>Customize Toolbar. The
sheet that appears works just like the Customize Toolbar sheet within

a Finder window: Drag the control you want from the sheet to your
Toolbar, or drag a control that you don’t want from the Toolbar to the
sheet.

v AutoFill: If you fill out a lot of forms online — when you’re shopping at
Web sites, for example — you can click the AutoFill button (which looks
like a little text box and a pen) to complete these forms for you. You can
set what information is used for AutoFill by choosing Safaric>Preferences
and the clicking the AutoFill toolbar button.

@‘“\NG! To be honest, I'm not a big fan of releasing any personal information to
S any Web site, so I don’t use AutoFill often. If you do decide to use this
feature, make sure that the connection is secure (look for the padlock
icon in the upper-right corner of the Safari window) and read the site’s
Privacy Agreement page first to see how your identity data will be
treated.

v Text Size: Use this to shrink or expand the text on the page, offering
smaller, space-saving characters (for the shrinking crowd) or larger,
easier-to-read text (for the expanding crowd). Hence the button, which
is labeled with a small and large letter A.



Chapter 8: Taking Your Laptop on Safari!

v+~ Stop/Reload: Click Reload (which has a circular arrow) to refresh
(reload) the contents of the current page. Although most pages remain
static, some pages change their content at regular intervals or after you
fill out a form or click a button. By clicking Reload (look for the curvy
arrow), you can see what’s changed on these pages. (I use Reload every
hour or so with CNN.com, for example.) While a page is loading, the
Reload button turns into the Stop button — with a little X mark — and
you can click it to stop the loading of the content from the current
page. This is a real boon when a download takes foorrevverr, which can
happen when you’re trying to visit a very popular or very slow Web site
(especially if you're using a dialup modem connection to the Internet).
Using Stop is also handy if a page has a number of very large graphics
that are going to take a long time to load.

v Open in Dashboard: Click this button to create a Dashboard widget
using the contents of the currently displayed Web page. Safari prompts
you to choose which clickable section of the page to be included within
the widget’s borders (like the local radar map on your favorite weather
Web site). Click Add, and Dashboard loads automatically with your new
widget. (More on widgets in Chapter 5.)

v Add Bookmark: Click this Toolbar button (which carries a plus sign) to
add a page to your Bookmarks bar or Bookmarks menu. (More on this in
atad.)

v Google Search: As [ mention earlier, you can click in this box, type text
that you want to find on the Web via the Google search engine, and then
press Return to display the results. To repeat a recent search, click
the down arrow in the Google Search box and select it from the pop-up
menu.

v Print: Click this convenient button to print the contents of the Safari
window. Dig that crazy printer icon!

+~ Report Bug: A rather strange creature, the Safari Bug button makes
it easy to alert Apple when you encounter a page that doesn’t display
properly in Safari. (Software developers call such glitches bugs: hence,
the name.) When you click the Bug button, you’ll see a sheet with the
settings shown in Figure 8-2; there, you can enter a short description of
the problem that you’re having. (I also enable the Send Screen Shot of
Current Page and the Send Source of Current Page check boxes to give
the Apple folks more to work with while they’re debugging Safari.) Then
click the Submit button to send the bug report to Apple.

125



1 26 Part lll: Connecting and Communicating

|
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Putting Down Roots with a
New Home Page

Choosing a home page (that’s the page that initially appears when you launch
Safari) is one of the easiest methods of speeding up your Web surfing, espe-
cially if you're using a dialup modem connection. However, a large percent-
age of the Mac owners with whom I've talked have never set their own home
page, simply using the default home page provided by their browser. With
Safari running, take a moment to follow these steps to declare your own free-
dom to choose your own home page:

\\3

1.

Display the Web page you want as your new home page, in Safari.

[ recommend electing a page with few graphics or a fast-loading popular
site.

2. Choose Safari~>Preferences or press 3+, (comma).

. Click the General button.

You see the settings shown in Figure 8-3.

4. Click the Set to Current Page button.

5. Alternatively, click the New Windows Open With pop-up menu and

choose Empty Page if you want Safari to open a new window with a
blank page.

This is the fastest choice of all for a home page (and a good choice for
those using a dialup modem connection because then Safari doesn’t
have to download anything upfront).

. Click the Close button to exit the Preferences dialog.
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Visit your home page at any time by pressing the Home button on the Toolbar.

Well, maybe not mean— after all, | don't want
you to be afraid of RSS (RDF Site Summary or
really simple syndication) pages! RSS Web
sites display updated information by using a
shortened list format, rather like a newspaper
headline, without unnecessary graphics or
silly advertisements. You can tell when a Web
site has RSS pages available because Safari
displays an RSS icon at the right side of the
Address box. (When you click the RSS icon,
the Web address switches to a feed: //
prefix — another indication that you're not in
Kansas reading HTML pages anymore.)

To display more information about a news
item on an RSS page, click the item headline.
Safari opens the corresponding Web page —
yep, once again you're back in the world of

Lean, fast, and mean — That's RSS

HTML — where you can read the full story. To
return to the RSS feed, click the Back button on
the Toolbar. Naturally, RSS feed pages can be
bookmarked. In fact, Apple gives you a number
of RSS sites that you can explore immediately.

To customize your RSS display, choose
Safariz>Preferences and then click the RSS
tab. By default, Safari checks for updated RSS
headlines on your bookmarked feeds every 30
minutes, but you can change this to an hourly or
daily check. (Of course, you can also check for
updates manually by reloading the RSS page, just
like you would any other Web page.) New articles
can be assigned any color you like, and you can
specify the amount of time an item should remain
on the RSS page after it's published.
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Adding and Using Bookmarks

No doubt about it: Bookmarks make the Web a friendly place. When you set
bookmarks in Safari, you can immediately jump from one site to another with
a single click of the Bookmarks menu or the buttons on the Bookmarks bar.
(The Bookmarks menu opens up in a separate pane on the left side of the
Safari window, and the Bookmarks bar appears right below the Toolbar: your
choice!)

To add a bookmark, first navigate to the desired page and then do any of the
following:

v Choose Bookmarks~>Add Bookmark.
+* Press the 88+D keyboard shortcut.

Safari displays a sheet where you can enter the name for the book-
mark and also select where it appears (on the Bookmarks bar or the
Bookmarks menu).

+ Drag the icon next to the Web address from the Toolbar to the
Bookmarks bar.
¥ You can also drag a link on the current page to the Bookmarks bar, but note
that doing this adds only a bookmark for the page corresponding to the link —
not the current page.

To jump to a bookmark

v Choose it from the Bookmarks menu.

If the bookmark is contained in a folder, which I discuss later in this
section, move your mouse pointer over the folder name to show its con-
tents and then click the bookmark.

v Click the bookmark on the Bookmarks bar.

¥ If you've added a large number of items to the Bookmarks bar, click the

More icon on the edge of the Bookmarks bar to display the rest of the
buttons.

v Click the Show All Bookmarks button (which looks like a small,
opened book) on the Bookmarks bar and then click the desired
bookmark.

The Bookmarks window that you see in Figure 8-4 appears, where you
can review each collection of bookmarks at leisure.
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The more bookmarks that you add, the more unwieldy the Bookmarks
menu and the Bookmarks window become. To keep your bookmarks
organized, choose Bookmarks=>Add Bookmark Folder and then type a
name for the new folder. With folders, you can organize your bookmarks
into collections, which appear in the column at the left of the Bookmarks
window (or as separate submenus within the Bookmarks menu). You
can drag bookmarks into the new folder to help reduce the clutter.

To delete a bookmark or a folder from the Bookmarks window, click it and
then press Delete.

Downloading Files

A huge chunk of the fun that you’ll find on the Web is the ability to download
images and files. If you’ve visited a site that offers files for downloading, you
typically just click the Download button or the download file link, and Safari
takes care of the rest. You'll see the Downloads status window, which keeps
you updated with the progress of the transfer. While the file is downloading,
feel free to continue browsing or even download additional files; the status
window helps you keep track of what’s going on and when everything will be
finished transferring. To display the Download status window from the key-
board, press 88+Option+L.
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By default, Safari saves any downloaded files to your Mac OS X Downloads
folder on the Dock, which I like and use. To specify the location where down-
loaded files are stored — for example, if you’d like to scan them automati-
cally with an antivirus program — follow these steps:

1. Choose Safari~>Preferences or press 38+, (comma).

2. Click the General tab (refer to Figure 8-3) and then click the Save
Downloaded Files To pop-up menu.

. Choose Other.
. Navigate to the location where you want the files stored.
. Click the Select button.

S U1 e W

. Click the Close button to exit Preferences.

To download a specific image that appears on a Web page, move your mouse
pointer over the image and hold down Control while you click (or right-click,
if you've got the button to spare). Then choose Save Image As from the
pop-up menu that appears. Safari prompts you for the location where you
want to store the file.

You can choose to automatically open files that Safari considers safe —
things such as movies, text files, and PDF files that are very unlikely to

store a virus or a damaging macro. By default, the Open “Safe” files After
Downloading check box is enabled on the General pane. However, if you're
interested in preventing anything you download from running until you man-
ually check it with your antivirus application, you can disable the check box
and breathe easy.

Luckily, Safari has matured to the point that it can seamlessly handle virtually
any multimedia file type that it encounters. However, if you've downloaded

a multimedia file and Safari doesn’t seem to be able to play or display it, try
loading the file within QuickTime. QuickTime is the Swiss Army knife of multi-
media players, and it can recognize a huge number of audio, video, and image
formats.

Using Subscriptions and History

To keep track of where you've been, you can display the History list by click-
ing the History menu. To return to a page in the list, just choose it from the
History menu. Note that Safari also arranges older history items by the date
you visited the site, so you can easily jump back a couple of days to that page
you forgot to bookmark!
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Searching for pointed sewing implements in a haystack

Looking for a certain word or phrase on a huge
Web page that seems to be 47 screens long?
Don’t despair! You can always press 38+F (or
choose Edit=>Find=>Find) to display the Find
bar (which appears directly under the Safari
Toolbar). Type the word or phrase that you're
looking for in the Find box — no need to press
Return — and Safari highlights any matches
that it finds!

Click the Next button in the Find bar to advance
to each spot within the page in order, all the
way to the bottom of the page. To search
upward to the top of the page, click Previous.
When you're finished searching, click the Done
button to banish the Find bar.

Convenient, indeed. Consider that needle
found!

In fact, Safari also searches the History list automatically, when it fills in an
address that you're typing. That’s the feature I mention in the earlier section,

“Visiting Web Sites.”

If you're worried about security and you’d rather not keep track of where

you've been online, I show you how to clear the contents of the History file in

the upcoming section, “Handling ancient history.”

Tabs Are Your Browsing Friends

Safari also offers tabbed browsing, which many folks use to display (and orga-
nize) multiple Web pages at one time. For example, if you're doing a bit of
comparison shopping for a new piece of hardware between different online

\\3

stores, tabs are ideal.

When you hold down the 38 key and click a link or bookmark using tabs, a
tab representing the new page appears under the Bookmarks bar. (Choose
File>New Tab or press 8+T to work the same magic.) Just click the tab to
switch to that page. (If you don’t hold down 88, things revert to business as
usual, and Safari replaces the contents of the window with the new page.)
Figure 8-5 illustrates a number of pages that I opened in Safari, using tabs.

To turn on tabbed browsing, choose Safari>Preferences to display the

Preferences dialog; then click Tabs. From here, select the 88-Click Opens a
Link in a New Tab check box to enable it. After you turn on tabs, your brows-
ing experience will never be the same.

Done with a page? You can remove a tabbed page by clicking the X button

next to the tab’s title.
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Saving Web Pages

If you encounter a page that you’d like to load later, you can save it to disk in
its entirety as a Web archive (which stores all the page content, including the
text and images). Follow these steps:

1.
2.
3.
4.

5.

Display the desired page.
Choose Filem>Save As, or press 38+S.
In the Export As text field, type a name for the saved page.

From the Where field, navigate to the location where you want to
store the file on your system.

To expand the sheet to allow navigation to any location on your system,
click the button with the down arrow.

Click the Format pop-up menu to choose the format for the saved
page.

Usually, you’ll want to choose a Web Archive, which saves the entire
page and can be displayed just as you see it (even if your MacBook no
longer has an Internet connection). However, if you want to save just the
HTML source code, choose Page Source.
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6. Click Save to begin the download process.

After the Save file is created, double-click it to load it in Safari.

A quick word about printing a page within Safari: Some combinations of back-
ground and text colors might conspire together to render your printed copy
practically worthless. In a case like that, use your printer’s grayscale setting
(if it has one). Alternatively, you can simply click and drag to select the text
on the page, press 8+C to copy it, and then paste the text into Word or Pages,
where you can print the page on a less offensive background (while still keep-
ing the text formatting largely untouched).

If you’d rather mail the contents of a Web page to a friend — or just a link to
the page, which is faster to send over a dialup Internet connection — choose
Filer>Mail Contents of this Page/Mail Link to this Page. (From the keyboard,
press 88+I to send the contents in an e-mail message, or press 8 +Shift+I to
send a link in e-mail.) Mail loads automatically, complete with a prepared
e-mail message. Just address it to the recipients and then click Send!

Protecting Your Privacy

No chapter on Safari would be complete without a discussion of security,
both against outside intrusion from the Internet and prying eyes around your
MacBook. Hence, this last section, which covers protecting your privacy.

Although diminutive, the tiny padlock icon that appears in the top-right corner
of the Safari window when you’re connected to a secure Web site means a
great deal! A secure site encrypts the information that you send and receive,
making it much harder for those of unscrupulous ideals to obtain things like
credit card numbers and personal information. Of course, the padlock doesn’t
ensure that you're on a “good” Web site — plenty of objectionable sites want
your money as well — but at least you can be certain that your personal and
financial information won’t be intercepted in transit between your MacBook
and the site.

Never — I mean never — enter any valuable personal or financial information
on a Web page unless you see the secure connection padlock symbol.™

This type of information includes

v Obvious things, such as your credit card number, address, or telephone
number

v Not-so-obvious things, such as your Social Security number or a login/
password combination
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If a site doesn’t provide a secure connection and asks you for personal infor-
mation, find another spot in cyberspace to do your business. Your identity
should remain yours.

It’s always a good idea to restrict your Web shopping to your home network.
For example, [ don’t use airport or coffee shop wireless networks when

I'm sending credit card or personal information across the Internet. Why?
Because the “open” (as in unencrypted) architecture of these public networks
can allow others to intercept the data that you send and receive. Therefore,

I recommend that you use a public wireless network for simple Web surfing,
but save the important stuff for your home or office. (You can find more infor-
mation on wireless networking in Chapter 17.)

Ves, there are such things as bad cookies

First, a definition of this ridiculous term: A cookie, a small file that a Web site
automatically saves on your hard drive, contains information that the site
will use on your future visits. For example, a site might save a cookie to pre-
serve your site preferences for the next time or — in the case of a site such
as Amazon.com — to identify you automatically and help customize the offer-
ings that you see.

In and of themselves, cookies aren’t bad things. Unlike a virus, a cookie file
isn’t going to replicate itself or wreak havoc on your system, and only the
original site can read the cookie that it creates. However, many folks don’t
appreciate acting as a gracious host for a slew of little snippets of personal
information. Also, if you do a large amount of surfing, cookies can occupy a
significant amount of your hard drive space over time. (Not to mention that
some cookies have highly suggestive names, which could lead to all sorts of
conclusions. End of story.)

You can choose to accept all cookies — the default — or you can opt to dis-
able cookies altogether. You can also set Safari to accept cookies only from
the sites you choose to visit. To change your Cookie Acceptance Plan (or
CAP, for those who absolutely crave acronyms), follow these steps:

1. Choose Safari->Preferences.

2. Click the Security button.

Safari displays the preference settings shown in Figure 8-6.
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Chapter 8: Taking Your Laptop on Safari!

enNn Security
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Web Content: EEnabie plug-ins
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MEnabie JavaScript
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(' Show Cookies )
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3. Choose how to accept cookies via these radio button choices:

¢ Never: Block cookies entirely.

e Always: Accept all cookies.

¢ Only from Sites You Navigate To: Personally, | use this default
option, which allows sites like Amazon.com to work correctly with-
out allowing a barrage of illicit cookies.

4. To view the cookies currently on your system, click the Show Cookies

button.

If a site’s cookies are blocked, you might have to take care of things
manually, such as providing a password on the site that used to be read

automatically from the cookie.

5. Click the Close button to save your changes.

Cleaning your cache

Safari speeds up the loading of Web sites by storing often-used images and
multimedia files in a temporary storage, or cache, folder. Naturally, the files
in your cache folder can be displayed (hint), which could lead to assump-
tions (hint, hint) about the sites you’ve been visiting (hint, hint, hint).

(Tactful, ain’t I?)

Luckily, Safari makes it easy to dump the contents of your cache file. Just
choose Safari>Empty Cache; then click Empty to confirm that you want to

clean up your cache.
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Handling ancient history

As you might imagine, your History file leaves a very clear set of footprints
indicating where you’ve been on the Web. To delete the contents of the
History menu, choose History=>Clear History.

The latest version of Safari also allows you to specify an amount of time to
retain entries in your History file. Open the Safari Preferences dialog, click
the General tab, and then click the Remove History Items pop-up menu to
specify the desired amount of time. Items can be rolled off daily, weekly,
biweekly, monthly, or yearly.

Avoiding those @*!"%$ pop-up ads

[ hate pop-up ads, and I'm sure you do, too. To block most of those pop-up
windows with advertisements for everything from low-rate mortgages to
“sure-thing” Internet casinos, click the Safari menu and verify that Block
Pop-Up Windows is checked. (If it’s not checked, click the menu item to
toggle the menu item on.)

From time to time, you might run across a Web site that actually does
something constructive with pop-up windows, like present a download or
login prompt. If you need to temporarily deactivate pop-up blocking, press

38 +Shift+K to toggle it off. Then press 38+Shift+K again to turn pop-up blocking
back on after you’ve finished with the site.



Chapter 9
Mac Is .Made for Mac Laptops

In This Chapter

Understanding online storage
Opening a new .Mac account

Using your iDisk

Backing up your hard drive with .Mac

R eaders often ask me to name my favorite reasons why they should
switch — that is, why should a Windows user who thinks all is well
move to the Apple universe? Of course, I always mention the superior hard-
ware and how much of a better job Leopard does as an operating system. But
here’s my favorite selling point: “Apple simply does things right the first time,
and everyone else plays catch-up.”

And then I pose this question: “What if you could reach a hard drive with 5GB
of your files over any Internet connection — anywhere in the world — and

it just showed up on your Desktop automatically?” Usually, I get a thoughtful
silence after that one, and another person decides to learn more — about
Apple’s .Mac online hosting service, that is. In this chapter, I save you the
trouble of researching all the benefits of .Mac. Heck, that’s one of the reasons
why you bought this book, right?

Whevre Exactly Is My .Mac Stuff Stored?

Yep, that’s the question everyone asks. Best that | answer this one first.

I'll begin with a definition. The online hard drive offered to .Mac subscribers
(read about subscribing in the following section) is an iDisk, and it’s well inte-
grated into Mac OS X. In fact, if you didn’t know the background, you might
think that iDisk were simply another internal hard drive. Figure 9-1 illustrates
my iDisk icon on my Desktop. The Finder window displays the contents;
notice the folders visible there. (More on these folders later in the chapter.)
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The files that [ add to my iDisk are stored on an Apple server, location
unknown. Literally. The physical storage (a massive file server that holds
uncounted gigabytes of data) could be in Cupertino, or it might be in
Timbuktu. There’s a whole bunch of ’em, too. You and I don’t need to care
about the where part because

v Your iDisk is always available. Oh, yes. 24/7, your files are waiting for
you.

v Your iDisk is secure. Apple goes to great lengths to guarantee the secu-
rity of your data, encrypting the transfer of files and folders whenever
you use your iDisk. You can also password-protect any data that you
want to offer to others, just in case.

v Your iDisk works even when you aren’t on the Internet. Yep, you
read that right: You can create new documents and modify files to your
heart’s content while you're on a flight or relaxing on the beach. iDisk
automatically updates whatever’s changed the next time you connect to
the Internet.

Now that I've piqued your interest (and answered the most common question
about iDisk), return to the .Mac service for a moment so [ can show you how
to set up your account.
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Opening a .Mac Account
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If you haven’t already opened your .Mac account, you get a chance to sign up
when you turn on your laptop for the first time and also when you install (or
upgrade to) Mac OS X. However, if you decided to pass on .Mac at that time,
you can always join in the fun by following these steps:

1. Click the System Preferences icon on the Dock.

Read through Chapter 6 for the A-Z on System Preferences.
2. Click the .Mac icon.
3. Click the Learn More button.

This launches Safari (the Apple browser) and displays the Apple .Mac
Welcome page (www.mac . com/dotmac). Click Free Trial and then
follow the onscreen instructions to choose a member name and pass-
word.

When you’re done with the clicking and you’re rewarded with your login
information, close Safari and then enter your name and password into
the text boxes in the .Mac System Preferences pane.

Figure 9-2 illustrates an example login that I created.

fe00 -Mac
{2 mac .Mac is the only online service that seamlessly extends your Mac experience
2 to the Internet.
—
Are you a .Mac member? Try .Mac for free.
Sign into your account to set up .Mac on Sign up now and experience .Mac for 60
this computer. days at no charge.
Member Name: yourmacname
Password:
Forgot your password? Sign In Learn More. ..

Like the convenient operating system that it is, Leopard handles all your
.Mac login chores automatically from this point on.

If you're a dialup Internet user, you were likely dreading this moment, but here
it is. 'm truly sorry, but in my opinion, a high-speed broadband connection is
areal requirement in order to take full advantage of a .Mac subscription. You
can certainly still use all the functionality of .Mac with any type of Internet
connection, but you're going to spend from now until the next Gone With the
Wind sequel waiting for files to copy and things to happen.
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If you decide to sign up for a full year’s .Mac membership, I salute you for
your discerning taste in online services. However, you can opt for a 60-day
trial subscription at this point, which is only fair because Apple wants you
to check out things at your leisure. Table 9-1 shows the major differences
between a free trial subscription and a full $100 yearly subscription to .Mac.

Table 9-1  What a Ben Franklin Buys with .Mac

Status iDisk/ Time Data Backup
E-Mail Provided Transfer Storage
Storage

Trial, free 100MB total 60 days 3GB per 100MB total

month
Member, 10GB total 1year 100GB per 10GB total
$100 annually month

A Mac subscription also allows you to synchronize your e-mail, Address Book

contact information, and your Safari bookmarks between multiple Macs. What
areal boon if you spend time on the road with a member of the MacBook

species!

Both trial and subscriber .Mac users can read .Mac e-mail through the Web-
based browser offered on the .Mac Web site. That’s neat, certainly, and you
can use Web mail from any computer with an Internet connection. However,
you can also send and receive .Mac e-mail seamlessly from Leopard’s Mail

application, which is the preferred method of checking your messages. In fact,
Leopard automatically creates a matching Mail account for your trial .Mac

account. Unadulterated sweet/

Is .Mac an ISP?

.Mac is many things, but it isn't an ISP (techno-
nerd shorthand for Internet service provider).
You need to join an ISP first because you need
an existing Internet connection to use the ser-
vices and features included in .Mac member-
ship. This makes a lot of sense, considering that
most of us already have Internet access. (Plus,
Apple doesn't have to worry with all the sup-
port and hardware headaches that an ISP has
to deal with.)

.Mac works with the ISP that you already
have, so you don't have to worry about AOL
or EarthLink conflicting with .Mac. (However, |
can't guarantee that your system administrator
at work will allow .Mac traffic across his or her
pristine network. Perhaps a steak dinner would
help your argument.)
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If you decide that you want the extra functionality of a .Mac subscription,
upgrading is easy. When you open the .Mac pane within System Preferences
and click the Account button, Leopard displays a countdown reminder telling
you how many days remain on your trial period. To upgrade, visit the .Mac
Web site at any time and click the Join Now button.

Using Your iDisk on the iRoad

So how do you open your iDisk? Leopard gives you a number of different
avenues:

v Choose Go~iDisk from the Finder menu and then choose My iDisk
from the submenu.

Keyboard types can press 38+Shift+] instead.
v Click the iDisk icon in the Finder window Sidebar.
v Click the iDisk button on your Finder toolbar.

It’s easy to add an iDisk button. Open a Finder window, click View, and
then click Customize Toolbar. Drag the iDisk icon up to the toolbar and
then click Done.

After you open your iDisk, an iDisk volume icon also pops up on your
Desktop. You can open the little scamp later in your computing session

by simply double-clicking the Desktop icon. The Desktop iDisk icon hangs
around until you log out, restart, eject the iDisk, or shut down your MacBook.

It's all in the folders

Your iDisk contains a number of different folders. Some of them are similar to
the subfolders in your Home folder, and others are unique to the structure of
your iDisk. In this section, I provide the details on the iDisk folder family.

iDisk storage folders

Although you can store files and create folders in the root (or top level) of an
iDisk, the same organizational tips apply as the root of your laptop’s internal
hard drive. In other words, most things that you copy to or create on your
iDisk should be stored in one of these six storage folders. (Refer to Figure 9-1
to see them.)
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v Documents: Store the documents that you create with your applications
in this folder, which only you can access.

v Movies: This folder stores your QuickTime movies (including any that
you might use in your .Mac Web pages).

v Music: iTunes music and playlists go here.

v~ Pictures: The digital images that you store in this folder can be used
with other .Mac services (like your Web pages) or within iPhoto.

v Public: The files that you store in this folder are meant to be shared
with other people (as well as offered on your .Mac Web pages). You can
also allow others to copy and save files to your Public folder as well
(more on this later in this section).

v~ Sites: You can use HomePage to create Web pages in this folder, or you
can add Web pages that you’ve created with your own applications. You
can read more about HomePage, the Apple Web page-creation applica-
tion, in the upcoming section, “Publishing a Web Site with HomePage.”

These folders can be opened in a Finder window just like any typical folder
on your MacBook’s internal hard drive, and you can open and save docu-
ments to your iDisk folders, using all your applications. In other words, these
six iDisk folders act just like normal, everyday folders. Pretty doggone neat!

Funky specialized iDisk folders

Your iDisk contains three folders that you can’t use to store stuff (directly,
anyway):

v Backup: This is the storage vault for the backup files created with the
.Mac Backup application. You can read more about Backup later in this
chapter.

o Because you have Read access to the Backup folder, you can copy the

backup files from this folder to a CD, DVD, or removable drive on your
MacBook. (I cover backing up later in this chapter.)

v Library: Like the Library folders that you find in the root of your hard
drive (and in your Home folder), this folder stores all sorts of configura-
tion settings for the .Mac features that you're using, like your Backup
settings.

v~ Software: This read-only folder is a special case. Apple stuffs this folder
full of a wide variety of the latest in freeware and shareware as well as
commercial demo software. You can copy whatever you like from the
Software folder to your MacBook’s Desktop and then install your new
toy from that local copy. (Oh, and the contents of the Software folder
don’t count against your total storage space limit.) Enjoy!
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Mirror, mirvor, on your drive . . .

You can use your iDisk even if you aren’t connected to the Internet. This
magic is accomplished through a mirror, or local copy of your iDisk, that’s
stored on your local hard drive. (“Hey, wasn’t | supposed to be getting away
from storing things locally?”) If you choose to use a mirror — and you can
enable this feature if you like — Leopard automatically synchronizes any files
that you created or changed on your local iDisk copy the next time you con-
nect to the Internet. This is a great feature if you have more than one Mac in
different locations because you can update and synchronize your iDisk files
from any of your computers — all automatically!

Without a mirror, you must have an active Internet connection to use your
iDisk.

To enable (or disable) the mirror feature, open System Preferences, click the
.Mac icon, and then click the iDisk tab to display the settings you see in Figure
9-3. Click the Start button, and — after a moment of preparation, complete with
its own dialog — the text above the button reads iDisk Syncing On.

aen Mac

(o[> Coronai ] C—

= MaAcC  :Macis the only online service that seamlessly extends your Mac experience
L to the Internet

—

! Account  Sync | iDisk = Back to My Mac !

iDisk Usage
(] 25 MB 50 MB
50 MB total, 1 MB used, 48 ME available ( Upgrade Storage...

Your iDisk Public Folder
You can connect to your iDisk public folder at http:{/idisk.mac.com lic

Allow others to: (®) Read only (O Read and Write

" Password-protect your public folder Set Password
iDisk Sync: Off

(" Starr ) Clicksartto keep a copy of your iDisk on this computer, so you can access it even

when you're not connected to the Internet.

Update: (*) Automatically Manually

If you use a local copy of your iDisk — and [ recommend it — choose to syn-
chronize automatically. This ensures that your files get updated even if you're
somewhat forgetful, like I am.
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A mirror makes things much faster when you browse your iDisk or when you
save and load documents from your iDisk. Leopard actually uses your local
copy from your hard drive, and then updates your remote iDisk files in the
background while you work. (Leopard is updating your iDisk whenever you
see that animated circular-yin-yang-thinglet rotating next to your iDisk icon in
the Finder window. You'll know it when you see it.)

Monitoring and configuring your iDisk

The iDisk pane in System Preferences groups all the configuration settings
that you can make to your iDisk and your .Mac account. In this section, |
review the controls that you can find here.

Disk space

Concerned about how much of your 100MB (for trial users) or 10GB (for
subscribers) remains? The iDisk panel (refer to Figure 9-3) includes the Disk
Usage bar graph, which always displays how much of your iDisk space is free.
(The bar actually totals only half of your storage because the other half of
your iDisk is reserved for e-mail use.)

Public folder

The Finder Go menu includes a shortcut to access another .Mac member’s
Public folder.

Password

[ strongly recommend that you set a password to protect the contents of
your Public folder.

This password must be entered by anyone trying to open your Public folder.
If you haven’t supplied that person with the proper password, he can’t open
your Public folder. Just that simple. (There’s nothing more embarrassing
than discovering the bikini shots from your vacation are available for every
.Mac user to peruse.)

Here’s one drawback to this extra level of security: If you password-protect
your Public folder, it can’t be used to store anything that you offer on your
.Mac Web pages.

Settings
While you're in the iDisk panel, you can configure your Public folder security
settings. You can decide whether others should be able to
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+ Only read the contents of your Public folder.
By default, the Public folder is set to Read Only.
v Copy documents to your Public folder.

To give others the ability to save and copy, select the Read and Write
radio button.

Backing Up Vour Treasured Laptop Stuff
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My editors have heard me drone on and on long enough about how impor-
tant it is to back up your hard drive. They probably rub their eyes when they
encounter yet another instance of my preaching about the wages of backup
sloth and losing everything but hindsight.

Well, you’re lucky, because I was just about to launch into another round

of backup warnings. .Mac subscribers get a great utility application called
Backup when they join the club. Backup is a great application that saves a
copy of your treasured data on just about any media on the planet, including

v Your iDisk (using the Backup folder that I discuss earlier in this chapter)
v An external USB or a FireWire hard drive

1 Recordable CD or DVD media

v Network servers

v Your iPod

Before you get too enthusiastic about backing up to your iPod, heed this: You
can indeed back up to your iPod (or I wouldn’t have listed it as an option),
but your iPod’s tiny hard drive isn’t meant to handle the same serious thrash-
ing as a full-size external hard drive. Personally, I've never used my iPod as

a backup destination, and [ don’t recommend that you do, either, unless no
other recording media is handy and you absolutely have to have a backup.

If you’d like an offline copy of your data that would survive a catastrophe like a
fire or theft, consider using both Time Machine and Backup. That way, your stuff
is covered in the WCS (short for worst case scenario). I cover Time Machine —
Leopard’s awesome new automatic backup system — in Chapter 21.
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Installing Backup

Backup isn’t built into Leopard; you have to download it from the .Mac site at
www . apple.com/dotmac. After the image file is mounted on your Desktop,
you see the Backup installation folder. Double-click the Backup . pkg file to
begin the installation. After installation is complete, you can find Backup in
your Applications folder.

Saving your stuff

Nothing is more important to a proud MacBook owner than a secure backup.
In this section, [ demonstrate how you can produce both manual backups
(produced whenever you like) and automated backups (which are scheduled
at regular intervals). Do it!

Remember that you're limited to 50MB of data storage with a trial .Mac mem-
bership! The other 50MB is dedicated to your .Mac e-mail account. (I'm still
talking about several hundred JPEG images that can fit in 50MB, but that total
isn’t much when you consider digital video or your iTunes Library.)

Beginning a backup is as easy as marking the check boxes next to the items
that you want to safeguard. These are the default Backup Plans available, and
they’re already scheduled to start automatically.

After you enable the check boxes for the items you want to back up, follow
these steps to start a manual backup:
1. Click Continue to display the Backup main window.

Notice that each backup plan you selected on the previous screen has a
scheduled time assigned to it for automatic operation.

2. Click the plan you want to select it; then click Back Up.
The rest is cake as your irreplaceable stuff is saved to your iDisk.

If you ever need to restore from your backup, click the desired plan to select
it, and then click the Restore button. Backup leads you through the restore
process with the same aplomb.

The Backup application itself doesn’t need to be running for the automated
backup to kick off, but keep in mind that your laptop must remain awake!
Make sure that

v You're logged in.

v Sleep mode is completely disabled on the Energy Saver pane within
System Preferences.

v Your computer has an active Internet connection.



Chapter 9: .Mac Is .Made for Mac Laptops

Publishing a Web Site with HomePage

HomePage is a very popular feature for .Mac members. Most MacBook
owners aren’t Web page designers, after all, and HomePage is extremely easy
to use. Apple is smart enough to let trial .Mac members use HomePage; you
can try it before you decide to invest in a .Mac subscription.

|
Figure 9-4:
Good call!
You're about
to create a
.Mac Web
page.
|

Follow these steps to create a new Web page on your .Mac site with

HomePage:

1. Launch Safari and visit www . apple.com/dotmac.

2. Click the Log In link.

Safari prompts you for your .Mac member name and password.

3. Click the HomePage link at the top of the .Mac Welcome page.

The HomePage top-level page that you see in Figure 9-4 appears.

@ Safari File Edit View History Bookmarks Window Help
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000

HomePage

== HomePage
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9
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Choose a theme..,

A variety of themes showcase your
adventures, photos, movies, and files
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Add your memories and experiences,
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4.

Choose a theme for your page from the tabbed display at the left of
the screen.

Some of the categories are specially designed for certain chores. For
example, the Photo Album theme collection is perfect for showing off
your digital photographs online, and the File Sharing category presents
an easy downloading format for your visitors. Each of these different cat-
egories displays different onscreen instructions that are specific to their
use.

For an elegant site where you show off your best photography online,
click the Formal frame in the Photo Album category.

. Choose the folder with the photos you want to include on the page.

This can be either your iDisk Pictures folder or a subfolder that you cre-
ated within it.

. Click Choose.

HomePage loads all the images in the selected folder.

7. Mark the Show check box for each image that you want to appear.

8. Drag the image thumbnails to the order that you want.

9. Select the text boxes to add

10.

11.

e The Web page title
¢ An introductory sentence (or two)
e The titles for each photo

You can display a counter (which tallies how many visitors came to your
page) and an e-mail button (so your visitors can send a message to your
.Mac e-mail account). To use either of these features, just mark the cor-
responding Show check box to enable it.

Click Preview in the toolbar at the top of the page to see what your
page will look like.

If the page you see in Preview mode isn’t up to snuff, click the Back
button on the Safari Toolbar to edit it.

If you like what you see, click the Publish button.

Huzzah! You’re a Web page designer! (Insert sound of champagne cork
popping here.)

HomePage displays your new Web page address, which you can click to
jump directly to your new work of art.

The steps to create a page vary by category. However, the only category that

really requires any rocket science is the Advanced tab, which allows you

to use your own HTML files that you copy to your iDisk Sites folder. Not to
worry, though: Just follow the onscreen instructions for creating a Web site
with your own HTML files, and you’ll be fine.
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Spiffy Connections for
the Road Warrior

In This Chapter

Adding a printer or a scanner to your MacBook
Using Photo Booth

Putting Front Row to work

Watching cable or satellite TV on your laptop

Fis chapter is all about getting interesting things into — and out of —
your MacBook. Some are more common (almost mundane these days)
and pretty easy to take care of, such as scanners and printers. Then I might
surprise you with something new to you, like your laptop’s built-in video
camera, which is built into your laptop and the perfect companion to Photo
Booth.

[ also show you how to turn your road warrior into a photo booth, and how
to use an Apple Remote to control your MacBook or MacBook Pro wirelessly
using Leopard’s Front Row application. Heck, I'll even describe how you can
pull that fancy satellite or cable TV signal into your laptop.

Sure, you can connect your MacBook Pro to a printer and do some serious
work — but then again, you could also snap your photo and send it to your
friends as an e-mail attachment or upload it to your blog. Decisions, decisions!

Connecting Printers

All hail the USB port! It’s the primary connection point for all sorts of good-
ies. In this section, I concentrate on adding a local USB printer and the basics
of adding a network printer to your system. (You find more on connecting a
wireless Bluetooth printer in Chapter 18.)
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USB printers

Connecting a USB printer to your MacBook is duck soup. Don’t you wish all
things in life were this easy? You might very well be able to skip most of the
steps in this section entirely, depending on whether your printer came with
an installation disc. (Virtually all do, of course, but you might have bought
yours used, say from eBay.)

Your printer needs to be fully supported within Mac OS X:

v If the software is designed for earlier versions of Mac OS X (say, v. 10.3
or v. 10.4), it probably works with Leopard.

v~ | always recommend visiting the manufacturer’s Web site to download
the latest printer driver and support software before you install your
printer. That way, you know that you're up to date. (Don’t forget to
check the Read Me file that accompanies your new software to make
sure there are no new system requirements!)

Save and close open files and applications before installing your printer. You
might have to restart your laptop to complete the installation.

The physical connections for your printer are pretty simple:
1. Make sure that your printer’s USB cable is plugged in to both your
laptop and the printer itself.
2. After the USB connection is made, plug the printer in to an AC wall
socket and turn it on.

Don’t forget to add the paper and check the cartridge(s)!

The finishing printer installation steps depend on whether you have a manu-
facturer’s installation CD for your printer.

Sure, I've got the install disc
If your printer comes with its manufacturer’s installation disc, follow these

steps when everything is connected and powered on:
1. Insert the installation disc in the laptop.

The disc contents usually appear in a Finder window. If they don’t, dou-
ble-click the installation disc icon on the Desktop to open the window.

If you're using a MacBook Air, you need to use either the external
SuperDrive or a computer with an optical drive on your local network.
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2. Double-click the installation application to start the ball rolling.
3. Follow the onscreen instructions.
Files get copied to your hard drive.

You might have to restart your MacBook.
You're ready to print!

Don'’t forget to visit your printer manufacturer’s Web site to check whether
any driver updates are available for your particular model.

Whoops, I've got diddly-squat (Software-wise)

Didn’t get an installation CD? Try installing the printer without software, or
download the software from the manufacturer’s Web site.

Installing without software

If you didn’t get an installation CD with your printer, you might be lucky
enough that your printer’s driver was included in your installation of Mac OS
X. First, press +P within an application to display the Print dialog, and see
whether the printer you connected is already recognized.

If it’s not displayed, here’s how to check for that pesky driver after you con-
nect the printer and switch it on:

1. Open the System Preferences window.

2. Click the Print & Fax icon.

3. Click the Add button (which sports a plus sign).
4.

Check the Printer list in the Printer Setup Utility window to see
whether your printer has already been added automatically within
Leopard.

If your printer appears here, dance a celebratory jig. You can close
System Preferences and choose that printer from the Print dialog in your
applications. You can set it as the default from the System Preferences
Print & Fax pane; just click the Default Printer pop-up menu to select
your new printer.

Downloading software

If you don’t have installation software and your laptop doesn’t automatically
match your USB printer with a driver, it’s time to check the Internet to locate
a Leopard-compatible driver for your printer.
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Check the manufacturer’s Web site for your printer’s software. Look for

1 Special software drivers that the printer might need
\NG/
gg‘“ Install any drivers you find before you run an installation application.

Otherwise, the installation app might not be able to recognize or config-
ure the printer if the driver hasn’t been installed first.

v+ Installation application

If the manufacturer offers an installation application for your printer,
download the application and run it.

Networked printers

Your wired or wireless Ethernet network provides a quick and easy way to
share any printer that’s connected to your MacBook. Follow these steps to
share your printers across the network with others:

1. Click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

4. Click the Close button to exit System Preferences.
In most cases, a printer that you share automatically appears in the Print
dialog on other computers connected to your network. Therefore, if you want
to access a printer being shared by another Mac across your network, open

the Print dialog within your application and click the Printer pop-up menu to
select it.

If the remote printer isn’t listed automatically, you can dig a little further.
To add a printer that another Mac on your network is sharing to your list of
printers, follow these steps:

1. Click System Preferences on the Dock.

2. Click the Print & Fax icon.

3. Click the Add button (which carries a plus sign).

4. Click the Default button on the toolbar.

Leopard displays all the available local shared printers. Click the desired
printer and then click Add.
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Connecting Scanners

USB and FireWire scanners practically install themselves. As long as the
model is listed as Mac OS X-compatible (check the system requirements on
the scanner’s box or on the manufacturer’s Web site for compatible comput-
ers) and it supports the TWAIN device standard (just about all scanners do),
&QN\BE” things really are plug-and-play.
&

The MacBook Air doesn’t have a FireWire port, so it’s a USB-only ticket.

If you have the scanner manufacturer’s installation disc, go ahead and use
it. However, most scanners don’t require specialized drivers, so even that
orphan model that you picked up from Uncle Milton last year should work
(if it’s recognized by Mac OS X). It doesn’t hurt to check the manufacturer’s
Web site to see whether any of the software has been updated since the disc
was produced.

<P If Mac OS X doesn’t support your older scanner, a third-party application
might be able to help. Get thee hence to Hamrick Software at www . hamrick.
com and download a copy of the latest version of VueScan. This great scan-
ning application supports over 750 scanner models, including a number that
don’t work with Leopard otherwise. At $40, it’s a world-class bargain to boot.

Ready to go? Make sure that your scanner is powered on and connected to
your laptop (and that you load a page or photograph to scan). If your scan-
ner’s installation disc provided you with a proprietary scanning application,
I recommend that you use that application to test your scanner. In fact, it’s
Mark’s Maxim time!

If your printer or scanner includes bundled applications, use them!™

Sure, Mac OS X has the Print & Fax pane within System Preferences for print-
ers and the Image Capture application for scanners and digital cameras,

but these are bare-bones tools compared with the print manager and image
acquisition software that comes bundled with your hardware. I turn to
Leopard’s built-in hardware handling stuff only when I don’t have anything
better.

Hey, I'm not saying that anything’s wrong with Image Capture, which is in
your Applications folder, if you need to use it. However, don’t expect Image
Capture to support any specialized features offered by your scanner (like
one-button e-mail or Web publishing). You have to use the application espe-
cially designed for your manufacturer and model to take advantage of any
extras that it offers.
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Using Photo Booth and Front Row

Figure 10-1:
The iSight
camera is

a sightto
behold.
|

Many Apple switchers and first-time owners quickly notice that tiny square
lens and LED light at the top of the MacBook’s svelte frame. You might also
have received a device that looks like a stick of chewing gum with buttons.
What gives?

First, allow me to identify these toys. The former is the lens of your laptop’s
built-in iSight camera, which allows you to capture video or snap a quick fun
series of photos via Leopard’s Photo Booth application. The latter is an Apple
Remote, which you can use to control your MacBook from the comfort of
your lounge chair or breakfast nook via Leopard’s Front Row software.

If your MacBook didn’t come with an Apple Remote, you can pick one up on
Apple’s Web site. Note, however, that the MacBook Air is not compatible with
the Apple Remote because the Air model doesn’t have an infrared sensor.

Capturing the moment with Photo Booth

What’s that you say? You've never used a computer video camera? Well then,
good reader, you’'ve come to the right place!

The iSight camera’s indicator light (see Figure 10-1) glows green whenever
you're taking a snapshot or recording video . . . which, when you think about it,
is A Good Thing (especially if you prefer chatting at home in Leisure Mode).

Camera
indicator light

iSight
camera lens
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Figure 10-2:
Photo

Booth does
one thing
particularly
well —
candid
photography.
|

If you need a quick picture of yourself for use on your Web page, or perhaps
your iChat icon needs an update to show off your new haircut, use Photo
Booth to capture images at 640 x 480 resolution and 32-bit color. Although
today’s digital cameras can produce a much higher-quality photo, you can’t
beat the built-in convenience of Photo Booth for that quick snapshot!

To snap an image in Photo Booth, follow these steps:

1. Launch Photo Booth from the Dock or from the Applications folder.
Check out that glowing LED!

2. (Optional) Click Effects button to choose an effect that you’d like to
apply to your image.

Photo Booth displays four screens of thumbnail preview images. Each
screen displays nine thumbnails (see Figure 10-2) so that you can see
how each effect changes the photo. To move through the thumbnail
screens, click the Previous and Next arrow buttons that appear around
the Effects button.

8.00 Photo Booth

*. Color Pencil

) ?.;_'{i“ E)
RN n-:ﬂ

Effects

\‘ No photos. |

Film strip viewer
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You can produce some of the simple effects you might be familiar with
from Photoshop (such as a black-and-white image or a fancy, colored
pencil filter), but it can also deliver some mind-blowing distortion
effects, and even an Andy Warhol-style pop-art image!

Of course, you can always launch your favorite image editor afterward
to use a filter or effect on a photo — for example, the effects available in
iPhoto — but Photo Booth can apply these effects automatically as soon
as you take the picture.

3. (Optional) Click a thumbnail to select the desired effect.

To return the display to normal, click the Normal thumbnail, which
appears in the center. (Um, that would be Paul Lynde’s spot, for those of
you old enough to remember Hollywood Squares.)

4. Click the Camera button.

The image appears in the film strip at the bottom of the window.
Photo Booth keeps a copy of all the images you take in the film strip so that
you can use them later. After you click a photo in the film strip, a series of
buttons appear, inviting you take any one of a series of actions, including

v Sending the photo in an e-mail message

v Saving the photo directly to iPhoto

v Using the image as your Leopard user account icon
v Using the image as your iChat Buddy icon

To delete an image from the Photo Booth filmstrip, click the offending photo
and then click the X button that appears underneath.

If you're itching to connect a USB digital camera for use with iPhoto, let me
redirect you to Chapter 12, where I cover the iPhoto experience in depth.

To capture a video clip, click the Movie Clip button (which bears frames from
an old-fashioned movie reel) at the lower left of the Photo Booth window.
Click the Big Red Movie Button to start recording, and again to end the clip.

Controlling your laptop
remotely with Front Row

Okay, you've seen some neat stuff so far, but things get really cool about now!
With Apple’s Front Row software, you can turn your MacBook into a multime-
dia presentation center that can show off all your digital media to your ador-
ing public (and friends and family to boot). In fact, with the Apple Remote,
you don’t even have to leave the comfort of the couch to start the show.
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The Front Row application performs four different functions:

v Watching DVD movies with DVD Player: If you already loaded a DVD
into your optical drive, you can watch it. (Sorry, your MacBook doesn’t
load the DVD for you. I guess some things have to remain manually
driven for a few years yet.) Naturally, MacBook Air owners need an
external SuperDrive to watch movies from a disc.

v Viewing photos and slide shows: Front Row calls upon iPhoto so that
you can see your albums, film rolls, and slideshows.

v~ Displaying videos in QuickTime Player: You can choose any video you
download from the iTunes Music Store or save to your Movies folder.

v Coaxing your favorite music, podcasts, and TV shows from your
iTunes library: Find your media and playlists available from Front Row.

All this is accomplished by using the awesome, infrared Apple Remote you
see in Figure 10-3. If your last computer — the beige box — didn’t have a
remote control, don’t panic. It’s as simple to use as an iPod Shuffle!

—+—— IR window

Volume/menu up

Previous/rewind Next/fast forward

Volume/menu down |~~——Select/play/pause

—— Menu

Figure 10-3:
Isitan

older iPod
Shuffle?

No, it's

the Apple
Remote!
|

\
P To launch the application, press the Menu button on the remote. As long as

your laptop is on, Front Row runs automatically. To put your MacBook to
sleep after a night of fun, press and hold the Select/Play/Pause button.

Table 10-1 includes the important functions of the Apple Remote in Front
Row.

157
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Table 10-1 Using the Apple Remote in Front Row

Action Purpose

Menu Press to launch Front Row or to return to the previous
menu.

Volume/Menu Press to navigate down through menu options or to lower

Down the volume while media is playing.

Volume/Menu Up Press to navigate up through menu options or to raise the
volume while media is playing.

Select/Play/Pause Press to select a menu item, or play or pause media from
within iTunes, DVD Player, QuickTime, or iPhoto.

Next/Fast Forward Press to skip to the next song or DVD chapter, or hold down

to fast-forward through a song.

Previous/Rewind Press to skip to the previous song or DVD chapter, or hold
down to rewind a song.

You can also go the mundane route and use keyboard shortcuts to control
Front Row (but it’s nowhere near as cool). Table 10-2 explains the keyboard

shortcuts.
Table 10-2 Using the Keyboard in Front Row
Action Keyboard Equivalent
Menu $8+Esc to enter the menu; Esc to exit it
Volume/Menu Down Down arrow ({)
Volume/Menu Up Up arrow (T)
Select/Play/Pause Spacebar or Return
Next/Fast Forward Right arrow (—)
Previous/Rewind Left arrow (<)

Note that Front Row has no complex configuration. Front Row is what design-
ers call a front-end application, that is, it launches the Leopard applications
necessary to display or play the media you select. (There is a simple Settings
menu in Front Row, offering you the chance to toggle your screen saver and
menu sound effects off or on. Both options are turned on by default.)

TE(,‘/, ,

“&N\BER Your Apple Remote isn’t designed to work with any other third-party applica-

Y tions at the time of this writing. For example, you can’t use it as a presentation
aid in PowerPoint. However, some Apple applications do recognize the Apple
Remote (like Keynote), and it’s a sure bet that Apple will continue to add func-
tionality to the Apple Remote in the future. Check the Apple Remote section of
Leopard’s online Help system to keep tabs on what’s happening!

&
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Using iSight with iChat AU

Although your MacBook comes ready for videoconferencing, you should
understand two caveats before embarking on the Voyage of Video Chat:

v~ Speed is an issue. To take advantage of video in iChat AV, you need a
fast Internet connection — at least high-speed DSL or cable Internet, or
even a connection between computers on the same network.

v~ All participants need a video camera. Plenty of folks online have sud-
denly realized that most of their iChat AV buddies didn’t have video
capability!

Even though your laptop has an iSight camera installed, you can still join
text-based and audio chats. (Your Mac has a built-in microphone, so even if
your online buddies aren’t equipped with video hardware, you can enjoy an
audio chat.) iChat AV displays audio and video buttons next to each person
on your buddy list to help you keep track of who can communicate with you
and how they can do it.

Starting a video chat is as simple as launching iChat AV from the Dock (or
from your Application folder). Then in the buddy list, click any buddy entry
with a Camera button next to it to connect. Wave hello for me!

Turning Your MacBook into a
TU — And More

Your laptop’s beautiful LCD screen would seem to be the perfect artist’s
canvas for watching live cable or satellite TV broadcasts, but there’s no coax-
ial (coax) input on the back of your computer. Therefore, unless you invest in
some additional hardware, you're restricted to watching DVD movies (using
your optical drive) or watching movies and TV shows that you downloaded
from the iTunes Store.

Such an obvious need is going to be filled quickly, and a number of different
hardware manufacturers have produced external devices that can merge
your MacBook and your TV signal. Most are USB or FireWire peripherals, and
many have all the features of today’s TiVo and digital video recorders.

My favorite example is the EyeTV Hybrid, from Elgato Systems (www .
elgato.com), which uses a USB connection (so it’s suitable for use with the
MacBook Air). Check out what this superstar includes for your investment of
$150.
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v Built-in NTSC (analog) and ATSC (digital TV) tuners, cable-ready with a
coaxial connector

v The ability to pause, fast-forward, record, or even edit the video you
stored on your laptop’s hard drive

v Capability to schedule recordings with an onscreen program guide

v Full-screen TV display or in a window anywhere on your Desktop

v No external power supply required
[ really love the ability to fast-forward through commercials, and I can take
anything that I record on my MacBook Pro and use it in iDVD and iMovie. The

addition of TV under your control sorta finalizes the whole digital hub thing,
now doesn'’t it?
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In this part . . .

ere they are, the applications that everyone craves.
This part covers iTunes, iPhoto, iMovie, iDVD, and
GarageBand like your Grandma’s best quilt. You discover
how to share your images, music, and video clips among
the iLife '08 applications on your Mac laptop and how
to create everything from your own DVDs to a truly awe-
some hardcover photo album!




Chapter 11
The Multimedia Joy of iTunes

In This Chapter

Playing music with your laptop

Arranging and organizing your music collection
Tuning into the world with Internet radio
Creating eye candy with the Visualizer

Buying the good stuff from the iTunes Store

ometimes, words just aren’t enough. iTunes is that kind of
perfection.

To envision how iTunes changes your relationship with your MacBook, you
have to paint the picture with music — music that’s easy to play, easy to
search, and easy to transfer from place to place. Whether it be classical,
alternative, jazz, rock, hip-hop, or folk, I can guarantee you that you won’t
find a better application than iTunes to fill your life with your music.

Whoops, I almost forgot: and podcasts. And video. And TV shows. And
Internet radio. (See how hard it is to pin down this wonderful application?
Along with your laptop, iTunes really does form the hub of your digital
lifestyle.)

In this chapter, I lead you through all the features of my absolute favorite
member of the iLife '08 suite . . . and it’s going to be pretty doggone obvious
how much I appreciate this one piece of software.

What Can I Play on iTunes?

Simply put, iTunes is a media player: It plays both audio and video files,
which can come in many different formats. Some of the more common audio
formats that iTunes supports are
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v MP3: The small size of MP3 files has made them popular for file trading
on the Internet. You can reduce MP3 files to a ridiculously small size
(albeit at the expense of audio fidelity), but a typical CD-quality, three-
minute pop song in MP3 format has a size of 3-5MB.

v AAC: AAC (short for Advanced Audio Coding) is an audio format that’s
very similar to MP3; in fact, AAC files offer better recording quality at
the same file sizes. However, this format also supports a built-in, copy-
protection scheme that prevents AAC music from being widely distrib-
uted on Macs. (Luckily, you can still burn AAC tracks to an audio CD,
just like MP3 tracks.) The tracks that you download from the iTunes
Store are in AAC format.

<P The iTunes Store’s iTunes Plus tracks are also in AAC format, but these
tracks are not copy-protected, and they’re encoded at a higher-quality
256 Kbps rate. You can listen to your iTunes Plus tracks on as many
Macs as you like.

1 Apple Lossless: Another format directly from Apple, Apple Lossless
format provides the best compromise between file size and sound qual-
ity. These tracks are encoded without loss of quality: hence the name, as
opposed to “lossy” compression schemes, such as MP3. However, Apple
Lossless tracks, which are somewhat larger than AAC files, are generally
considered the favorite of the most discerning audiophile for their entire
music library.

v AIFF: This standard Macintosh audio format produces sound of the
absolute highest quality. This high quality, however, also means that the
files are pretty doggone huge. A typical pop song in AIFF format has a
size of 30-50MB.

1 WAV: Not to be outdone, Microsoft created its own audio file format
(WAV) that works much like AIFF. It can reproduce sound at higher qual-
ity than MP3, but the file sizes are very large, like AIFF.

v CD audio: iTunes can play audio CDs. Because you don’t usually store
CD audio anywhere but on an audio CD, file size is no big whoop.

1 Movies and video: You can buy and download full-length movies, TV
shows, music videos, and movie trailers from the iTunes Store. And,
with an Apple TV unit connected to your home theater system, you can
watch those movies and videos from the comfort of your sofa on the
other side of your house.

v Podcasts: These relatively new programs are like radio programs for
your iPod, but iTunes can play and organize them, too. Some podcasts
also include video and photos, to boot.

v Audiobooks: No longer do you need cassettes or audio CDs to enjoy
your spoken books. iTunes can play audiobooks for you, or you can
send them to your iPod for listening on the go.
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v~ Streaming Internet radio: You can listen to a continuous broadcast of
songs from one of tens of thousands of Internet radio stations, with qual-
ity levels ranging from what you’d expect from FM radio to the full qual-
ity of an audio CD. You can’t save the music in iTunes, but it’s still great
fun. (In fact, I run my own station . . . more on MLC Radio later in the
chapter.)

Playing an Audio CD

Figure 11-1:
The main
playback
controls:
Play,
Previous,
and Next.
|

Playing an audio CD in iTunes is simple. Just insert the CD in your laptop’s opti-
cal drive, start iTunes by clicking its icon on the Dock, and then click the Play
button. (Note that your MacBook might be set to automatically launch iTunes
when you insert an audio CD.) The iTunes interface resembles that of a tradi-
tional cassette or CD player. The main playback controls of the iTunes display
are Previous, Play, Next, and the volume slider, as shown in Figure 11-1.

e iTunes
[ Get Down Tonight 1 —_——
o — ) [+] K.C. & The Sunshine Band -] @ Q-
1:04 [ z 3 1-2:08 i ST
LIBRARY » Name Time Artist Album Genre
3 Music 154 = Get Down Tonight
Movies 2 @ That's The Way (I Like It) 3:06 K.C.& The Sunshin. The Best Of KC & T Pop
B v sh 3 @ (Shake,Shake Shake)Shake You 3:07 K.C. & The Sunshin... The Best Of KC& T. Pop
= e 4 © Queen of Clubs 3:19 K.C.& The Sunshin... The Best OfKC&T.. Pop
§) Podcasts 5 ®IlikeToDolt 2:57 K.C.& The Sunshin... TheBest Of KC&T... Pop
'{' Radio 6 @ I'm Your Boogie Man 4:03 K.C.& The Sunshin... TheBest Of KC&T... Pop
ps 7 @ Keep It Comin' Love 3:54 K.C.& The Sunshin... The BestOfKC&T... Pop
i 8 @ Boogie Shoes 2:12 K.C.& The Sunshin... TheBestOf KC&T... Pop
7] iTunes Store
9 ® Do You Wanna Go Party 3:48 K.C. & The Sunshin... The Best Of KC& T. Pop
DEVICES 10 @ Please Don't Go 3:49 K.C.& The Sunshin... The BestOfKC&T.. Pop

PLAYLISTS
(25 Party Shuffle
[ 90's Music
[# Music Videos
[# My Top Rated
[#] Recently Added
[ Recently Played
[#1 Top 25 Most Played
[ Tracks 1've Gotta Hear
[} MLC Radio
[ Weird Al Yankovic - Even Worse

@ The Best Of KC & The Sunshine Band [+]

10 songs, 33.4 minutes, 338.9 MB
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Click the Play button to begin listening to a song. While a song is playing, the
Play button toggles to a Pause button. As you might imagine, clicking that
button again pauses the music. If you don’t feel like messing around with
your trackpad, you can always use the keyboard. The spacebar acts as the
Play and Pause buttons. Press the spacebar to begin playback; press it again
to stop.

Click the Next button to advance to the next song on the CD. The Previous
button works like the Next button but with a slight twist: If a song is playing
and you click the Previous button, iTunes first returns to the beginning of the
current song (just like an audio CD player). To advance to the previous song,
double-click the Previous button. To change the volume of your music, click
and drag the volume slider.

Like other Macintosh applications, you can control much of iTunes with the
keyboard. Table 11-1 lists some of the more common iTunes keyboard short-
cuts. (Note that iTunes must be the active application for these shortcuts to

work.)

Table 11-1 Common iTunes Keyboard Shortcuts

Press This Key/Key To Do This

Combination

Spacebar Play the selected song if iTunes is idle.

Spacebar Pause the music if a song is playing.

Right-arrow key (—) Advance to the next song.

Left-arrow key («) Go back to the beginning of a song. Press a
second time to return to the previous song.

98+up-arrow key (T) Increase the volume.

98+down-arrow key () Decrease the volume.

38+0ption+down-arrow key () Mute the audio, if any is playing. Press again to

play the audio.

Playing Digital Audio and Video

In addition to playing audio CDs, iTunes can also play the digital audio files
that you download from the Internet or obtain from other sources in the
WAV, AAC, Apple Lossless, AIFF, and MP3 file formats. (You can read about
these formats earlier in this chapter.)

Enjoying a digital audio file is just slightly more complicated than playing a
CD. After downloading or saving your audio files to your laptop, open the
Finder and navigate to wherever you stored the files. Then simply drag the
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music files (or an entire folder of music) from the Finder onto the Music entry
in the iTunes Source list, on the left side of the iTunes window.

The added files appear in the iTunes Music Library. Think of the Music
Library as a master list of your music. To view the Music Library, select the
Music entry in the left-hand column of the iTunes player, as shown in Figure
11-2. Go figure.

Heck, you can also drag a song file from a Finder window and drop it on the
iTunes icon in the Dock, which adds it to your Music Library as well.

If you drop the file on top of a playlist name in the Source list, iTunes adds it
to that particular playlist as well as the main Library. (More about playlists in
a bit.)

To play a song, just double-click it in the Music Library list. Alternatively, you
can click the song once to select it and use the playback controls (Previous,

Play, and Next) that I discuss earlier in this chapter. (Refer to Figure 11-1.)

The Source list of iTunes can list up to six possible sources for audio.

enn iTunes
Stuck In A Closet With Vanna White
@ @ @ 4 ° Weird Al Yankovic ° Sl=[m| a-
0:09 & ] -4:52 View mh
LIBRARY [ Name A Time Artist Album Genre
| TMusie (Shake,Shake,Shake)Shake Your Booty 3.07 K.C.&TheSunshin.. TheBestOf.. Pop
& vovies  (This Song’s Just) Six Waords Lang 337 Weird Al Yankovic  EvenWorse  Rock
e ® Alimony 316 Weird Al Yankovic  EvenWorse  Rock
- ® Boogie Shoes 212 K.C.&TheSunshin... TheBestOf.. Pop
§ Podeasts @ Do You Wanna Go Party 3:48 K.C.&The Sunshin.. TheBestOf ... Pop
'{' Radio ® Fat 3:37  Weird Al Yankovic Even Worse Rock
Sreee @ Get Down Tonight 313 K.C.&TheSunshin... TheBestOf.. Pop
e # Good Old Days 322 Weird Al Yankovic  EvenWorse  Rock
o e ot I Like To Do It 257 K.C.&The Sunshin... TheBestOf.. Pop
DEVICES | Think I'm A Clone Now 320 Weird Al Yankovic  EvenWorse  Rock
. The Best OF KC & The Sunshine Band ©| @ Im Your Boogie Man 4:03 K.C. & The Sunshin... The Best Of Pop
# Keep It Comin' Love 354 K.C.&TheSunshin.. TheBestOf.. Pop
FEANLISTS # Lasanga 2:46 Weird Al Yankovic ~ EvenWorse  Rock
= Party Shuffle @ Melanie 358 Weird Al Yankovic EvenWorse  Rock
81 90's Music ®  MLC Radio Online - A 70's Time Machine Contin... 70's Mix
8 Music Videos @ Please Don't Go 350 K.C.&TheSunshin... TheBestOf.. Pop
@ My Top Rated @ Queen of Clubs 3:19 K.C. & The Sunshin, The Best Of Pop
IRg:encary lcad © TBBS Ultrachat - Bob Hartman (Part 1) 45:40 Bob Hartman ONE BESCON
81 Recently Played  TBBS Ultrachat - Bob Hartman (Part 2) 12:42 ONE BBSCON.
8] Top 25 Most Played @ TBBS: Future Directions (Part 1) (45:25) 45:25 Phil Becker, Bob Ha... ONE BBSCON.
8 Tracks I've Gotta Hear  TBBS: Future Directions {Part 2) {41:00) 41,00 Phil Becker, Bob Ha... ONE BBSCON
[J] Best of K.C. & The Sunshine Band # That's The Way (I Like It) 3:06 K.C.&TheSunshin... TheBestOf... Pop
@ MLC Radio ™ Twister 1:03 We:fﬂ Al Yankovic Even Worse Rock
B 3 Velvet Elvis 430 Weird Al Yankovic  EvenWorse  Rock
[31 eird Al Yaniavic - Even Worse # You Make Me 305 Weird Al ankovic  EvenWorse  Rock
[ IR

+ [ == @ 26 songs, 3.5 hours, 147.9 ME el E/
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v Library: This section includes Music, Movies, TV Shows, Podcasts,
Audiobooks, iPod Games, and Radio. (Think Internet radio, which I dis-
cuss further in the section, “iTunes Radio.”) Discerning readers will note
that Figure 11-2 doesn’t show Audiobooks: That’s because [ don’t have
any loaded.

v iPod: If an iPod is connected, it appears in the list. (And yes, Virginia,
other models of MP3 players from other companies also appear in the
list if they support iTunes.)

v~ iTunes Store: [ discuss this later in the section, “Buying Billie Holiday
from the Apple Music Store.”

v Audio CD: A standard audio CD . .. anything from the Bee Gees to Fall
Out Boy.

v Shared music: If another Mac on your local network is running iTunes
and is set to share part (or all) of its library, you can connect to the
other computer for your music. (Shared music on another Mac appears
as a separate named folder in the Source list.) Of course, you can elect
to share your music with others as well.

v~ Playlists: Think of playlists as folders that you use to organize your
music. (More on playlists later in this chapter.)

Notice also that the Library lists information for each song that you add to it,
such as

v Name: The title of the song

v Time: The length of the song

v Artist: Who performs the song

v Album: The album on which the song appears

Most MP3 files have embedded data — title, album, or artist information,

for example — that iTunes can read, but don’t panic if those fields are blank
or generic right now. If a song doesn’t include any data, you can always add

the information to these fields manually. [ show you how later in the section,
“Setting or changing the song information manually.”

Clicking any of the column headings in the Library causes iTunes to reorder
the Library according to that category. For example, clicking the Name column
heading alphabetizes your Library by song title (and another click reverses the
order). Oh, and you can drag column titles to reorder them any way you like.

iTunes can display your Music Library in three ways: By default, the applica-
tion uses the list view that you see in Figure 11-1, where each song is one
entry. Click the second View button (at the top of the iTunes window) to
group tracks together by album. Click the third View button (Cover Flow),
and you’re browsing by album cover, complete with reflective surface!
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In fact, you can even browse full-screen in Cover Flow mode. Click the Full-
Screen button at the lower right of the cover pane — it looks like a box with
arrows at each corner — and iTunes switches to full-screen mode, complete
with those familiar play controls.

Browsing the Library

After you add a few dozen songs to iTunes, viewing the Library can become a
task. Although a master list is nice for some purposes, it becomes as cumber-
some as an elephant in a subway tunnel if the list is very long. To help out,
iTunes can display your Library in another format, too: namely, browsing
mode. To view the Library in browsing mode, click the Browse button at the
lower-right corner of the iTunes window, which carries an eye icon.

The Browse mode of iTunes displays your library in a compact fashion, orga-

nizing your tunes into four sections:

v Genre
v Artist
v Album
v Name

Selecting an artist from the Artist list causes iTunes to display that artist’s
albums in the Album list. Select an album from the Album list, and iTunes
displays that album’s songs in the bottom section of the Browse window.
(Those Apple software designers . . . always thinking of you and me.) Note
that the Browse button is disabled in Cover Flow view mode.

Will | trash my Count Basie?

Novice iTunes users, take note: iTunes watches
your back when you trash tracks.

To illustrate: Suppose you try to delete a song
from the Library that's located only in the iTunes
Music folder (which you didn’t copy into iTunes
from another location on your hard drive). That
means you're about to delete the song entirely,
with no copy remaining on your MacBook. Rest
assured, though, that iTunes will prompt you to
make sure that you really want to move the file to
the Trash. (I get fearful e-mail messages all the

time from readers who are loath to delete any-
thing from iTunes because they're afraid they’ll
trash their digital music files completely.)

If you delete a song from the Library that exists
elsewhere on your hard drive (outside the reach
of the iTunes Music folder), it isn't deleted
from your hard drive. In fact, if you mistakenly
remove a song that you meant to keep, just drag
it back into iTunes from the Finder, or even from
the Trash. ‘Nuff said.
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Finding songs in your Music Library

After your collection of audio files grows large, you might have trouble locat-
ing that Swedish remix version of “I'm Your Boogie Man.” To help you out,
iTunes has a built-in Search function. To find a song, type some text into the
search field of the main iTunes window. While you type, iTunes tries to find a
selection that matches your search text. The search is quite thorough, show-
ing any matching text from the artist, album, song title, and genre fields in the
results.

For example, if you type Electronic into the field, iTunes might return results
for the band named Electronic or other tunes that you classified as electronic
in the Genre field. (The upcoming section, “Know Your Songs,” tells you how
to classify your songs by genre, among other options.) Click the magnifying
glass at the left side of the Search field to restrict the search even more: by
Artists, Albums, Composers, and Songs.

Removing old music from the Library

After you spend some time playing songs with iTunes, you might decide that
you didn’t really want to add 40 different versions of “Louie Louie” to your
Library. (Personally, I prefer either the original or the cast from the movie
Animal House.) To remove a song from the Library, click the song to select it
and then press the Delete key on your keyboard. (If that sounds a bit daunt-
ing, check out the sidebar titled, “Will I trash my Count Basie?”)

Watching video

Watching video in iTunes is similar to listening to your music. To view your
video collection, click one of these entries in the Source list:

v Movies

v Music Videos

v Video Podcasts

v TV Shows

If you select Movies or TV Shows, iTunes displays your videos as thumbnails.
Music Videos appear as a standard playlist.
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From your collection, you can

+* Double-click a video thumbnail or an entry in the list.

v Drag any QuickTime-compatible video clip from the Finder window to
the iTunes window.

These typically include video files ending in .mov or .mp4.

iTunes plays video full-screen, but when you move your finger across your
trackpad, a control strip appears, sporting a standard slider bar that you
can drag to move through the video (as well as a volume control and Fast
Forward/Reverse buttons). You can also pause the video by clicking the
Pause button.

Keeping Slim Whitman and Slim Shady
Apart: Organizing with Playlists

Given time, your iTunes Music Library can quickly become a fearsomely
huge beastie. Each Library can contain thousands upon thousands of songs:
If your Library grows anywhere near that large, finding all the songs in your
lifelong collection of Paul Simon albums is not a fun task. Furthermore, with
the Library, if you just click Play you're stuck listening to songs in the order
that iTunes lists them.

To help you organize your music into groups, use the iTunes playlist feature.
A playlist is a collection of some of your favorite songs from the Library. You
can create as many playlists as you want, and each playlist can contain any
numbers of songs. Whereas the Library lists all available songs, a playlist
displays only the songs that you add to it. Further, any changes — deleting a
song, for example — that you make to a playlist affect only that playlist, leav-
ing the Library intact.

For example, suppose that you want to plan a party for your polka-loving
friends. Instead of running to your computer after each song to change the
music, you could create a polka-only playlist. Select and start the playlist at
the beginning of the party, and you won’t have to worry about changing the
music the whole night. (You can concentrate on the accordion.)

To create a playlist, you can do any of the following:

1 Choose Filec>New Playlist.
+ Press 38+N.
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v Choose File=> New Playlist from Selection. This creates a new playlist
and automatically adds any tracks that are currently selected in the
Library. iTunes also attempts to name the playlist automatically for you.

v Click the New Playlist button in the iTunes window (the plus sign
button in the lower-left corner). You get a newly created empty playlist
(the toe-tappin’ untitled playlist).

All playlists appear in the Source list. To help organize your playlists, it’s
agoodideato...well...name them. (Aren’t you glad now that you have
this book?) To load a playlist, select it in the Source list; iTunes displays the
songs for that playlist. Click the playlist entry in the source list again to type
a new name for the playlist.

To add a song from the library to your new playlist, click the Library and find
the song you want to include, and then drag it to the desired playlist entry in
the Source list.

The same song can appear in any number of playlists because the songs in a
playlist are simply pointers to songs in your Music Library — not the songs
themselves. Add and remove them at will to any playlist, secure in the knowl-
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edge that the songs remain safe in the Library. As for removing playlists
themselves, that’s simple, too. Just select the playlist in the Source list and

then press Delete.

Removing a playlist doesn’t actually delete any songs from your Library.

Some playlists are smarter than others

From the File menu, take a look at a menu com-
mand for creating a smart playlist. The contents
of a smart playlist are automatically created
from a specific condition or set of conditions
that you specify via the Smart Playlist dialog:
You can limit the track selection by mundane
things, such as album, genre, or artist; or, you
can get funky and specify songs that were
played last, or by the date you added tracks, or
even by the sampling rate or total length of the
song. For example, iTunes can create a playlist
packed with songs that are shorter than three
minutes, so you can fill your iPod Shuffle with
more stuff! Ah, but wait! You're not limited to a
single criterion. If you want to add other crite-
rion, click the plus sign at the right side of the

dialog, and you get another condition field to
refine your selection even further.

You can choose the maximum number of songs
to add to the smart playlist; or limit the size of
the playlist by the minutes or hours of play, or
the number of megabytes or gigabytes the play-
list will occupy. (Again, great for automatically
gathering as much from your KISS collection
that will fit into a specific amount of space on a
CD or your iPod.) Mark the 